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Chapter 1: Introduction to Additive Manufacturing
Additive manufacturing (3D printing) can be a cost-effective way of producing parts, especially when
making use of the design freedoms the manufacturing process enables, such as topological complexity
and the ability to print assemblies in one step.

Metal additive manufacturing is used to produce parts for aerospace, automotive, medical and other
industries. These are high-value parts that require careful design and manufacturing, and simulation
has long been used to validate the as-built part performance.

The additive process for metals introduces inherent complexities and challenges, however, such that
the process itself requires simulation to successfully produce the parts.

Additive Manufacturing Processes

Additive manufacturing (AM) is classified into a number of processes, most of which are applicable to
polymers. Two are the primary processes for fully-dense (no porosity) production of metal parts: laser
powder bed fusion (LPBF) and directed energy deposition (DED). Our focus is on modeling these
two processes.

In a laser powder bed fusion process – also known as direct metal laser melting (DMLM), direct metal
laser sintering (DMLS), or selective laser melting (SLM) – a thin layer of metal powder is deposited and
a highly focused laser beam of energy is moved over its surface in order to melt the metal powder
composing the current cross section and fuse it to the preceding layer. A solid part emerges as successive
layers are deposited and processed. The initial layer is deposited on a build plate or substrate.

In a directed energy process (DED) – also known as laser engineered net shaping (LENS), electron beam
additive manufacturing (EBAM®), or laser deposition technology (LDT) – a laser or electron beam creates
a melt pool on previously solidified material where blown powder or fed wire is introduced to add
material.

Both of these processes produce high temperatures and severe thermal gradients, leading to significant
distortion and buildup of residual stresses as the layers are deposited. The distortion can be high enough
to interfere with the application of the next layer, and the residual stresses high enough to break the
part off the build plate or off its supports, or crack the part itself. Additionally, the residual stresses will
produce more distortion when the part is removed from the build plate and its supports removed
leading to an undesirable final shape.

How Simulation Can Assist with AM Challenges

Being able to simulate these distortions and stresses during the design of the part will help prevent
failed builds and lead to better designs for additive manufacturing.

Supports are generally needed to anchor and support overhangs and other horizontal (and nearly hori-
zontal) surfaces such as the tops of holes. They are also used to control distortions and provide heat
transfer routes during the build. Supports add cost – material, build time, and removal effort – so their
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use should be minimized. Simulation can be used to determine the best build orientation for a part,
best locations for supports, and support sizing requirements. Simulation is particularly powerful when
used with topology optimization to minimize overhang regions requiring supports.
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Chapter 2: Additive Simulation in the Mechanical
Application
Ansys Additive Suite™ is a powerful collection of tools from Ansys, Inc. dedicated to additive manufac-
turing simulation. This document describes the LPBF additive manufacturing simulation capabilities in
the Ansys Mechanical™ application using the Ansys Workbench™ framework.

Target Users

Target users of AM capabilities in the Mechanical application are the engineers involved in the design
and analysis of mechanical components, not necessarily manufacturing engineers and technicians tasked
with printing the parts on the machine floor, nor the R&D researchers responsible for determining the
ideal printing machine process parameters. Current users of the Ansys Discovery™ and Ansys Mechan-
ical applications will benefit greatly from running AM Process Simulations if they plan to use additive
manufacturing to print their metal parts.

Simulation Goals

The goal of Additive simulations in Mechanical is to predict the macro-level distortions and stresses in
parts to prevent build failures and provide trend data for improving designs for additive manufacturing
including part orientation and support placement and sizing.

The simulation is not meant to provide detailed thermal or structural results needed for prediction of
micro-level process phenomena (that is, microstructure). The simulation will also not provide detailed
guidance on the setting of the machine’s process parameters. Our complementary offerings of Ansys
Additive Print and Additive Science (within Additive Suite) are the products to use to achieve those
goals.

Methodology and Abstractions

Simulation of the manufacturing process requires that the analysis follows the build process itself: layer-
by-layer solidification of the part. Since the thermal (temperatures) and structural (distortion and stress)
physics are largely uncoupled (that is, a weak coupling), we can simulate the thermal phenomena first,
layer-by-layer, and use those temperature results in a following structural simulation.

In an AM Process Simulation, the model evolves over time; that is, elements are added. We actually
mesh the entire part first with a layered mesh (either Cartesian or Tetrahedrons) and then use the
standard element birth and death technique to "turn on" element layers to simulate the build progress-
ing. Additionally, the relevant boundary conditions also evolve such as thermal convection surfaces.
The build step is complete when all the element layers have been added (made "alive").

The analysis times and time stepping are also driven by the process parameters and are not known a
priori. These details are all handled internally during the solution.
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Simulating the entire build process for a real part following the beam scan pattern would take enormous
compute time making it impractical. To meet our goals in a reasonable compute time – meaning much
less than the actual build time – we use the following abstractions:

Super layers: Actual metal powder deposit layers are aggregated into finite element "super layers" for
simulation purposes. Since the temperature histories of each adjacent layer is similar, this lumping ap-
proach is appropriate. Note: The real machine build time is approximately the transient thermal build
step simulation time multiplied by R^(1/3), where R is the number of deposit layers in one element
super layer.

Layer-by-layer addition: Material is added and heated all at once for each element layer. For current
generation machines and their scan patterns, this is a reasonable assumption. The in-plane thermal effects
do not contribute to the distortion as much as the build direction thermal effects. This means we do
not use scan pattern information as input.

Heat Application: Heat is applied to new layers in one of two ways, an applied temperature or power-
based heat generation. For applied temperature, the assumption is that the process parameters for the
build have been set appropriately so that (1) the developed temperature is always at or above melt (no
lack of fusion) and (2) the developed temperature does not substantially exceed melt (no keyholing).
For heat generation, the power input and absorptivity is specified and a heat generation load is applied
to elements in the new layer. The time over which the heat generation is applied can be set to either
a very quick "Flash" option where the energy is added in a short amount of time, or a longer "Scan
Time" option where the energy is added over the amount of time it would take to scan the new element
layer. In both timing options, the input energy is the same. More information on the heat generation
option can be found in the command descriptions for the underlying Mechanical APDL™ commands
AMBEAM and AMBUILD.

Time step size: Large integration time step sizes are used throughout the simulation. This is sufficient
to capture the induced thermal and plastic strains driving the distortion. The localized smooth heating
and cooling curves will not be captured in detail.

Supports: Supports are represented as an orthotropic homogenized solid. While you can provide detailed
support geometry, modeling this way is sufficient to capture part distortion and obtain estimates of
support failure.

Surrounding powder: For the powder bed process, the surrounding unmelted powder need not be
explicitly modeled. Instead, the heat loss into the powder can be accounted for in a simplified approach
using a convective boundary condition at the interface between powder and solid material.

The LPBF Process Add-on and the LPBF Setup Wizard

An AM process simulation can be run using native Mechanical interface objects and working through
the project tree. For an easier approach, however, we recommend you load the LPBF Process Add-on,
accessible from the Add-ons Tab in the Mechanical ribbon. Simply click the LPBF Process button (in the
Additive Manufacturing group) to load the add-on. The button is shaded blue when the add-on is
loaded.
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Click the LPBF Process tab to see the add-on's custom ribbon:

An easy-to-use LPBF Setup Wizard steps you through all the steps required to set up a simulation. If
you are new to Ansys Workbench/Mechanical, or if you are an occasional user, we highly recommend
you use the wizard. The workflow is described in Using the LPBF Setup Wizard (p. 17). We also recom-
mend you read Application Interface in the Mechanical User's Guide.

Even existing Ansys Workbench/Mechanical users may want to try the LPBF Setup Wizard because it's
is an excellent tool for keeping you on track and preventing you from missing a task. There are a few
advanced capabilities that are not available in the LPBF Setup Wizard, but because it does not include
a solve, you can easily modify your simulation set-up after you complete the wizard. If you decide not
to use the wizard, see Workflow Through the Project Tree (p. 67) for the procedure.

Elements, Commands, and Interface Objects Used in AM Process Simulations

The following tables show the primary elements, Mechanical APDL commands, and Mechanical interface
objects used in AM Process Simulations. These items are well documented in our reference guides and
links are provided.

DescriptionElement

3D 8-node thermal solid element (Cartesian mesh)SOLID278

3D 8-node structural solid element (Cartesian mesh)SOLID185

3D 10-node tetrahedral thermal solid (Tetrahedrons mesh)SOLID291

3D 10-node tetrahedral structural solid (Tetrahedrons mesh)SOLID187

3D 8-node surface-to-surface contact elementCONTA174

3D target segmentTARGE170

3D thermal surface effectSURF152

DescriptionCommand

For multiple-beam printers, specifies the number of beams.AMBEAM

Specifies printer parameters for the build and other options.AMBUILD

Specifies the build-environment thermal boundary conditions.AMENV

Specifies the build-material melting temperature.AMMAT

Specifies the powder thermal conditions.AMPOWDER

Specifies AM-specific result data written to a .csv file.AMRESULT

Specifies the process-sequence steps.AMSTEP

Specifies the information about supports.AMSUPPORTS

Specifies the printing process, PBF or DED.AMTYPE
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DescriptionInterface Object

Establishes a connection between a meshed part and a meshed support in an AM
Process Simulation.

AM Bond (p. 209)

Identifies geometries and sets global options for all AM-related objects in an AM
Process Simulation.

AM Process (p. 211)

Defines strain assumptions, process parameters, and build conditions related to
the additive machine, material, and process.

Build
Settings (p. 214)

Creates a support structure consisting of finite elements.Generated
Support (p. 224)

Identifies areas of high strain that are prone to cracking in an AM Process
simulation.

LPBF High
Strain (p. 227)

Identifies areas of overheating that may result in problematic thermal conditions
in an AM LPBF Thermal Structural simulation.

LPBF Hotspot (p. 230)

Identifies dwell times to correct overheating in an AM LPBF Thermal Structural
simulation.

LPBF Hotspot Time
Correction
(Beta) (p. 233)

Identifies areas that may result in recoater interference issues in an AM Process
simulation.

LPBF Recoater
Interference (p. 233)

Identifies a support structure that was imported with CAD geometry.Predefined
Support (p. 236)

Imports and meshes a support structure that is an STL (Stereolithography) file, of
either volumeless or solid type.

STL Support (p. 239)

Groups Predefined Support objects and Generated Support objects.Support
Group (p. 243)

Loosely holds parts in place during AM post process steps to prevent rigid body
motion.

Weak Springs (p. 245)

Known Issues and Limitations

Note the following limitations:

• If you use a Mechanical Model from Workbench's Component Systems, you must manually create
the AM Custom System. This is due to the fact that AM Custom Systems are pre-populated with
AM sample materials in Engineering Data, and linking to the Mechanical Model necessitates the
absence of materials in Engineering Data.

• The LPBF Setup Wizard is not yet fully supported when using the standalone Mechanical applic-
ation. For example, if you open the Mechanical application independent of Workbench and use
the LPBF Setup Wizard to configure a heat treatment with creep properties, the creep properties
will be incorrectly configured. Using creep properties from the wizard necessitates the use of
Engineering Data in Workbench.

• For a multi-part Inherent Strain simulation with either Scan Pattern or Thermal Strain strain
definition (p. 104) and a generated scan pattern (rather than a build file), scan stripes will likely
not align in the x-y direction between parts.
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• On machines with AMD processors, an Inherent Strain simulation with Thermal Strain strain
definition fails by default. Workaround: Set a global environment variable of TF_ENABLE_ONED-
NN_OPTS=0 and restart the Workbench/Mechanical application.

• An Additive Manufacturing Process Simulation is not meant to be used in conjunction with any
of these features: gasket elements, fracture, and remote boundary conditions.

• When using Workbench scripting to open SpaceClaim and then use Additive Prep, the Additive
tab may be missing and/or the tools in the Additive ribbon may be grayed out.

• In certain configuration scenarios, and for some .scdoc geometries that were created prior to
Release 2021 R2, if you have the Additive Prep license enabled in SpaceClaim you will not be
able to open the Mechanical application from inside Ansys Workbench. Mechanical will begin
to launch and then it gets stuck at this stage. If this happens, the workaround is to do one of
the following:

– Within SpaceClaim 2021 R2 or a subsequent release, save the older .scdoc geometry as
a new file using Save, Save As, or Export from Additive Prep.

– Clear the Additive Prep license check box in SpaceClaim, perform your work in Mechanical,
and then go back into SpaceClaim to enable Additive Prep for your next session. Additive
Prep license options are accessible in SpaceClaim by clicking File > SpaceClaim Options
> License and then checking/unchecking Additive Prep.

• Result items from the LPBF Process Add-on (LPBF Recoater Interference and LPBF High Strain)
with an AM Octree simulation (p. 163) may cause the Mechanical application to crash if an ana-
lysis is cleared and resolved and then the result items are evaluated again.

• Multiframe restarts are not supported for the build step. Restarts are supported for the other
AM process steps (p. 97).

• Linux system:

– The LPBF Setup Wizard introduced as the default wizard at Release 2023 R2 is not suppor-
ted on a Linux platform. Linux users use the Legacy LPBF Setup Wizard instead, which is
loaded as the default wizard on Linux systems.

– The voxelized mesh option (Cartesian Mesh with Voxelization Option), one of the three
recommended mesh methods (p. 78) for layered simulations, is not available on a Linux
platform because the underlying voxelizer code is incompatible with Linux. Choose
between a Cartesian mesh and a layered tetrahedrons mesh.

High Performance Computing

An AM Process Simulation can be very compute intensive. We recommend you use high performance
computing using an Ansys HPC license to take advantage of more than four cores.
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Chapter 3: Preparing the Part for Simulation
There are several Design for Additive Manufacturing (DfAM) considerations to be aware of that affect
the cost and quality of your part. Variables include:

• Part design – Relevant design parameters include thicknesses, overhangs, edges, holes, and desired
surface finish.

• Orientation on the base plate – Orientation affects time to print, number of support structures,
and number of replicate parts that can be nested on a base plate.

• Support structures – Support structures serve to stabilize the part, lower deformations, and
conduct heat away from part, but using more supports increases print and finishing time and
cost.

In particular for support structures, you should think ahead about how you will remove them.
In some cases you may even need to design tooling rails onto the part in order to be able to
hold the part while supports are removed.

Determining the Location of Supports

You can determine ahead of time which overhang locations on your part will require supports. Use the
Overhangs Tool in the Ansys Discovery™ application, located on the Facets tab, to determine where
supports will be generated.

Cleaning Up Facets

If you have an .stl file, 3D Printing requires that the faceted body be watertight and free of self-inter-
secting facets, or other defects. Be sure to clean up your file to eliminate gaps and slivers before importing
it into Ansys Workbench.

In Ansys Discovery under Facets, the Check Facets and the Auto Fix tools are quick ways to find and
fix problems in faceted bodies.

Many additional tools for working with faceted parts are available in the Discovery application. Refer
to the Facets section in the Discovery Documentation.

To Share Topology or Not?

The requirement that geometric bodies be meshed in uniform layers in the Z direction is unique to
additive manufacturing simulations. These uniform mesh layers must be conformal, even for multi-body
parts or geometries consisting of separate part and support bodies. That is, not only must faces, edges,
and vertices of distinct 3D printed bodies be aware of one another in order to communicate information
in the simulation, but they must also be sliced into layers with the same step size in the Z direction.
Together, the part and the supports constitute "the build."
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In the Mechanical application, there are three approaches for achieving these uniform mesh layers: using
a Layered Tetrahedrons mesh, using a Cartesian (brick) mesh, and using a voxel (cubic) mesh. Which of
these mesh approaches you employ will determine whether or not you share topology between bodies
in the build—upstream in the CAD program.

Use the following criteria for deciding which type of mesh method to use:

• Use a Layered Tetrahedrons mesh if:

– Your geometry has thin walled features, organic curves, and/or holes.

• Use a Cartesian mesh if:

– Your geometry is blocky or chunky without fine features or holes.

– You know you will be using AM octree adaptive meshing (p. 163) to coarsen the mesh for
reduced simulation time. (The AM Octree method is not supported with the layered Tet-
rahedron mesh method.)

– You know you will be generating supports in Ansys Mechanical. (Auto-generated supports
are not supported with the layered Tetrahedron mesh method.)

Once you've decided which type of mesh method to use, use one of the following approaches, as ap-
propriate.

• If using a Layered Tetrahedrons mesh:

– Do not share topology in the CAD program. For example, in Discovery, use the Unshare
tool in the Shared Topology group to unshare coincident topology.
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Or use Explode Part in DesignModeler.

• If using a Cartesian mesh:

– Share coincident topology in the CAD program. For example, in Discovery, select all bodies
that are associated with the part and the supports. Use the Share tool in the Shared To-
pology group to share coincident topology.
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• If using a voxel mesh:

– It is recommended to use unshared topology. Shared topology between part bodies, predefined
supports, and/or powder bodies is allowed with the voxelization option but not recommended
because some elements may get assigned to the wrong body at the interface.
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Chapter 4: Using the LPBF Setup Wizard
Begin your laser powder bed fusion (LPBF) simulation by using the LPBF Setup Wizard. Follow the wizard
steps, which are organized into logical tasks for additive simulations. As you proceed through a step,
click Apply Changes, which automatically adds objects to the project tree in the Mechanical application's
user interface, and enters values for object properties. During solution, the settings in the project tree
are executed, so it is important to understand that the wizard serves to simplify and focus your workflow
for the purpose of setting up the project tree. Unless you are doing some advanced customization, the
simulation is ready to solve when you have completed the last step in the wizard. Click Finish or
Exit (p. 19) to leave the wizard.

Opening the Wizard

First make sure the LPBF Process Add-on is loaded (p. 8).

To start the wizard, select the LPBF Process tab and then select the LPBF Setup Wizard button.

The geometry in this example, which is used throughout the documentation, is courtesy of Aconity3D
GmbH and Brightlands Chemelot Campus.

Overview of the Wizard Steps

The LPBF Setup Wizard guides you in a step-by-step manner through the following steps:

1. Model Setup (p. 21):
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Identify geometries of the part(s), supports, and base plate. Use Advanced Options for
the simulation of powder or non-build items (such as clamps, bolts, etc.), or if you want
to take advantage of symmetry.

•

• Select your material. Use Advanced Options if the base plate is a different material than
the build items.

• Set mesh criteria, such as type and sizing.

2. Build Settings:

This step is slightly different depending on whether you have an Inherent Strain simula-
tion (p. 49) or a Thermal-Structural simulation (p. 53).

• Simulation assumptions are set by default based on your chosen AM LPBF system. For
Inherent Strain simulations, choose among the options for strain definition.

• Enter calibration scaling factor(s) as determined from calibration experiments (p. 199).
Use default calibration factors if your goal is simply to examine trends, that is, the effects
of variable changes on stress or distortion relative to each other.

• Enter machine settings where applicable, which are process parameters that directly in-
fluence how the process deposits material. These can include Deposition Thickness,
Hatch Spacing, Scan Speed, and a number of other factors.

• Enter build and cooldown conditions, which are settings pertaining to the environment
around the part during the deposition process and during cooldown. These include Pre-
heat Temperature and gas and powder boundary conditions.

• For Thermal-Structural simulations, enter boundary conditions applied on the specified
surface of the base, usually the underside surface, during the build and during cooldown.
The wizard automatically selects the underside surface of the base by default.

3. Postprocessing Options (p. 59):

• Select the post-build processing steps you want to simulate, such as base unbolting,
heat treatment, and base and/or support removal.

• Select LPBF result items to be calculated during solution, such as Hotspot, Recoater In-
terference, and High Strain. Specify criteria for warning and critical thresholds for these
items, or add multiple versions with different criteria for comparison.

Recommended Workflow and Best Practices

• Know the relationship between the wizard and the project tree objects

As you progress through the wizard and take actions, such as Apply Changes, Generate Mesh, etc.,
the options you specified in the wizard are implemented as objects and options in the project tree.
Mesh objects, boundary condition objects and others have been added or changed automatically by
the wizard. Review the Details of related objects to see the wizard options you specified. Notice the
named selections for the build body, the base body, support bodies, contact connections, and con-
straint nodes. For convenience, the help for each wizard option lists the affected tree objects.
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• Use the wizard first to set up your simulation before using more advanced customization

The wizard is capable of reading standard objects relevant to the AM Process from the project tree.
These include assigned geometry types, mesh settings, build settings, boundary conditions and heat
treatment settings, if applicable. Upon opening, the wizard will pre-populate it's properties based on
the given project if the objects have default Ansys names (not custom names). If the project itself
was set up using the wizard, the wizard will read all required properties so you can simply jump in
and navigate to any step and change any properties as desired.

Important:

The wizard is not designed to accommodate advanced custom settings, such as
complex mesh or contact settings, that you may set directly in the project tree. As a
best practice, we recommend that you use the wizard first to set up the majority of
your simulation, Finish or Exit from the wizard, and then tweak the advanced settings
in the tree as needed. Advanced custom settings refers to detailed options that are
not present in the wizard.

• Use Read from Tree to update the wizard for standard setup options

If you change some standard project details (see Important note above) directly in the project tree
while a wizard session is open, you can use the Read From Tree button to update the wizard. Think
of the Apply Changes and Read from Tree actions as opposite functions. Apply Changes updates the
project tree with inputs from the wizard. Read from Tree updates the wizard with inputs from the
project tree. The LPBF result items (Hotspot, Recoater Interference, High Strain) in the Postprocessing
Options step are an exception to this rule. You can add multiple versions of the same result item in
order to set different criteria so the wizard does not track these items.

• Know the difference between the Exit and the Finish buttons

Exit leaves the wizard without applying actions. Finish applies changes to all steps sequentially and
then exits the wizard. If you've been using the Apply Changes button for each step along the way,
we recommend using the Exit button rather than the Finish button because the Finish button will
reapply all changes from each step, including meshing, which may take some time. If you prefer to
have the wizard execute all steps simultaneously at the end of the wizard, use the Finish button instead
of using Apply Changes along the way.

Once you start using the wizard, we recommend you complete all the wizard steps.

• Close the wizard before solving

The wizard does not include a solve step. It is best to complete the wizard using either Exit or Finish
and then close the wizard window before solving. If you initiate a solve while the wizard is open and
then later click Finish to complete the wizard, the existing result data is cleared and the wizard executes
all steps simultaneously again.

Assumptions and Known Limitations for Using the Wizard

• The LPBF Setup Wizard, introduced as the default wizard at Release 2023 R2, is not supported
on a Linux platform. Linux users will use the Legacy LPBF Setup Wizard instead, which opens by
default for Linux users.
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• Simulation of advanced items such as bolt pretension and other types of conditions are not
available in the wizard and need to be defined in the AM Process Sequence worksheet (p. 100).
See Define AM Process Steps (p. 97).

• If multiple mesh sizing objects are created for the build or base prior to opening the wizard, the
wizard will use the first mesh sizing object in the tree to define the corresponding Build Element
Size or Base Element Size.

• Supports can be deleted either all at once or one at a time when using the Delete Support button
in the wizard. Deletion of more than one but fewer that all supports can be done outside the
wizard. Note that even suppressed supports appear in the Select Support dropdown box and
can be edited or deleted although you cannot suppress or unsuppress supports from within the
wizard.

• When you click Finish, the wizard may overwrite advanced custom settings, such as complex
mesh or contact settings, that you may have set in the project tree while the wizard was open.
Conversely, the Read from Tree action does not read advanced custom settings. As a best practice,
we recommend that you use the wizard first to set up the majority of your simulation, Finish or
Exit from the wizard, and then tweak the advanced settings in the tree as needed. Advanced
custom settings refers to detailed options that are not represented in the wizard.

• The LPBF Setup Wizard is not yet fully supported when using the standalone Mechanical applic-
ation. For example, if you open the Mechanical application independent of Workbench and use
the LPBF Setup Wizard to configure a heat treatment with creep properties, the creep properties
will be incorrectly configured. Using creep properties from the wizard necessitates the use of
Engineering Data in Workbench.

• When you use Creep Properties for heat treatment, the wizard automatically unsuppresses the
material model in Workbench's Engineering Data, requiring the wizard to refresh the whole
Workbench project. During this process, any other upstream updates to the project, including
changes to geometry, will be updated.

Also, when switching from Relaxation Temperature to Creep Properties or vice versa under
Properties, you may get this message if Engineering Data was the active tab in Workbench:
"Unexpected error while refreshing pane Toolbox: Object not set to an instance of an object." It is
safe to close the message and ignore the error. This happens only the first time you switch the
heat treatment method. On subsequent changes in the same project, the error message should
not pop up.

• If you initiate a solve while the wizard is open and then later click Finish to complete the wizard,
the existing result data is cleared and the wizard executes all steps simultaneously again.

• Clicking X in the upper, right corner to close the wizard window without first clicking either Exit
or Finish leaves AM-related highlights (such as the red color for the part and blue color for the
base) on the items in the graphics window. Opening and closing the wizard may not reset this.

• Limitations related to Generated Supports:

– (Mechanical limitation): Generated Supports are available for multibody scenarios only
when the bodies have shared topology (p. 13) between them. This means you can use
Generated Supports for a multibody part with shared coincident surfaces but not for a
multibody part with unshared coincident surfaces, nor for multiple parts separated by
space on the build plate.
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– (Mechanical limitation): Generated Supports are not available when the part is meshed
with the Layered Tetrahedral mesh method.

– (LPBF Setup Wizard limitation): When you click the "Show Mesh" button and then proceed
to select element faces for adding multiple instances of Generated Supports, a problem
occurs. This interferes with the highlighting functionality. Hence it is recommended not
to use the "Show Mesh" button while using the wizard to add additional Generated
Supports via the Element Face Selection option.

– (LPBF Setup Wizard limitation): Clicking Finish without having generated a mesh first does
not generate the Generated Supports object. Generated Supports depend on an existing
mesh of the part so a two-step process is required. The Finish button executes the steps
simultaneously. As a best practice, click Apply Changes to establish mesh criteria and
then Generate Mesh to establish the part mesh before using Generated Supports.

Closing the Wizard

1. Upon completing the last step, click Exit or Finish to complete the wizard.

2. Click the X in the upper, right corner to close the wizard window.

Note:

Clicking X in the upper, right corner to close the wizard window without first clicking
either Exit or Finish leaves AM-related highlights (such as the red color for the part
and blue color for the base) on the items in the graphics window. Opening and
closing the wizard may not reset this.

If no changes are necessary you are ready to proceed to the solution step (p. 117). Remember that the
wizard is only a tool to help set up the simulation. You should review your setup in the project tree
before proceeding to solve.

4.1. Wizard Step 1: Model Setup

In the Model setup step:

• Identify geometries of the part(s), supports, and base plate. If you imported a 3MF file, the geo-
metries for part and supports are automatically identified. Use Advanced Options for the simulation
of powder or non-build items (such as clamps, bolts, etc.), or if you want to take advantage of
symmetry.

• Select your material. Use Advanced Options if the base plate or non-build items are a different
material than the build material.

• Set mesh criteria, such as type and sizing.
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Action buttons are described in the following table.

FunctionAction ButtonFunctionAction Button

Click to toggle on/off options
for materials, supports, and

Advanced
Options

Click to apply the actions for
this wizard step, which updates
the project tree. If you make
additional changes, click Apply
Changes again.

Alternatively, you may
choose to fill in the wizard

Apply Changes

advanced geometry items of
non build, powder, and
symmetry.

fields for each step
without clicking Apply
Changes and then click
Finish on the last step to
execute all actions
simultaneously.

Click to bring up help for this
wizard step.

HelpClick to import the new
support(s), or edit the selected
support(s), to the project tree.

This action is separate
from the Apply Changes

Add / Edit
Support

button to allow the
possibility of using
multiple folders of support
files.
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FunctionAction ButtonFunctionAction Button

Click to move to the next
wizard step. All required inputs

NextClick to delete the selected
support(s) from the project
tree.

Delete Support

on this step must be filled in
to be able to move to the next
step. If the button does not
appear blue, not all required
inputs are filled in.

No actions are
performed when you
click Next.

At times, you may want to
fill out all the wizard
inputs completely before
applying any actions.
Clicking Next without first
clicking Apply Changes
allows you to do that.

Not applicable for this step.BackClick to generate the mesh
using the mesh criteria and to
generate the appropriate
contact connections.

Important:

Be sure to click
Apply Changes

Generate Mesh

first before
generating the
mesh. This
ensures the
additive bodies
(part/support/base
plate) are
identified
correctly and a
layered mesh
will be
generated.

This action is separate
from the Apply Changes
button because meshing
may take several minutes
for large models.
Sometimes users prefer to
wait before generating
the mesh. If you make
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FunctionAction ButtonFunctionAction Button

changes to mesh criteria,
click Apply Changes first
and then Generate Mesh.

Click to exit the wizard. Any
actions you have performed

Exit WizardClick to read the status of
objects in the project tree and
update the wizard input fields

Read from Tree

using Apply Changes will be
accordingly. Think of this as maintained in the project tree.
the opposite action of Apply No additional actions will be

performed upon exit.Changes, which updates the
objects in the project tree with
inputs from the wizard.

The status of the tree is
read only from certain
relevant tree objects.
Advanced custom
settings, such as complex
mesh or contact settings,
are not read from the tree
and may be overwritten
by the wizard upon a
subsequent Finish click. It
is best to make advanced
custom tweaks after
exiting from the wizard.
See Recommended
Workflow and Best
Practices (p. 18).

Click to load a previously saved
template of wizard inputs. You

Load Template

will still need to click Apply
Changes or Finish, as usual.

The setup items saved on
the xml file include
materials, mesh settings,
build settings, and
postprocessing selections.
Geometry selections and
advanced options
involving geometry
selections/picks are not
included in saved files.

Use Save Template in the
Postprocessing Options
step (p. 59) to save a
template.

Input fields are described in the following table.
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ExampleDescriptionInput Field

Select the body
representing the
part you are
manufacturing.
Then click Apply.
Use Ctrl-click to
select multiple
bodies.

The body
should be a

Build Geometry: Part
Geometry Selection

closed
volume
(watertight),
and should
be oriented
with the
global Z axis
as the build
direction. It
may be
modeled
either resting
on the base
plate (Z=0),
or elevated
off the base
by supports.

See
additional
guidelines (p. 70),
including
information
about
topology (p. 13)
and
symmetry (p. 189).

Affects these
tree objects:
AM Process,
creates BUILD
named
selection

Choose None if
the part is resting

Select Support
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ExampleDescriptionInput Field

on the base and
no other supports
are in the model.

Choose New
to add a
support,
which opens
the Support
Type options.

Choose one
individual
support, or
All, followed
by clicking
the Delete
Support
button, to
delete one or
all supports
in the model.
(Selecting
more than
one but
fewer than all
supports is
not possible
at this time.)

When
deleting a
Predefined
Support, the
geometry
body will
remain in the
tree but the
Predefined
Support
definition will
be deleted.

Note that
even
suppressed
supports
appear in the
selection
dropdown
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ExampleDescriptionInput Field

and can be
edited or
deleted,
although you
cannot
suppress or
unsuppress
supports
from within
the wizard.

Affects these
tree objects:
AM Process,
Support
Group, STL
Support,
Predefined
Support,
Generated
Support.

Choose STL
Supports if you
have support
structures saved in
.stl files that were
not imported
along with the
part geometry.

Important:

STL
support

Support Type - STL
Supports

files
must
be
in
millimeters.

Number of
Supports:

• Choose
Single
if you
have
only
one
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ExampleDescriptionInput Field

support
file
and
then
click
Edit to
navigate
to the
.stl
file.

• Choose
Multiple
if you
have
more
than
one
support
file
and
then
click
Edit to
navigate
to the
folder
that
contains
the
support
files.

Support
files in
a
folder
must
be of
one
type
(either
volumeless
or
solid
.stl
files)
and
belong
to
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ExampleDescriptionInput Field

only
one
part.
So for
a
simulation
with
multiple
parts,
multiple
supports,
and
multiple
support
types,
the
folder
structure
might
look
like
this:

Do
not
include
the
part in
the
support
folders
if it is
an .stl
file
because
the
application
will
attempt
to
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ExampleDescriptionInput Field

import
all .stl
files as
supports.

STL Support
Type:

• Volumeless
supports
are
usually
thin-walled
supports
created
by
support
generation
tools
such
as
Additive
Prep.

• Solid
supports
are
comprised
of a
solid
body.

Click Add /
Edit Support
to import the
file(s) and see
the supports.

See
additional
information
about
supports (p. 86).

Affects these
tree objects:
Support
Group, STL
Support
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ExampleDescriptionInput Field

Choose
Predefined
Supports if you
have solid support
bodies that were
imported with
your part
geometry. Select
the body and click

Support Type - Predefined
Supports

Apply. Use
Ctrl-click to select
multiple bodies.

Click
Advanced
Options if
you want to
make
material
adjustments
to the
supports.

Affects these
tree objects:
Predefined
Support

Choose
Generated
Supports to have
the Mechanical
application
generate supports
directly as
elements with no
associated
geometry.
Elements are

Support Type - Generated
Supports

generated straight
down from the
part mesh by
either automatic
detection based
on the Overhang
Angle criterion or
from mesh
element faces that
you select on the
part.
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ExampleDescriptionInput Field

Because this
type of
support is
generated
from an
existing mesh,
you first must
have a mesh
established
for the part
and base in
order to
apply a
Generated
Support.
Select the
part and base
with Support
Action set to
None, add
appropriate
mesh criteria,
click Apply
Changes,
then click
Generate
Mesh. After
the basic AM
process is set
up using the
above
method,
select the
Support
Action to Add
Support and
the Support
Type to be
Generated
Support, and
then proceed
to identify
how and
where the
supports will
be generated
by choosing
either
Overhang
Angle or
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ExampleDescriptionInput Field

Element Face
Selection.
Then click
Apply
Changes to
see the
generated
elements.

Overhang
Angle: Enter
the angle
measured
from the
horizontal
base plate (0
degrees) to
the surface of
the part. Any
surface
measuring
less than the
Overhang
Angle will be
supported.
Elements are
generated
vertically
straight down
from the
overhanging
portion of the
build to the
base, or to a
lower portion
of the model
if it is in the
way. Default
is 45°.

33
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Wizard Step 1: Model Setup



ExampleDescriptionInput Field

Element
Face
Selection: In
the graphics
window,
select the
element faces
of the part
mesh from
which
support
elements will
be generated
straight
down. Click
and drag to
select
multiple
element
faces. Then
click Apply in
the wizard.

Notes:

• Generated
Supports
are
available
for
multibody
scenarios
only
when
the
bodies
have
shared
topology (p. 13)
between
them.
This
means
you
can
use
Generated
Supports
for a
multibody
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ExampleDescriptionInput Field

part
with
shared
coincident
surfaces
but
not
for a
multibody
part
with
unshared
coincident
surfaces,
nor
for
multiple
parts
separated
by
space
on the
build
plate.

• Generated
Supports
are
not
available
when
the
part is
meshed
with
the
Layered
Tetrahedral
mesh
method.

Affects these
tree objects:
Generated
Support
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ExampleDescriptionInput Field

Selecting a baseSelect the base
body and click
Apply. This is the
platform on which
the build (part
plus supports) is
to be printed. It is
included in the
simulation
because it acts as
a heat sink.

Choose
Create Base

Base Geometry

Creating a base

if none was
included with
your part
geometry
import. Enter
overall
dimensions of
the body and
coordinates
from the
center of the
top of the
base body. A
red outline
will guide
you as you
create the
base. Use
pan, zoom,
and rotate
mouse
options to
view the base
preview from
all angles.

If you choose
Create Base
and you do
not have STL
Supports,
base sizing is
automatic.
The wizard
generates
one that is
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ExampleDescriptionInput Field

appropriately
sized and
positioned for
your model.
Internally, the
application
reads the
bounding
box
coordinates
of all your
build
geometries
and sizes the
base plate to
twice the
dimensions in
the X-Y plane
and with an
appropriate
thickness
starting at
the minimum
Z coordinate.
Note that
base creation
does not take
into account
any STL
Support
dimensions
so you may
have to
adjust the
minimum
Z-location
depending
on the STL
Support.

Affects these
tree objects:
AM Process,
creates BASE
named
selection, and
Construction
Geometry if
you created a
base
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ExampleDescriptionInput Field

Select the desired material from the drop-down list of Ansys-supplied
sample additive materials.

Both the build and the base are assigned the same material by default.
Click Advanced Options if you want to designate a different material

Material Assignment

for the base. By default, nonlinear effects are turned on in the
simulation. Click Advanced Options to turn off nonlinear effects.

See additional information about materials (p. 69).

Affects these tree objects: Material assignment for each geometry
component under Geometry

Choose Voxelizer
to create a mesh
of cubic elements
for the geometry.
Small features,
curved surfaces,
and horizontal or
vertical surfaces
that are not

Mesh Criteria - Mesh
Method = Voxel

multiples of the
mesh size are
automatically
accounted for by
a knock-down
factor technique.
Note: The
voxelizer mesh
method is not
available on a
Linux platform.

Build
Element Size
is the edge
length of the
cubic
elements of
the part and
support
mesh, which
defines the
super layer
height (p. 7).

Base
Element Size
is the edge
length of the
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ExampleDescriptionInput Field

elements of
the base
mesh.

See
additional
information
about mesh
controls (p. 78).

Affects these
tree objects:
Mesh Method
renamed to
Part Voxelizer,
Mesh Sizing
renamed to
Base Sizing.
After mesh
generation,
creates Build
contact
element faces
and Base
contact
element faces
named
selections and
Build to Base
contact.

Choose Cartesian
to create a hex
mesh that
approximates the
geometry. Small
features, curved
surfaces, and
horizontal or
vertical surfaces

Mesh Criteria - Mesh
Method = Cartesian

that are not
multiples of the
mesh size are not
captured
accurately unless
a small mesh size
is used.

Build
Element Size
is the edge
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ExampleDescriptionInput Field

length of the
hex elements
of the part
and support
mesh, which
defines the
super layer
height (p. 7).

Projection
Factor
defines how
well the mesh
will fit to the
geometry. A
value of 0
(default)
results in
cubic
elements
with a rough
fit to the
geometry.
Increasing
the Projection
Factor will
change the
shape of the
elements to
better fit the
geometry and
may yield
better results
in some cases
but may also
result in a
failed mesh.
Our
recommendation
is to leave it
at 0, or close
to 0, initially
and then
iterate from
there to see
the effects of
changing
Projection
Factor.
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ExampleDescriptionInput Field

Base
Element Size
is the edge
length of the
elements of
the base
mesh.

Affects these
tree objects:
Mesh Method
renamed to
Part Cartesian,
Mesh Sizing
renamed to
Base Sizing.
After mesh
generation,
creates Build
contact
element faces
and Base
contact
element faces
named
selections and
Build to Base
contact.

Choose Layered
Tetrahedral to
create an
unstructured
tetrahedral mesh
in layers based on
a specified layer
height fit to the
geometry. It

Mesh Criteria - Mesh
Method = Layered
Tetrahedral

captures the
geometry well,
and is useful if
there are organic
curves, small
features, such as
holes, or
thin-walled parts.
Note: Generated
Supports are not
available when
using Layered
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ExampleDescriptionInput Field

Tetrahedral mesh
method.

Build
Element Size
is the triangle
edge length
of the
elements of
the part and
support
mesh. It can
be greater
than the
Mesh Layer
Height to
allow the
mesher to
produce
elements that
are skewed
with a longer
direction
parallel to the
element
layers.

Mesh Layer
Height is the
height of
each element
layer,
sometimes
referred to as
the super
layer (p. 7).
Actual metal
powder
deposit layers
are
aggregated
into finite
element
"super layers"
for simulation
purposes.

Base
Element Size
is the edge
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ExampleDescriptionInput Field

length of the
elements of
the base
mesh.

Affects these
tree objects:
Mesh Method
renamed to
Part Layered
Tetrahedral,
Mesh Sizing
renamed to
Base Sizing.
After mesh
generation,
creates Build
contact
element faces
and Base
contact
element faces
named
selections and
Build to Base
contact.

Advanced Options

In additive
machines,
supports are
printed with the
same material as
the part but as
thin walled
structures with
less mass than the
part. In the
simulation we
model the
supports as an
equivalent
"homogenized"
solid rather than
as thin-walled
structures. Their
properties will be
scaled down to

Build Geometry, Predefined
Supports and Generated
Supports

account for this
homogenization
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ExampleDescriptionInput Field

technique.
Affected
properties are
elastic modulus,
shear modulus,
yield strength,
density, and
thermal
conductivity.

Select from
one of the
following
methods for
Support
Material
Adjustments
for the
Predefined/Generated
Supports:

• Overall
Factor
is the
ratio
of the
actual
support
area
to the
area
of the
part
area.
For
example
an
Overall
Multiplier
of
0.33
will
adjust
the
properties
of the
supports
to be
a third
of that
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ExampleDescriptionInput Field

of the
part
material.

• Block
Support
Dimensions
allows
you to
modify
Block
Wall
Thickness
and
Block
Wall
Spacing
for the
supports.

• Property
Specific
Factors
allows
you to
modify
property-by-property
multipliers.
These
multipliers
are
the
ratio
of
geometric
areas
of the
supports
to the
areas
of the
part
geometry,
where
the
areas
are
the
projected
areas
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ExampleDescriptionInput Field

in the
X, Y,
and Z
directions.

These
properties
can be
changed after
a support is
added by
changing the
values and
clicking Add /
Edit Support.

Choose Non Build
to simulate
geometry items
that are present
on the base plate
but that are not
being 3D-printed.
These items may
include clamps,
bolts, measuring

Advanced Geometry
Options, Non Build

devices,
instrumentation,
etc.

Select the
body
representing
the non build
component.
Use Ctrl-click
to select
multiple
bodies.
Selecting the
Non Build
option will
also make the
field for the
Non Build
Element Size
visible under
Mesh Criteria.

Affects these
tree objects:
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ExampleDescriptionInput Field

Will create a
named
selection for
non build
elements, and
a mesh sizing
object for the
selected non
build
geometry

Choose Powder to
select a geometry
body that
represents
unmelted powder.
Modeling the
powder as
elements may be
useful if you are
simulating

Advanced Geometry
Options, Powder

multiple parts
close together on
the build plate or
if the part has
features close
together, where
accounting for the
heat transfer
occurring between
the parts or
features is
important.

Select the
body
representing
the powder
and click
Apply. Use
Ctrl-click to
select
multiple
bodies. The
mesh size for
this will be
the same as
the build
mesh size in
order to have
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ExampleDescriptionInput Field

the same
layer height.

See
additional
information
about
modeling
powder (p. 194).

Affects these
tree objects:
Will add a
powder
elements
named
selection for
the selected
powder
geometry.

Choose Symmetry
if your model has
symmetrical
geometry—specifically,
if it is symmetric
with respect to
the part, supports,
and build plate,
and it has
symmetric loading
and boundary
conditions.
Simulating a
sector of a large

Advanced Geometry
Options, Symmetry

model will result
in a faster
simulation time
while using fewer
resources.

Select the
faces
representing
the symmetry
plane and
click Apply.
Use Ctrl-click
to select
multiple
faces.
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ExampleDescriptionInput Field

See
additional
information
about
modeling
symmetry (p. 189).

Affects these
tree objects:
Will add a
SYMM_NODES
named
selection and
a Symmetry
Region object

The next step of the wizard is Build Settings. The procedure varies depending on whether you have a
Thermal-Structural system or an Inherent Strain system:

• Wizard Step 2: Build Settings (for Inherent Strain Simulations) (p. 49)

• Wizard Step 2: Build Settings (for Thermal-Structural Simulations) (p. 53)

4.2. Wizard Step 2: Build Settings (for Inherent Strain Simulations)

In the Build Settings step:

• Simulation assumptions are set by default based on your chosen AM LPBF system. Choose the
Inherent Strain Definition.

• Enter calibration factor(s) as determined from calibration experiments (p. 199). Use default calib-
ration factors if your goal is simply to examine trends, that is, the effects of variable changes on
stress or distortion relative to each other.

• Enter machine settings, which are process parameters that directly influence how the process
deposits material. These can include Deposition Thickness, Hatch Spacing, Scan Speed, and a
number of other factors.

• Enter build conditions, which are settings pertaining to the environment around the build during
the deposition process and during cooldown. This includes Preheat Temperature.
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Action buttons are described in the following table.

FunctionAction
Button

FunctionAction Button

Click to bring up help for this
wizard step.

HelpClick to apply the actions for this
wizard step, which updates the
project tree. If you make changes,
click Apply Changes again.

Apply Changes

Click to move to the next wizard
step. All required inputs on this

NextClick to read the status of objects
in the project tree and update the
wizard input fields accordingly.

Read from Tree

step must be filled in to be able
Think of this as the opposite to move to the next step. If the
action of Apply Changes, which button does not appear blue, not

all required inputs are filled in.

No actions are performed
when you click Next.

updates the objects in the project
tree with inputs from the wizard.

At times, you may want to
fill out all the wizard inputs
completely before applying
any actions. Clicking Next
without first clicking Apply
Changes allows you to do
that.

Click to go back to the previous
wizard step.

BackNo advanced options for this
step.

Advanced
Options
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FunctionAction
Button

FunctionAction Button

Click to exit the wizard. Any
actions you have performed using

Exit Wizard

Apply Changes will be maintained
in the project tree. No additional
actions will be performed upon
exit.

Input fields are described in the following table.

DescriptionInput Fields

Choose one of the following strain definitions, which reflect how inherent
strain is calculated as an input to the structural solver:

Simulation Settings

• Isotropic assumes that a constant, uniform strain occurs at every
location within a part as it is being built. This is the simplest
assumption, resulting in the shortest simulation time.

• Anisotropic subdivides the strain into anisotropic components in
the X, Y, and Z directions based on the Global coordinate system.

• Scan Pattern subdivides strain into anisotropic components based
on the local orientation of scan vectors within the part. Scan vectors
are generated internally via a slicing function assuming a rotating
stripe scan pattern or input directly from a build file.

• Thermal Strain (Machine Learning), using a Machine Learning
prediction, is a method that provides the highest level of fidelity
and takes thermal cycling into account at each location within the
part. As with Scan Pattern, scan vectors are generated internally via
a slicing function assuming a rotating stripe scan pattern or input
directly from a build file.

Important:

The Machine Learning Prediction feature requires a
Structures AI+ license.

Machine Learning Model is a list of materials that were used to
train the ML prediction, in particular, the materials validated for the
Additive application. Choose the material that most closely matches
your material assignment in Engineering Data. ML models may be
based on different material properties than those in Engineering
Data. The ML models are used to generate loading strains. Materials
in Engineering Data are used for the structural analysis.

Affects these tree objects: Build Settings

Enter strain scaling factors. These are optional inputs that scale the inherent
strains by a given value. They are usually determined from calibration

Calibration Settings
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experiments (p. 199) and account for differences in materials, machines,
and other factors.

• Isotropic allows one Strain Scaling Factor reflecting uniform scaling
in all directions. It defaults to 1.

• Anisotropic allows a strain scaling factor for each global coordinate
direction. These default to 1.

• Scan Pattern and Thermal Strain allow strain scaling factors, called
Anisotropic Scaling Factors, parallel and perpendicular to the
scanning direction in the X-Y plane, and one that is vertical in the
build direction. The default ASCs take into account the fact that
more strain develops in the scan direction than perpendicular to
it, with Parallel ASC = 1.5, Perpendicular ASC = 0.5, and Vertical =
1. You can also enter a uniform Strain Scaling Factor, which defaults
to 1.

Affects these tree objects: Build Settings

Enter the Machine Settings, which are settings and process parameters
that directly influence how the process deposits material. Every simulation
except isotropic uses some, or all, of these parameters:

Machine Settings

• Scan Pattern Definition is how the scan pattern is defined, either
generated using a rotating stripe pattern (default) or input via a
build file.

Build File Path is the location of a .zip file containing the scan
pattern file(s), and an stl of the part geometry. See Build File
Requirements (p. 109).

Machine Type identifies the machine or OEM associated with the
specified build file. Options are Additive Industries, EOS, HB3D,
Renishaw, Sisma, SLM, and Trumpf.

• Start Layer Angle is the orientation of fill rasters on the first layer
of the build. It is measured from the X axis, such that 0 degrees
results in scan lines parallel to the X axis. The starting layer angle
is commonly set to 57 degrees. Must be between 0 and 180°.

• Layer Rotation Angle is the angle at which the major scan vector
orientation changes from layer to layer. It is commonly 67 degrees.
Must be between 0 and 180°.

• Scan Stripe Width is the width of the sections, called stripes, into
which the geometry is sliced. The stripes are scanned sequentially
to break up what would otherwise be very long continuous scan
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vectors. Slicing Stripe Width is typically set to 10 mm wide. Must
be between 1 and 100 mm.

• Hatch Spacing is the average distance between adjacent scan
vectors when rastering back and forth with the laser. Hatch spacing
should allow for a slight overlap of scan vector tracks such that
some of the material re-melts to ensure full coverage of solid
material. For Thermal Strain (Machine Learning) strain definition,
must be between 60 and 1000 microns.

• Deposition Thickness is the thickness of deposited material in
every pass of the recoater blade. Specifically, use the amount the
base plate drops between layers.

• Scan Speed is the average speed at which the laser spot moves
across the powder bed along a scan vector to melt material,
excluding jump speeds and ramp up and down speeds. For Thermal
Strain strain definition, must be between 350 and 2500 mm/sec
and the recommended range is between 500 and 2500 mm/sec.

• Beam Power is the power setting for the laser in the machine. Must
be between 50 and 700 Watts. The recommended range is between
50 and 500 Watts.

• Beam Diameter is the width of the laser on the powder or substrate
surface defined using the D4σ beam diameter definition. Usually
this value is provided by the machine manufacturer. Sometimes
called laser spot diameter. Must be between 20 and 140 µm. The
recommended range is between 80 and 120 µm.

Affects these tree objects: Build Settings

Enter Build Conditions, which are settings pertaining to the environment
around the build during the deposition process.

Build Conditions

• Preheat Temperature is the starting temperature of the build plate.
Used when Inherent Strain Definition = Thermal Strain. Must be
between 20 and 500 °C and the recommended range is between
20 and 200 °C.

Affects these tree objects: Build Settings

Select the face of the base where the fixed support should be applied,
usually the underside of the base. Then click Apply. Use Ctrl-click to select

Base Structural Boundary
Conditions

multiple faces. By default, the underside surface of the base is already
selected.

Affects these tree objects: Fixed boundary condition under Static Structural
system

4.3. Wizard Step 2: Build Settings (for Thermal-Structural Simulations)

In the Build Settings step:
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• Simulation assumptions are set by default based on your chosen AM LPBF system.

• Enter calibration factor(s) as determined from calibration experiments (p. 199). Use default calib-
ration factors if your goal is simply to examine trends, that is, the effects of variable changes on
stress or distortion relative to each other.

• Enter machine settings, which are process parameters that directly influence how the process
deposits material. These include Deposition Thickness, Hatch Spacing, Scan Speed, and a number
of other factors.

• Enter build and cooldown conditions, which are settings pertaining to the environment around
the part during the deposition process and during cooldown. These include Preheat Temperature
and gas and powder boundary conditions.

• Enter boundary conditions applied on the specified surface of the base, usually the underside
surface, during the build and during cooldown. The wizard automatically selects the underside
surface of the base by default.

Action buttons are described in the following table.

FunctionAction
Button

FunctionAction Button

Click to bring up help for this
wizard step.

HelpClick to apply the actions for this
wizard step, which updates the
project tree. If you make changes,
click Apply Changes again.

Apply Changes

Click to move to the next wizard
step. All required inputs on this

NextClick to read the status of objects
in the project tree and update the
wizard input fields accordingly.

Read from Tree

step must be filled in to be able
Think of this as the opposite to move to the next step. If the
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FunctionAction
Button

FunctionAction Button

button does not appear blue, not
all required inputs are filled in.

No actions are performed
when you click Next.

action of Apply Changes, which
updates the objects in the project
tree with inputs from the wizard.

At times, you may want to
fill out all the wizard inputs
completely before applying
any actions. Clicking Next
without first clicking Apply
Changes allows you to do
that.

Click to go back to the previous
wizard step.

BackClick to toggle on/off options
related to gas and powder
convection.

Advanced
Options

Click to exit the wizard. Any
actions you have performed using

Exit Wizard

Apply Changes will be maintained
in the project tree. No additional
actions will be performed upon
exit.

Input fields are described in the following table.

DescriptionInput Fields

Enter Thermal Strain Scaling Factor. This is an optional input that scales
the thermal strains in the structural portion of a Thermal-Structural

Calibration Settings

simulation by a given value. It is usually determined from calibration
experiments (p. 199) to account for differences in materials, machines, and
other factors.

Affects these tree objects: Build Settings

Enter the Machine Settings, which are settings and process parameters
that directly influence how the process deposits material.

Machine Settings

• Heating Method is the simulation assumption related to how the
material is heated for each new layer as it is added (made alive).
Choose either Melting Temperature (default) or Power. For Power,
additional inputs are required:

– Heating Duration is the amount of time the heat is applied,
either Scan Time (default) or Flash.

→ Scan Time means that heat is applied for the amount
of time it takes to scan the volume of material in each
element layer. This setting may give better
temperature results at the end of the layer but may
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not yield a temperature spike above melting. Note
that this Scan Time option will have a different end
time of the simulation because the layer thickness
adjustment for cooling will not be used.

→ Flash means that heat is applied in a very short time
increment resulting in a spike in temperature then
cooling before the next element layer is added.

– Beam Power is the power of the laser.

– Absorptivity is a fraction that describes how much energy
is absorbed by the material and contributes to the heating
process. Value must be between 0 and 1.

• Hatch Spacing is the average distance between adjacent scan
vectors when rastering back and forth with the laser. Hatch spacing
should allow for a slight overlap of scan vector tracks such that
some of the material re-melts to ensure full coverage of solid
material.

• Deposition Thickness is the thickness of deposited material in
every pass of the recoater blade. Specifically, use the amount the
base plate drops between layers.

• Scan Speed is the average speed at which the laser spot moves
across the powder bed along a scan vector to melt material,
excluding jump speeds and ramp up and down speeds.

• Dwell Time is the span of time from the end of the laser scan of
one layer to the start of the laser scan of the next layer. It includes
the time required for recoater-blade repositioning and powder-layer
spreading as well as deposition of other parts that may be part of
the build but are not being simulated.

• Dwell Time Multiplier multiplies the scan time by the specified
number to represent identical parts built at the same time, but not
present in the simulation. If they are the same part arranged in the
same orientation on the build plate, the multiplier is the number
of parts.

In the case of symmetry, the Dwell Time Multiplier is required to
reconcile the reduced time to simulate the build and should be
equal to the number of repetitions (or sectors). For example, the
build time for a half symmetry model is ½ of the build time of the
full model, so the Dwell Time Multiple should be 2. Similarly, for a
quarter symmetry model, enter 4 for Dwell Time Multiplier, and so
on.

• Number of Heat Sources is the number of lasers if using
multiple-beam printers. This divides the amount of time it takes to
scan a layer by the number of heat sources specified.
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Affects these tree objects: Build Settings

Enter Build Conditions, which are settings pertaining to the environment
around the build during the deposition process. In LPBF, heat loss to the

Build Conditions

powder is simulated as a convection boundary condition unless it is
explicitly modeled as a body (see Advanced Options in the Model Setup
step (p. 43)).

By default, these conditions will be added as thermal boundary
conditions with the default values for temperature and convection
coefficients set by the wizard. Convection coefficients default to 10

W/(m)2(°C). Use Advanced Options (p. 57) to customize build
conditions.

• Preheat Temperature is the starting temperature of the build plate.

Affects these tree objects: Build Settings

Select the face of the base where preheat temperature should be applied,
usually the underside of the base. Then click Apply. Use Ctrl-click to select

Base Thermal Boundary
Conditions

multiple faces. By default, the underside surface of the base is already
selected.

Affects these tree objects: Thermal boundary conditions and loads under
Transient Thermal system

Select the face of the base where the fixed support should be applied,
usually the underside of the base. Then click Apply. Use Ctrl-click to select

Base Structural Boundary
Conditions

multiple faces. By default, the underside surface of the base is already
selected.

Affects these tree objects: Fixed boundary condition under Static Structural
system

Advanced Options

Enter details about the Build Conditions, which are settings pertaining to
the environment around the build during the deposition process. In LPBF,

Build Conditions

heat loss to the powder is simulated as a convection boundary condition
unless it is explicitly modeled as a body (p. 194).

Convection coefficients default to 10 W/(m)2(°C).

• Preheat Temperature is the starting temperature of the build plate.

• Gas/Powder Temperature setting allows you to use either Preheat
Temperature or user-specified.

– Gas Temperature is the temperature in the chamber during
the build.

– Powder Temperature is the temperature of the powder
surrounding the part.
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• Gas Convection Coefficient is the convection coefficient from the
build to the enclosure gas. The convection is applied only to the
top of a newly laid layer.

• Powder Convection Coefficient is the effective convection
coefficient from the sides of the build to the powder bed. To
estimate, divide the conduction property of the powder by a
characteristic conduction length into the powder (for example, a
quarter of the distance from the build boundary to the
build-chamber wall).

• Powder Property Factor is a knockdown factor used to estimate
the powder properties. The Mechanical application applies the factor
to the solid material properties to estimate the properties of the
material in its powder state. The powder-state properties are used
in the newly added layer during the heating of the new layer (before
its subsequent solidification and cooldown) prior to the next layer
being applied. The default value is 0.01.

This powder knockdown factor is also used if powder is explicitly
modeled (p. 194) in the build.

Affects these tree objects: Thermal boundary conditions and loads under
Transient Thermal system

Enter details about Cooldown Conditions, which are settings pertaining to
the environment in the build chamber around the build in the cooldown
step after the build is completed.

Cooldown Conditions

• Room Temperature is the ambient room temperature.

• Gas/Powder Temperature setting allows you to use either Room
Temperature or user-specified.

– Gas Temperature is the temperature in the chamber during
the cooldown.

– Powder Temperature is the temperature of the powder
during the cooldown.

• Gas Convection Coefficient: Same definition as in build conditions.

• Powder Convection Coefficient: Same definition as in build
conditions.

Affects these tree objects: Thermal boundary conditions and loads under
Transient Thermal system

Enter details about the thermal boundary conditions applied on the
specified surface of the base, usually the underside surface, during the

Base Thermal Boundary
Conditions
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build and during cooldown. Boundary condition options include
temperature, convection, or an adiabatic condition (no heat transfer).

• Base Face Selection: Select the face of the base where preheat
temperature should be applied, usually the underside of the base.
Then click Apply. Use Ctrl-click to select multiple faces. By default,
the underside surface of the base is already selected.

• Build Condition is the boundary condition applied to the selected
surface during the build, either Temperature, Convection, or
Adiabatic (no heat transfer).

– Build Boundary Temperature (default): Temperature applied
on the specified surface of the base during the build.

– Build Convection Temperature: Temperature for convection
applied on the specified surface of the base during the build.

– Build Convection Coefficient: Convection coefficient
representing heat loss through the bottom of the base to
the machine during the build.

• Cooldown Condition is the boundary condition applied to the
selected surface during the cooldown, either Temperature,
Convection, or Adiabatic (no heat transfer):

– Cooldown Boundary Temperature: Temperature applied
on the specified surface of the base during the cooldown.

– Cooldown Convection Temperature (default): Temperature
for convection applied on the specified surface of the base
during the cooldown.

– Cooldown Convection Coefficient (default): Convection
coefficient representing heat loss through the bottom of the
base to the machine during the cooldown.

Affects these tree objects: Thermal boundary conditions and loads under
Transient Thermal system

4.4. Wizard Step 3: Postprocessing Options

In the Postprocessing Options step:

• Select the post-build processing steps you want to simulate, such as base unbolting, heat treat-
ment, and base and/or support removal. The default sequence for post processing will be base
unbolting, heat treatment, support removal, and then base removal at the end, depending on
which options are chosen. In the case of multiple supports, removal will be in the order that the
supports were added. To reorder how the steps will be performed in the simulation, exit or finish
out of the wizard and then modify the sequence directly in Mechanical using the AM Process
Sequence worksheet (p. 97).
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• Click Add Results to add standard result items to the project tree, specifically Temperature for
a thermal system and Total Deformation, Equivalent Stress, and Equivalent Total Strain for the
structural system. Also, select LPBF result items to be calculated during solution, such as Hotspot,
Recoater Interference, and High Strain. Specify criteria for warning and critical thresholds for
these LPBF result items, or add multiple versions with different criteria for comparison.

Action buttons are described in the following table.

FunctionAction
Button

FunctionAction Button

Click to bring up help for this
wizard step.

HelpClick to apply the actions for this
wizard step, which updates the
project tree. If you make changes,
click Apply Changes again.

Apply Changes

Click to go back to the previous
wizard step.

BackClick to add standard result items
to the tree, specifically
Temperature (for a thermal system)

Add Results

and Total Deformation, Equivalent
Stress, and Equivalent Total Strain
(for the structural system), and the
specified LPBF result items,
specifically Hotspot, Recoater
Interference, and High Strain.

Click Add Results again to add
multiple LPBF result items,
perhaps with different criteria
defined for each.
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FunctionAction
Button

FunctionAction Button

Note that if the standard
result items mentioned above
are already in the project tree,
new ones will not be added
by the wizard. However, if
LPBF-specific result items are
already in the project tree,
new ones will be added by
the wizard.

Click to apply changes to all steps
sequentially and then exit the

FinishClick to read the status of objects
in the project tree and update the
wizard input fields accordingly.

Read from
Tree

wizard. (This includes mesh
generation even if you may have
already generated a mesh.)

Think of this as the opposite action
of Apply Changes, which updates
the objects in the project tree with
inputs from the wizard.

For this step of the wizard,
only objects in the tree
related to the
sequencer (p. 100) are read.

Click to exit the wizard. Any
actions you have performed using

Exit WizardClick to save wizard inputs as a
template. Navigate to the desired
folder, enter a file name, and click

Save Template

Apply Changes will be maintained
Save. The file is saved as an xml
file.

The items saved on the xml
file include materials, mesh

in the project tree. No additional
actions will be performed upon
exit.

settings, build settings, and
postprocessing options.
Geometry selections and
advanced options involving
geometry selections/picks are
not included in saved
templates.

Use Load Template in the
Model Setup step (p. 21) to
use a template in subsequent
simulations.

Input fields are described in the following table.

DescriptionInput Fields

Choose Base Unbolting to simulate the base plate being unbolted
from the machine after the build and cooldown processes are

Post Processing Steps: Base
Unbolting
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complete. Specifically, the constraints for UX, UY, and UZ will be
removed from the base plate nodes and weak springs are turned on
in Analysis Settings. Unbolting the base prior to heat treatment can
be especially important to prevent any artificial stress in the base due
to fixed boundary conditions and thermal expansion during heating.

Affects these tree objects: AM Process Sequence worksheet (p. 100),
Analysis Settings

Choose Heat Treat to simulate a heat treatment process, such as
annealing, to relieve residual stresses. In an annealing process, metal

Post Processing Steps: Heat
Treat

is heated in a furnace to a particular high temperature, held there for
a long time (hours or days), and then allowed to cool slowly.

• Heat Treat Geometry Selection Select all the bodies in the
model, including the base plate. By default, all bodies are
selected for you. (Note: Any STL Supports present in the model
are selected for heat treatment although they are not included
in the body count.)

• Heat Treat Temperature is the temperature for the isothermal
hold.

• Heat Treat Convection Coefficient is the convection coefficient
of the gas in the furnace.

• Heat Treat Ramp Time is the time, in seconds, to ramp up to
the Heat Treat Temperature.

• Heat Treat Hold Time is the isothermal temperature duration,
in seconds.

• Heat Treat Cooldown Time is the time, in seconds, allowed
for cooldown.

Choose one of the following properties as the mechanism to
account for the stress relaxation:

• Creep Properties uses a creep model as the mechanism
for stress relief. When selecting this option, and upon
clicking Apply Changes or Finish:

– The creep model for your chosen material is
automatically unsuppressed (p. 179) in Workbench's
Engineering Data.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.62

Using the LPBF Setup Wizard



– The units used during solution will automatically
switch to the unit system required for the creep
model.

Important:

Be aware that changes in Engineering Data,
such as suppressing/unsuppressing the creep
material model, causes the wizard to refresh
the whole Workbench project. Any other
upstream changes made to the project,
including changes to geometry, will be updated
during this process.

• Relaxation Temperature is the temperature at which
strains begin to soften. It is lower than the melting
temperature. Using the Relaxation Temperature option is
a simplified approach resulting in an abrupt stress
relaxation.

Note:

We strongly recommend you also choose the Base
Unbolting option if you choose Heat Treatment.
Unbolting the base prior to heat treatment can be
especially important to prevent any artificial stress in
the base due to fixed boundary conditions and thermal
expansion during heating.

Affects these tree objects: AM Process Sequence worksheet (p. 100),
Analysis Settings, and Imported Load under Static Structural system.
Adds a Transient Thermal system with all its child objects.

Choose Base Removal to simulate the removal of the build from the
base.

Base Removal Type determines how the base is removed from
the analysis at the end of cooldown:

Post Processing Steps: Base
Removal

• Instantaneous simulates instantaneous cutoff at the base
(bottom layer of elements only).

• Directional simulates a progressive cutoff at the base
(bottom layer of elements only), in which you specify the
distance of each cut increment and the angular direction
for removal from the base.

– Removal Step Size is the distance removed in each
cut step. Cannot be 0 or a negative number.
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– Removal Direction is the directional cutoff angle
on the X-Y plane as measured from the +X axis. For
example, a value of 90 results in a cutoff direction
in the +Y direction.

Affects these tree objects: AM Process Sequence worksheet (p. 100)
and Analysis Settings under Static Structural system

Choose Support Removal to simulate the instantaneous removal of
the supports from the part bodies. In the case of multiple supports,
removal will be in the order that the supports were added.

Affects these tree objects: AM Process Sequence worksheet (p. 100)
and Analysis Settings under Static Structural system

Post Processing Steps: Support
Removal

Choose Hotspot to add an LPBF Hotspot result item to your project
so that the appropriate data is written out during solution. Available

LPBF Results: Hotspot

only for simulations with thermal solves (LPBF Thermal-Structural
simulation). The Hotspot result tool is used to identify areas of
overheating that may result in problematic thermal conditions.

Threshold Definition: Either None or User Defined:

• None (default): The result tool will show the temperature
of each layer right before the next layer is added. The most
concerning hotspots are going to be the areas with the
highest temperature for that layer. Results are localized
(based on nodal values), not averaged across the layer.
Use a section plane to reveal hotspots inside the part.

• User Defined: You define your own warning and critical
thresholds:

– Warning Threshold: Temperature above which
results are considered a warning.

– Critical Threshold: Temperature above which
results are considered critical.

Important:

The data is based on the temperature that the build cools
down to at the end of each layer right before the next
layer is added. It does not represent the "final state" of
temperatures at the end of the cooldown step.

For more information about interpreting results after the
simulation is solved, see Review Results (p. 123).
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Affects these tree objects: LPBF Hotspot result item

Choose Recoater Interference to add an LPBF Recoater Interference
result item to your project so that the appropriate data is written out

LPBF Results: Recoater
Interference

during solution. The Recoater Interference result specifies the level of
Z-deformation at which the build may interfere with the recoater's
spreading.

Threshold Definition: Either None, Layer Thickness Based, or User
Defined:

• None (default): The result tool will show pure
Z-deformation in the build, where the value at each point
corresponds to the Z-deformation when that material was
a new layer.

• Layer Thickness Based: The result tool uses the Deposition
Thickness and Powder Packing Density to determine the
thresholds for warning and critical deformation. Specifically,
if the Z-deformation for any layer is equal to or greater
than the Deposition Thickness it is considered a warning.
If the Z-deformation is equal to or exceeds the value of
Deposition Thickness/Powder Packing Density, it is
considered critical.

– Powder Packing Density: May be dependent on
the powder particle size, material, spreading
mechanism, or other factors.

• User Defined: You define your own warning and critical
thresholds:

– Warning Threshold: Z deformation above which
results are considered a warning.

– Critical Threshold: Z deformation above which
results are considered critical.

Important:

The data is based on the Z deformation of each layer
right before the next layer is added. It does not represent
the "final state" of deformation at the end of the
cooldown step.

For more information about interpreting results after the
simulation is solved, see Review Results (p. 123).

Affects these tree objects: LPBF Recoater Interference result item

Choose High Strain to add an LPBF High Strain result item to your
project so that the appropriate data is written out during solution.

LPBF Results: High Strain
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The High Strain result shows the maximum equivalent strain
experienced during the build process. It can help to identify regions
at risk of cracking.

Threshold Definition: Either None or User Defined:

• None (default): The result tool will show pure maximum
equivalent strain in the build, where the value at each
point corresponds to the strain when that material was a
new layer.

• User Defined: You define your own warning and critical
thresholds:

– Warning Threshold: Maximum equivalent strain
above which results are considered a warning.

– Critical Threshold: Maximum equivalent strain
above which results are considered critical.

For more information about interpreting results after the
simulation is solved, see Review Results (p. 123).

Affects these tree objects: LPBF High Strain result item
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Chapter 5: Workflow Through the Project Tree
An AM process simulation involves most of the general steps found in any Ansys analysis with some
additional steps and considerations. The workflow is described in the following sections:

5.1. Create the Analysis System

5.2. Define Engineering Data

5.3. Attach Geometry and Launch Mechanical Application

5.4. Identify Geometries (AM Process Object)

5.5. Assign Materials

5.6. Apply Mesh Controls and Generate Mesh

5.7. Identify and/or Generate Supports

5.8. Define Connections

5.9. Define AM Process Steps

5.10. Define Build Settings

5.11. Establish Thermal Analysis Settings (Thermal-Structural System)

5.12. Apply Thermal Boundary Conditions (Thermal-Structural System)

5.13. Solve the Transient Thermal Analysis (Thermal-Structural System)

5.14. Establish Structural Analysis Settings

5.15. Apply Structural Boundary Conditions

5.16. Solve the Static Structural Analysis

5.17. Review Results

5.1. Create the Analysis System

Ansys analysis systems are the mechanism to define physics type, analysis type, and solver type. There
are two predefined, custom systems specifically for Laser Powder Bed Fusion (LPBF) additive manufac-
turing:

• AM LPBF Inherent Strain: A structural-only system in which strains are calculated from the use
of a Strain Scaling Factor rather than from material properties and thermal loads.

• AM LPBF Thermal-Structural: A linked transient thermal analysis followed by a static structural
analysis where strains are calculated from material properties and thermal loads. For simplification,
we assume the physics are uncoupled in that data flows one-way from the thermal analysis to
the structural.

While it is possible to set up an appropriate system without using an AM custom system in Workbench,
we recommend you use a custom system because AM sample materials and several settings are set
automatically for additive simulations. If you use a Mechanical Model from Workbench's Component
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Systems, you must manually create the AM custom system. This is due to the fact that AM custom systems
are pre-populated with AM sample materials in Engineering Data, and linking to the Mechanical Model
necessitates the absence of materials in Engineering Data. If you open the Mechanical application inde-
pendent of Workbench, you must manually insert the appropriate systems.

The remaining steps in this workflow assume you use an AM custom system.

Procedural Steps

1. Open Ansys Workbench.

2. Scroll down within the list of analysis systems to the list of custom systems and double-click your
preferred AM custom system, either AM LPBF Inherent Strain or AM LPBF Thermal-Structural.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.68

Workflow Through the Project Tree



5.2. Define Engineering Data

In this step, you define the source of your materials using the Engineering Data repository for material
properties. The Engineering Data workspace is designed to allow you to create, save, and retrieve ma-
terial models, as well as to create libraries of data that can be saved and used in subsequent projects
and by other users.

We recommend using temperature-dependent properties covering the range from room temperature
to melt temperature. For the thermal analysis portion of an LPBF Thermal-Structural simulation, the
properties required are thermal conductivity, density, and specific heat, and melting temperature must
be defined for the material. For the structural analysis we require Young’s Modulus, Poisson’s Ratio,
coefficient of thermal expansion, and a plasticity model, such as bilinear isotropic hardening (BISO). For
an AM LPBF Inherent Strain simulation, both bilinear isotropic hardening (BISO) and multilinear isotropic
hardening (MISO) plasticity models are supported.

The following popular materials for AM are provided as Ansys predefined samples in the Additive Ma-
terials library portion of the Engineering Data repository:

• 17-4PH Stainless Steel

• 316 Stainless Steel

• AlF357

• AlSi10Mg

• Co-Cr

• Inconel 625

• Inconel 718

• Ti-6AI-4V

The Ansys predefined materials are defined with bilinear isotropic hardening (BISO) plasticity models.

All of the Ansys AM sample materials have creep properties defined. Use creep properties as the
mechanism for stress relief when simulating heat treatment to achieve more realistic residual stress relief
effects.

Note:

The material properties used to generate thermal (loading) strains are not customizable when
using Machine Learning Thermal Strain as your chosen strain definition for LPBF Inherent
Strain simulations, as specific materials were used to train the ML model. In particular, the
materials used to train the model are the same as those validated for thermal simulations in
the Additive application.

Procedural Steps

Using Ansys Predefined Materials
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The sample materials in the Additive Materials library (within the Engineering Data repository) are
automatically available when you insert an AM custom system, either AM LPBF Inherent Strain or AM
LPBF Thermal-Structural. If you plan to use one of the sample materials without heat treatment, no action
is required here and you can move to the next step.

To use creep properties as the mechanism for stress relief in a heat treatment analysis using Ansys
predefined materials, unsuppress the creep model in Engineering Data (p. 179) as described in the heat
treatment advanced topic.

Using Granta MI's JAHM Curve Data

For information on using a material from the JAHM Curve Data database, see Using JAHM Temperature-
Dependent Material Data in AM Simulation (p. 140). Note that either a Granta Selector or a Granta MI
license is required to get access to JAHM datasets.

Using Custom Materials

To add your own custom material, follow the procedures as described in Material Data in the Engineering
Data User's Guide. A nominal strength should be provided at the melt temperature, as a near zero
modulus and/or yield strength could lead to convergence problems. (Ansys predefined materials take
care of this internally.)

For information about defining your own creep model, see Creep Material Models in the Material Refer-
ence.

5.3. Attach Geometry and Launch Mechanical Application

Go directly to procedural steps. (p. 71)

Typically, you’ll have these geometric bodies in the simulation model:

• Part – This is the part you are manufacturing. It should be a closed volume (that is, watertight), and
should be oriented with the global Z axis as the build direction. It may be modeled either resting on
the base plate (Z=0), or elevated off the base plate by supports.

The part can be made of multiple bodies but must have boundaries that are aware of each other in
order to assure a proper conformal mesh throughout the part. A conformal mesh is one where the
elements fit together seamlessly along their shared boundaries or faces. In other words, there are no
gaps or overlaps between adjacent elements. This is achieved through either shared topology, a
voxelization mesh option, or AM Bond connections, depending on your meshing approach, as described
in the meshing step (p. 78).

If your model exhibits symmetry, you can simulate a sector of a large model to achieve a faster sim-
ulation time. See Modeling a Symmetrical Part (p. 189) for more details.

Usually only one part is simulated even if there will be many duplicate parts nested on the base plate
for efficiency. (A multiplier on the build time should be used if this is the case, as described in Machine
Settings (p. 97).)

• Support Structures – Supports are needed to anchor overhanging part features so they do not break
away from the platform during the 3D print process because of residual stress buildup. Overhanging
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features are usually those with angles less than 45° to the horizontal X-Y plane. Supports may be
modeled in several ways. Together, the part and supports constitute the build.

• Base Plate – This is the platform on which the build (part plus supports) is to be printed. It is included
in the simulation because it acts as a heat sink.

Other geometric bodies that may be simulated include:

• Powder – Modeling the powder may be useful if you will be simulating multiple parts close to-
gether on the build plate or if the part has features close together, where accounting for the
heat transfer occurring between the parts or features is important. Create a separate, closed-
volume (watertight) body to represent the powder in-between multiple parts or in-between
features of the same part. Details of how to model powder (p. 194) in the simulation are found
in Advanced Topics.

• Non-build Components – At times you may want to simulate geometry items that are present
on the build plate but that are not being 3D-printed. These items may include clamps, bolts,
measuring devices, instrumentation, etc. They may influence the heat dissipation and/or distortion
of the part being built so they need to be included in the simulation. Details of how to model
non-build components (p. 196) are found in Advanced Topics.

For your part geometry, commonly imported file types include .dsco files from the Ansys Discovery
application, .3MF files, such as those from Materialise Magics, and stereolithography .stl files (faceted).
For other options, see Attach Geometry/Mesh in the Mechanical User's Guide.

You may create the base plate and supports ahead of time in the CAD program or in a support gener-
ation tool, or wait to create those bodies in the Mechanical application (described in subsequent steps).
If supports are created in CAD, the part and support bodies should be kept as separate bodies (that is,
not merged) so that they can be distinguished as such in the AM simulation in the Mechanical application.
Whether you set the bodies to "share topology" in the CAD program depends on whether you will be
using a Cartesian mesh, a Cartesian mesh with voxelization option, or a layered tetrahedrons mesh in
the simulation in Mechanical. For a discussion about this topic, see To Share Topology or Not? (p. 13).
When everything is imported into the Workbench application, you will later identify the support bodies
as predefined supports.

Alternatively, you may choose to not include supports when you attach the part but import the supports
separately later as .stl files.

Procedural Steps

Refer to one of the following topics depending on your import method:

5.3.1. Attaching Geometry from an .stl File

5.3.2. Importing Geometry from a .3MF File

5.3.3.Working with Supports from Additive Prep

5.3.1. Attaching Geometry from an .stl File

To attach geometry and launch the Mechanical application:
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1. Right-click the Geometry cell of the left-most analysis block (either AM LPBF Inherent Strain or
AM LPBF Thermal) and select Import. Browse for your file and import it. (Double-clicking on the
Geometry cell opens the Ansys Discovery application.)

2. After importing geometry, double-click the Model cell (or right-click, and select Edit) of the left-
most block to launch the Mechanical application. It may take a few minutes for the application
to open and your geometry to appear in the Geometry window. (In addition to the Workbench

icon, , in the taskbar, note the  icon once the Mechanical application opens; there are now
two applications open.)

3. Once your geometry is loaded in the Mechanical application, review how it is presented in the
project tree.

We will use an example model to be simulated that includes an arch part and a solid support as
separate bodies comprising the build, and the base plate as another separate body.

Recall that there are different requirements for connectedness of geometric bodies depending
on the mesh method you will use:

• A Cartesian mesh method requires shared topology between the part and predefined
supports.

• A Cartesian mesh method with the voxelization option may have shared or unshared topology
between the part and predefined supports.

• A layered tetrahedrons mesh method requires that there be no shared topology (that is,
unshared topology) between the part and predefined supports.

To check whether your geometry has shared topology, click the Display tab and in the Edge group,
choose Color and then choose By Connection from the drop-down menu. Pink edges means that
an edge is shared by three faces which is an indication of shared topology.

In the arch with support example, the geometry in the first figure has shared topology. First notice
the structure of the bodies in the project tree. The arch part and support bodies are child objects
under Build. Also, in the Geometry window, note the pink edges at the body interfaces when Edge
Coloring > By Connection is turned on. We will mesh this model with a Cartesian mesh method
(without using the voxelization option).
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The geometry in the next figure has unshared topology. Notice how the bodies are shown as in-
dependent bodies in the project tree, not as child objects under the Build object. Also, there are
no shared edges between bodies (lines are black instead of pink), indicating there is no shared
topology. We will mesh this model with a layered tetrahedrons mesh method.

4. Once the Mechanical application opens, it is a good time to adjust the number of processors
(cores) you are using on your computer. Depending on the complexity of your model, AM Process
Simulations may be computer intensive. If you have an Ansys HPC license, access the option in
the Solve group on the Home tab and change the Cores to something appropriate for your sim-
ulation.
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5.3.2. Importing Geometry from a .3MF File

To import an AM model from a 3D Manufacturing Format, or .3MF file, do not attach geometry in
the Workbench application. Instead, you will import the geometry directly into the Mechanical applic-
ation when it opens.

1. Double-click the Model cell (or right-click, and select Edit) of the left-most analysis block to launch
the Mechanical application. It may take a few minutes for the application to open. (In addition to

the Workbench icon, , in the taskbar, note the  icon once the Mechanical application opens;
there are now two applications open.)

2. Set the unit system in the Mechanical application to be the same as used for the Geometry Length
in your .3MF file. On the right-hand side of the status bar (blue bar on the bottom of the UI),
click the expandable triangle and change to the correct unit system as needed.

3. Load the LPBF Process Add-on (p. 8).

4. From the LPBF Process ribbon, click Import from 3MF. Navigate to your .3MF file and click OK.

The import function works by reading the structure of the .3MF file. A .3MF file describes geometry
by listing the coordinates of vertices and constituent triangles, much like an .stl file. The Import
from 3MF feature supports the core specification as defined by the 3MF Consortium, which includes
information about the geometries and their relationships but not material or slicing information.

During an import, Geometry Import objects are created and added in the Mechanical application's
project tree, and an .stl file is generated for each part and support body and placed beneath the
appropriate Geometry Import object. Additionally, an AM Process object is added, and the newly in-
serted geometries are automatically scoped to it. That is, the part and support geometries (and base
plate if present) are automatically identified and the supports for each part are scoped within a single
Support Group under AM Process. The image below shows a model from an imported .3MF file.
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After import, there is a message such as the following: Geometries from the .3MF file have been imported
as .stl files. Meshing options may be limited. We recommend using the LPBF Setup Wizard to set up the
simulation. Using the wizard is the best way to proceed as it has automatic short-cuts built-in. See
Using the LPBF Setup Wizard (p. 17).

5.3.3. Working with Supports from Additive Prep

If you created your model for AM simulation that includes generated supports in Additive Prep:

• From within the Ansys SpaceClaim application, use the recommended transfer to Workbench
feature, which attaches the geometry automatically. You can then skip step 1 in the procedural
steps (p. 71) above.

• If you do not use the recommended transfer to Workbench feature and instead open the
Mechanical application directly with a saved .scdoc file:

– The Mechanical application recognizes the file as an AM file and launches with the AM
Process and STL Supports objects automatically populated. If you had not joined the
individual supports together into one support for each part, they will be imported as
many individual stl supports and it may be unmanageable to continue on for simulation.

– With the AM Process object already in place, the LPBF Setup Wizard cannot be used to
set up this simulation. Continue setting up the simulation manually in the project tree.
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5.4. Identify Geometries (AM Process Object)

On the imported geometry, identify which bodies are associated with the build (part and supports, if
any) and the base plate. If your geometry from CAD does not include a base plate, use the Construction
Geometry feature to create one.

Procedural Steps

We use the AM Process object in the project tree to establish the options and assumptions appropriate
for an additive manufacturing simulation. Note that the AM Process object is available only if you have
an Ansys Additive Suite software license with Ansys Mechanical Enterprise or one of the multiphysics
bundles. If AM Process is grayed out, check your software license.

If you have inserted an AM custom system—either AM LPBF Inherent Strain or AM LPBF Thermal-
Structural— as the analysis system, or you are working with a model transferred from Additive Prep
using the transfer to Workbench feature, then the AM Process object is already added and you can skip
the first step in the procedural steps below.

1. Select the Model object in the project tree, then select the Model contextual tab on the ribbon and

then the AM Process option  in the Define group. Or, right-click the Model object or in the
Geometry window and select Insert > AM Process.

Once you insert the AM Process object, certain automatic actions take place. The application auto-
matically:

• Displays the AM Process context tab, providing useful shortcut options specific to an AM Process
Simulation. These options will be demonstrated in subsequent steps. Note that the AM Process
context tab is visible only when the AM Process object in the tree is selected.

• Sets Step Controls in an AM Process Sequence worksheet (discussed later) and in Analysis Settings
for each analysis.

• Suppresses the calculation of thermal fluxes, nodal forces, Euler angles, volume and energy, and
other miscellaneous items to reduce the size of the results file. (Set in Analysis Settings for the
transient thermal analysis.)

2. Next you need to identify which bodies are which in the geometry you imported. Select the AM
Process object and then:

• Select the body or bodies representing the part and the supports that make up the Build Geometry
and hit Apply in the Details view. To select a body, be sure that your mode of selection is on body

 (rather than on face, edge, or vertex). Use the Ctrl key while clicking
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the left mouse button to select multiple entities (or click, hold, and drag). Or use named selections
as a basis for selection. The build is now shown in red.

When selecting supports for identification, select only solid support bodies and not volumeless
supports (STL Supports) that may have been imported via transfer from Additive Prep. If you want
to have the application create supports automatically, you’ll do that later. For more information
about supports, see Identify and/or Generate Supports (p. 86).

• Select the body that is the Base Plate Geometry and hit Apply in the Details view. The base is
now shown in blue. (If your imported geometry does not have a base plate, construct one using
step 3.)

At the bottom of the Details view, the offset of the part from the base is shown as Z Location at
Top of Base. This is simply a confirmation of what the Mechanical application reads from the CAD
file.

3. To create the base plate if not imported with the CAD geometry, select the Model object and then:

• Right-click the Model object or in the Geometry window and select Insert > Construction Geo-
metry.

• Right-click the new Construction Geometry object (under Model) and choose Insert > Solid.

• In the Details panel, fields appear for you to enter overall dimensions of the base and coordinates
for the center of the top of the base. Enter values for X1, X2, Y1, Y2, Z1 and Z2. An outline is
provided to preview the dimensions. Right-click on Solid and select Add to Geometry. See Con-
struction Geometry for more information.

• To identify this newly created body as the Base Plate Geometry, highlight the AM Process object,
select the new body and hit Apply in the Details view for Base Plate Geometry.
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5.5. Assign Materials

In this step, you assign a material to each geometry body, considering the following guidelines:

• All bodies comprising the build (part and supports) must be the same material.

• The base plate can be a different material.

• If you are modeling powder, use the same material as the build.

• Non-build components can be different materials.

Procedural Steps

When you select a geometry entity in the project tree, the Details view lists all the settings associated
with that body.

1. In the project tree under Model, expand the Geometry object to see its child objects below it. Select
the geometric entity that is the build geometry and, in Details view, change the Assignment (under
Material) to be the AM material that you want to use, either one of the Ansys predefined samples,
or a custom material you defined in Engineering Data (p. 69). When you assign a material to the
build, the child objects below it (the part and supports) are also assigned that same material.

2. Select the entity that is the base plate body and change its material Assignment, as desired.

5.6. Apply Mesh Controls and Generate Mesh

Go directly to procedural steps. (p. 79)

The layer-by-layer additive printing process is simulated with element layers added one-by-one using
the element birth/death technique. As such, the mesh must have a uniform size in the build (global Z)
direction. That is, each element layer must have the same height (constant Z coordinate).

For the build, we recommend using one finite element "super layer" of elements to represent 10-20
actual metal powder layers. If your machine has a 25-micron powder layer thickness (also called deposition
thickness), your element size should be between 0.25 and .5 mm. The element sizing does not have to
be an even multiple of the deposit layer thickness. Note that the real machine build time is approximately
the transient thermal build step simulation time multiplied by R^(1/3), where R is the number of deposit
layers in one element layer. (This estimate of the real build time is provided for you in the simulation
results.)

A much coarser mesh is acceptable for the base plate because it is simply serving as a heat sink and a
fixed support in the simulation.

Three primary meshing methods/options are available for additive manufacturing process simulation,
each with their strengths and weaknesses.

• The Cartesian Mesher creates a hex mesh that approximates the geometry. Small features,
curved surfaces, and horizontal or vertical surfaces that are not multiples of the mesh size are
not captured accurately unless a small mesh size is used. The method is fast and, for most distor-
tion and residual stress predictions, is quite adequate.
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The Mechanical application can automatically generate supports when a part has a Cartesian
mesh. (See Generated Supports (p. 90) in the next step.)

• The Cartesian Mesher with the voxelization option creates a voxel (cubic element) mesh for
the geometry. Small features, curved surfaces, and horizontal or vertical surfaces that are not
multiples of the mesh size are accounted for by a knock-down factor technique.

Limitations with the voxelization option:

– The voxelized mesh option (Cartesian Mesh with Voxelization Option) is not available on
a Linux platform because the underlying voxelizer code is incompatible with Linux. Choose
between a Cartesian mesh or a layered tetrahedrons mesh.

– Shared topology between part bodies, predefined supports, and/or powder bodies is al-
lowed with the voxelization option but not recommended because some elements may
get assigned to the wrong body at the interface.

• The Layered Tetrahedrons Mesher creates a tetrahedrons mesh that conforms to a specified
layer size. It captures the geometry well, and is useful if there are organic curves, small features,
such as holes, or thin-walled parts.

Limitations with the layered tetrahedrons mesher:

– Bodies with shared topology cannot be meshed with the layered tetrahedrons mesher.
We recommend you separate bodies into individual parts in CAD. (Use the Unshare tool
in the Shared Topology group to unshare coincident topology in Discovery, or Explode
Part in DesignModeler to do this.) See To Share Topology or Not? (p. 13).

– The AM octree adaptive meshing (p. 163) method is not supported for parts meshed with
layered tetrahedrons.

– Auto-generated supports are not available for parts meshed with layered tetrahedrons.
If you want to use layered tetrahedrons mesh, you must either include supports with your
geometry as predefined supports or import a support as a separate .stl file.

– The model should not have other suppressed bodies.

– The mesh is not associated back to the geometry.

– This method cannot be used in conjunction with mesh controls such as Inflation, Refine-
ment, Match Control, Pinch, Face Meshing, Face Sizing, and Edge Sizing controls.

Procedural Steps

We will describe the meshing steps using the arch with support model for both the Cartesian and
layered tetrahedrons mesh techniques.
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Using a Cartesian Mesh

1. Set mesh controls for the part and support bodies. The size of the mesh is required to be the
same throughout all bodies in the build. Remember that the build requires a finer mesh than
the base plate.

a. To set mesh controls for the build, we will use a meshing shortcut designed for AM Process
Simulations. In the project tree, select the AM Process object and then select the Cartesian
Control option from the ribbon (AM Process context tab). Or, right-click the AM Process
object and select Insert > Cartesian Mesh. Notice that a Body Fitted Cartesian object has
appeared under the AM Process object and become active and that all the bodies that are
part of the build are selected.

b. In Details of the Body Fitted Cartesian object, under Definition, set the Element Size to
the desired value. (Click in the right column on the word Default to activate the text field.)

c. Under Advanced, you may choose to set the Projection Factor slider to a value between
0 and 1. The Projection Factor defines how well the mesh will fit to the geometry. A value
of 0 (default) results in cubic elements with a rough fit to the geometry. Increasing the
Projection Factor will change the shape of the elements to better fit the geometry and
may yield better results in some cases but may also result in a failed mesh. Our recommend-
ation is to leave it at 0, or close to 0, initially and then iterate from there to see the effects
of changing Projection Factor.

Important:

The Projection Factor must be set to 0 when using generated sup-
ports (p. 86).

You can apply a Coordinate System for the mesh. Typically, the default global coordinate system
is appropriate but you may want to set it to one located on the top surface of the base plate.

For additional information about Cartesian meshes, see Cartesian Method Control in the
Meshing User's Guide.

2. Set mesh controls for the base plate. Highlight the Mesh object and right-click Insert > Sizing.
A Sizing object is created under the Mesh object and becomes active.

a. Select the base plate body and hit Apply in the Details view.

b. Under Definition, change the Element Size to the desired value, something that will
result in a fairly coarse mesh.

3. Finally, highlight the Mesh object and right-click Generate Mesh. If you don't like the generated
mesh you can easily go back and change element sizes, then right-click Mesh and select Update.
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Using a Cartesian Mesh with Voxelization Option

1. First, set mesh controls for the part and support bodies. The size of the mesh is required to
be the same throughout all bodies in the build. Remember that the build requires a finer mesh
than the base plate.

a. To set mesh controls for the build, we will use a meshing shortcut designed for AM Process
Simulations. In the project tree, select the AM Process object and then select the Cartesian
Control option from the ribbon (AM Process context tab). Or, right-click the AM Process
object and select Insert > Cartesian Mesh. Notice that a Body Fitted Cartesian object has
appeared under the AM Process object and become active and that all the bodies that are
part of the build are selected.

b. In Details of the Body Fitted Cartesian object, under Definition, set the Mesh Using
Voxelization option to Yes. (This option is set to No and is grayed out on a Linux operating
system.)

c. Under Advanced, set the Element Size to the desired value.

d. Adjust the Wall Thickness, as needed, according to the single-bead thickness set by your
machine.

e. Adjust the Subsample Rate, as needed. For most cases, we recommend using the default
value of 5.

The part will be meshed with cubic elements. Each cubic element is divided into sampling
regions to determine density of material within that element. These are used as material
property knockdown factors. A Subsample Rate of 5 (default) = 5 x 5 x 5 = 125 subdivisions.
Subsample Rate affects the accuracy of element density.

2. Next, set mesh controls for the base plate. Highlight the Mesh object and right-click Insert >
Sizing. A Sizing object is created under the Mesh object and becomes active.

a. Select the base plate body and hit Apply in the Details view.

b. Under Definition, change the Element Size to the desired value, something that will
result in a fairly coarse mesh.

3. Finally, highlight the Mesh object and right-click Generate Mesh. If you don't like the generated
mesh you can easily go back and change element sizes, then right-click Mesh and select Update.

Important:

The mesh generated using the voxelization option is not fully associated to the part
geometry. Loads scoped to the part body (face, edge, vertex) are not possible. However,
loads scoped to the mesh of the part (that is, FE loads) are valid. These can be defined
with Named Selections or manual selection.

As a best practice when using the voxelizer mesh method, select all build bodies at one time for
a single mesh operation. This includes part bodies, Predefined Supports (p. 86), and powder
bodies, if any. As a result of the single voxel mesh operation, conformal mesh will be created
among all bodies and contact connections between them will not be needed. If each geometry
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has its own voxel mesh method object, then you will need to define AM Bond connections (p. 93)
or contacts between them.

Consider using AM octree adaptive meshing to reduce simulation time if your part has bulky or
blocky areas, especially near the bottom (that is, near the lower layers). The AM octree method
of nonlinear mesh adaptivity coarsens the mesh in previously deposited layers, resulting in a re-
duction in total element count. The method is only available for parts that have been voxelized.
See Using AM Octree Adaptive Meshing (p. 163).
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Using a Layered Tetrahedrons Mesh

To use a layered tetrahedrons mesh, in Ansys Mechanical:

1. Click Mesh in the Tree Outline, right-click and select Insert > Method. Select the build
geometry—use the Ctrl key to select multiple bodies, for example if you have part and
predefined support bodies—and in Details view, click Apply. In Details under Definition,
change the Method to Layered Tetrahedrons.

2. In the Layered Tetrahedrons Details view, set the Layer Height as desired. Note that
the layer height should balance the need to capture features and the need for a reasonable
simulation run time. The recommended setting for this "super layer" is 10-20 times the
size of the machine deposition thickness.

Most of the remaining advanced settings in the Details view have adequate defaults.

3. Click the Mesh object, and in its Details view, set the Element Size. Element Size can be
less than, equal to, or greater than the Layer Height but should not be greater than 6
times the Curvature Min Size. Consider starting with an initial value slightly larger than
Layer Height. This allows individual elements to have non-Z-direction edge lengths longer
than Layer Height while still keeping the overall Z-direction height at Layer Height.

Initially, use the default settings for the remaining options. The default settings are cus-
tomized for additive process simulations only when the AM Process object is in the project
tree so it is always best to add the AM Process object before meshing. Review the following
global mesh settings and change them as necessary:

Defaults
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Quadratic (default if the AM Process object is in the project tree).
Note that mid-noded elements will be generated, but the mid-nodes
will be kept straight and will not conform to the geometry.

Element Order

Can be greater than Layer Height. The Element Size should not be
greater than 6 times the Curvature Min Size specified. The mesh
quality reduces as the Element Size / Curvature Min Size ratio
increases.

Element Size

Sizing

No (default if the AM Process object is in the project tree)Use Adaptive Sizing

Yes (default if the AM Process object is in the project tree)Capture Curvature

Dynamically calculated to be 0.3 times the Layer Height (specified
in Details of Layered Tetrahedrons mesh method object). Used by
the mesher to generate a surface mesh before the slice layers are
generated, hence this min size drives the resolution of the mesh.
The min size should be decided based on the features that are to
be resolved and the Layer Height. A recommended value is 1/4 to
1/3 of the Layer Height.

Curvature Min Size

27 (default if the AM Process object is in the project tree). The
recommended range is 18 to 36. Use a lower angle if the model has
small features like holes and fillets that you want to preserve.

Curvature Normal
Angle

Dynamically calculated to be 10% of the Curvature Min Size. Used
to define the default value for sliver face height. Based on the model,
you might be required to increase it. We do not recommend using
a value greater than one-half of the Curvature Min Size.

Defeature Size

Understanding the approach that the layered tetrahedrons mesher uses may be useful if
you are not satisfied with the meshes being generated. After experimenting with the
mesh settings described here, if you are still not happy with the tetrahedrons mesh, con-
sider adjusting Relative Tolerance, Inflate Relative Tolerance, and Sliver Triangle Height.
Care must be taken to ensure that the layer slices cut the geometry in such a way as to
avoid thin slices. Thin slices may cause the mesher to struggle or result in poorly shaped
elements. Usually adjusting the mesh Layer Height or increasing Relative Tolerance will
lead to a higher quality mesh. Refer to the Layered Tetrahedrons Method Control in the
Meshing User's Guide for further information.

4. Next, set mesh controls for the base plate that will produce a much coarser mesh. Highlight
the Mesh object and right-click Insert > Sizing. A Sizing object is created under the Mesh
object and becomes active.

a. Select the base plate body and hit Apply in the Details view.

b. Under Definition, change the Element Size to the desired value, something that
will result in a fairly coarse mesh.

5. Finally, highlight the Mesh object and right-click Generate Mesh. If you don't like the
generated mesh you can easily go back and change element sizes and settings, then right-
click Mesh and select Update.
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5.7. Identify and/or Generate Supports

Go directly to procedural steps. (p. 88)

Supports may be imported with your geometry, you may import them as a separate .stl file, or you
may generate them directly as elements in Mechanical, or some combination of the three.

• Predefined Supports are support bodies that are imported with your part geometry and you
will need to identify them as such.

• STL Supports are supports imported as .stl files or transferred in automatically from Additive
Prep using the transfer to Workbench feature. STL Supports are generally volumeless (that is,
not watertight), thin-walled structures created with Additive Prep or other support-creation tools.
The thin, intricate support walls that may include perforations are made of many small facets.
We use a voxelizing technique, similar to that used in Additive Print, to account for this. The
mesh is generated with cubic elements that are internally divided into subdivisions for sampling
the presence of material to determine the overall densities of the elements. These, in turn, are
used for the material knockdown factors.

STL Support files must be in millimeters. Furthermore, with STL Supports, element size is set by
the mesh criteria used for the part. It is for this reason that you must mesh the part before, or
at the same time as, meshing the STL Support. If you used a Cartesian mesh, the element size
uses the value you specified for Build Element Size. (Element size may be slightly smaller than
the Build Element Size in certain cases.) If you used a layered tetrahedrons mesh for the part,
the element size will be the value you specified for Layer Height.
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• Generated Supports are available only for parts meshed with Cartesian mesh (with voxelization
option equal to yes or no). These supports generated by the Mechanical application are either
automatically detected or user-defined. For automatic detection you specify an overhang angle
(the default value is 45° to the horizontal X-Y plane) under which supports will be created. For
user-defined supports you select individual element faces under which supports will be created.
Supports are generated as elements vertically straight down from the overhanging portion of
the build to the base, or to a lower portion of the model if it is in the way.

We Treat Supports as Homogenized Solids

In additive machines, supports are printed with the same material as the part but as thin walled structures
with less mass than the part. In the simulation we model the supports as an equivalent "homogenized"
solid rather than as thin-walled structures. Regardless of whether the supports are predefined bodies,
automatically generated, or imported as .stl files, their properties will be scaled down to account for
this homogenization technique. Affected properties are elastic modulus, shear modulus, yield strength,
density, and thermal conductivity.

Scaling down properties is done automatically for STL Supports. For Predefined Supports and Generated
Supports, you will do this in one of three ways:

• Specifying an overall multiplication factor. This factor is the ratio of the actual support area to
the area of the solid area. For example an overall multiplier of 0.33 will adjust the properties of
the supports to be a third of that of the part material.

• Specifying individual multiplication factors for each orthotropic direction of each material property.

• Specifying wall thickness (T) and spacing (L) for block-type supports, commonly output from
support generation tools. In this method, we calculate the equivalent homogenization factor for
you.
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Procedural Steps

Supports are identified and/or added using the Support Group in the AM Process context menu. As
you add supports, objects are added to the project tree under AM Process. You may want to rename
these objects to meaningful names if you have many support groups. If things get confusing as you
add supports, useful tools are the Hide Support and Hide All Other Bodies options, accessible by right-
clicking on any support object.
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Predefined Supports

If support bodies were included in the CAD geometry, you need to identify them as supports so
that the Mechanical application is aware of which bodies to adjust properties for, or to remove if
support removal steps are specified. To identify these predefined supports:

1. Highlight the AM Process object, and then select the Predefined Support option on the AM
Process context toolbar. Or right-click in the Geometry window and select Insert > Predefined
Support.

2. Select the support bodies (geometry selection) with the mouse, holding the Ctrl key down to
select multiple bodies (or click, hold, and drag). Click Apply. Or, choose Named Selections.

3. To scale down material properties, in Details under Support Material Settings, choose Block
or User Defined for Support Type. If choosing Block supports, specify Wall Thickness (T) and
Wall Spacing (L). If you choose User-Defined for Support Type, you may adjust the material
properties by specifying either one overall multiplier or property-by-property multipliers. These
multipliers are the ratio of geometric areas of the supports to the areas of the solid geometry,
where the areas are the projected areas in the X, Y, and Z directions.
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Generated Supports

The Mechanical application's ability to automatically generate supports is available only if the part
is meshed with a Cartesian mesh (with voxelization option equal to yes or no). When generating
supports, the application can automatically determine their locations or you can specify the support
locations.

For automatic detection of generated supports:

1. Highlight the AM Process object, and then select the Generated Support option on the
context toolbar. Or right-click in the Geometry window and select Insert > Generated Support.

2. Click the Support Group object above Generated Support and change the overhang angle,
Hang Angle, to an angle between 0 and 90°, or leave it at the default of 45°.

3. Right-click Support Group and select Detect and Generate Supports. Supports are generated
for all bodies that are part of the build. Note that an option exists to Detect Supports only
(that is, not generate supports). This is quite useful if you want to see the effect of changing
Overhang Angle. If you are satisfied with the location of supports, then select Generate Support
Bodies. Another option allows you to detect and generate supports above a particular Z location
(Detect above Z location, in Details of Support Group), allowing further control of where sup-
ports are generated.

For user-defined generated supports, you restrict the regions under which supports will be generated
by selecting specific element faces in Scoping Method:

1. Highlight the AM Process object, and then select the Generated Support option on the
context toolbar. Or right-click in the Geometry window and select Insert > Generated Support.

2. Switch to element face mode of selection , and use Ctrl-left-
click to select multiple element faces, or double-click-left to select all the elements on a surface.
Click Apply in the Details panel.

3. Right-click Generated Support and click Generate Support Bodies.

Important:

Supports are generated as elements only (that is, there are no corresponding geometric
bodies created for the new supports). When viewing geometry in the Geometry window
you won’t see the supports. You will see the support elements when you select the
AM Process object (or one of its children), or the Mesh object. Or you can use the Show

Mesh toggle button  to reveal the mesh even when the Model object is
active.

More importantly, if you would like to use the supports generated in Mechanical in
your final print strategy, you will need to convert the elements to geometric bodies
for the .stl file required by the printer.
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STL Supports

The workflow is slightly different depending on how you add STL Supports. They can be transferred
in automatically from Additive Prep or imported from an .stl file. Both methods are described
in step 1 below.

1. To mesh STL Supports transferred in automatically from Additive Prep:

a. When supports are transferred automatically from Additive Prep, they are not scoped to
any particular body. That is, they are not associated to the part body. In the project tree,
click to expand the Imported Supports object and then click the STL Support object. In
the Geometry window, select the body representing the part and click Apply for the Geo-
metry in the Details view of STL Support.

To import and mesh STL Supports from a file:

a. Before inserting the STL Support, be sure the part is meshed and the build geometry
is identified in the AM Process object. Highlight the AM Process object, and then select
the STL Support option on the context toolbar. Or right-click in the Geometry window
and select Insert > STL Support.

b. In the Details view of STL Support, identify the source of the .stl file, either a file
(default) or a previously imported STL Construction Object. Click File Name to navigate
to the appropriate folder and select your .stl support file.

2. In the Details view of STL Support, change the Length Units, as needed. The default is milli-
meters. Most often, this is what you want.

3. Identify the STL Support Type by selecting Volumeless or Solid from the drop-down.
Volumeless (default) is for non-watertight supports such as block, heartcell, rod, or line supports
created by Additive Prep. Most often, this is what you want. Choose Solid for solid bodies that
are watertight, such as custom supports created in Additive Prep.

4. For Volumeless support type, adjust the Wall Thickness, as needed, according to the single-
bead thickness set by your machine.

5. Adjust the Subsample Rate, as needed. For most cases, we recommend using the default
value of 5.

The following figure shows a curved bar model with tree supports generated in Additive Prep
imported as an STL Support file.
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The support structure will be meshed with cubic elements. Each cubic element is divided into
sampling regions to determine density of support material within that element. These are used
as material property knockdown factors. A Subsample Rate of 5 (default) = 5 x 5 x 5 = 125
subdivisions. Subsample Rate affects the accuracy of element density.

6. Right-click the STL Support object and select Generate Mesh to mesh the support.
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7. Use the Support View (under Display) to switch back and forth among the view options of
STL View, Mesh View, or Knockdown Factors. (Or, the knockdown factors may be turned on
using Display Style in the Mesh object Details view.)

Hint: Look for the tiny icon to the left of an object in the project tree for a clue about its status.
For example, if you see a question mark next to an STL Support object, it means you have not
scoped it to a part yet (if supports were transferred from Additive Prep) or identified a file name
yet (if supports were inserted via an .stl file). If you see a yellow lightening bolt, it means you
have not generated the mesh for it yet. You will see a green check-mark once you have performed
all relevant tasks.

5.8. Define Connections

Go directly to procedural steps. (p. 95)

Connections are the mechanism to ensure that the part, support, and base plate bodies in the simulation
are aware of each other and are able to share data (temperatures and displacements) across boundaries.
Two connection types that are typically used in AM simulations are Build-to-Base contact connection
and AM Bond connection.

• A Build-to-Base connection is a special case of bonded contact between the element faces on
the bottom of the build and the element faces on the top of the base.

• An AM Bond connection is used to connect a meshed part to a meshed support when the mesh
is non-conformal between them. The internal means of connection is through constraint equations
that connect the support nodes to the part elements.
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Certain mesh and support combinations in Mechanical result in conformal mesh between the part and
the supports, in which connections are automatic by definition of a conformal mesh, while other com-
binations result in non-conformal mesh. In these scenarios you will need to create a contact connection
between them with an AM Bond.

As depicted in the following table, the part mesh/support combinations that are automatic because of
the conformal mesh are scenarios C, E, F, J, and K.

The part mesh/support scenarios that require an AM Bond connection are:

• When the part and/or the Predefined Support is meshed with layered tetrahedrons (scenarios
A, D, G, and H)

• When the part is meshed with Cartesian mesh (voxelization option = No) and STL Supports are
used (scenario B). STL Supports are automatically meshed with a voxel mesh. In this scenario,
we recommend you use the voxelization option to mesh the part instead.
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Symbols used in the Mesh and Support Options table are shown here.

This mesh/support combination is available

This mesh/support combination is not available

Connection between part and support is automatic because of a
conformal mesh

Contact connection between part and support is required

Procedural Steps

Defining connections between entities should be performed after they are meshed. For all scenarios,
you must define a connection between the build and the base plate so we will start there.
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Connection between the build and the base plate — Build-to-Base:

Highlight the AM Process object and then select the Create Build to Base Contact option on the
context toolbar.

Several things happen. You will see the contact body (red) and target body (blue) views shown in side
windows of the Geometry window. The Contact Side is defined as the element faces of the bottom of
the build (part and supports). The Target Side is defined as the element faces of the top of the base
plate. In the project tree, a Contacts object is added under Connections with a Build to Base object
underneath it. Also, named selections have been created that select the element faces at the build-base
interface (Build Contact Element Faces and Base Contact Element Faces).

Connections between part and supports — AM Bond:

If you have no supports, or connections are automatic because of a conformal mesh (scenarios C, E, J,
and K), skip ahead to the Establish Thermal Analysis Settings (Thermal-Structural System) (p. 113) step.

To create AM Bond connections automatically that will connect all appropriate part and support
boundaries, highlight the AM Process object and then select the Create AM Bond Connections option
on the context toolbar.

Several things happen. Named selections have been created for the part and support (such as Build
Part and STL Support). You will see the contact body (red) and target body (blue) views shown in side
windows of the Geometry window. The Contact is defined as the part body. The Target is defined as
the support body. In the project tree, an AM Bond object is added to the tree and renamed to reflect
the part and support named selections.

The automatic Create AM Bond Connections option described above works to detect appropriate part
and support pairs based on proximity to one another. Be sure to review the contact pairs created by
examining the views in the Geometry window and the details of the AM Bond objects in the project
tree. If there are multiple parts and/or multiple supports closely packed together on a base plate, it is
possible the Create AM Bond Connections action results in incorrect pairings. If you suspect that
happened, delete the connections and named selections and create AM Bond contact connections
manually, as follows.

To manually create an AM Bond connection that will connect a part to a support:

1. Create a named selection for the part: Right-click the part geometry and choose Create Named
Selection. Enter a name for the part geometry and click OK.

2. Create a named selection for the support:
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For an STL support, right-click the STL Support object and choose Create Named Se-
lection of Generated Elements.

a.

b. For a predefined support, right-click the support geometry and choose Create Named
Selection. Enter a name for the part geometry and click OK.

3. Right-click Connections and choose Insert > AM Bond. Using named selection as the scoping
method, choose the part named selection as the Contact, and choose the support named selec-
tion as the Target.

Consider the following guidelines for AM Bond connections:

• Do not use an AM Bond connection to connect a part or support to the base plate. Use the Build-to-
Base connection for that.

• One AM Bond connection is required for each part/support combination.

• Only one body should be selected when creating the named selection for the part.

• The identification of contact and target entities as indicated in step 3 above is appropriate for most
cases. Reversing the entities identified as contact and target will not only produce a warning message,
but will typically produce unexpected and unrealistic deformation. However, if the support mesh is
much coarser than the part mesh, say greater than 2:1 proportions, reverse the scoping selection and
make the support the contact and the part the target. This is easily done by right-clicking AM Bond
and choosing Flip Contact/Target.

• The internal constraint equations used to implement AM Bond connections are applied to the nodes
of only the top and bottom of the supports. This means the connections will be in the Z-direction but
not the side-to-side directions.

• The constraint equations will couple the voxel supports to the meshed body even if there is penetration
of the support into the part, such as when positive intrusion values are used when generating
volumeless supports. You may, though, see anomalies at some of these interfaces, such as temperature
higher than melt or lower than ambient, or very localized large displacements at a support-part inter-
face. The overall solution (temperatures, displacements, and stresses) over the build is good and these
local anomalies may be ignored.

• You can check the number of constraint equations that are created for each AM Bond connection by
viewing the solver output. Under the Transient Thermal system, Solution object, click Solution In-
formation. In Details view, Solution Information, choose Solver Output. In the worksheet window
shown, search on "CE connections."

5.9. Define AM Process Steps

Go directly to procedural steps. (p. 100)

The AM process is accomplished through sequential steps that dictate how consecutive solutions are
performed in the overall simulation. Minimally, there will always be a build step and usually there is a
cooldown step for Thermal-Structural systems. Conceptually, this can be visualized as follows:
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Additional steps may be added to the simulation to account for other phenomena in the AM process,
such as the removal of the base plate and/or supports, as shown here for a Thermal-Structural system:

In most cases, base removal is done before support removal. It is important to understand that residual
stress and distortion results may be affected by the order in which you remove supports. The Mechan-
ical application can simulate any scenario of support removal.

Other solution steps, such as base unbolting and heat treatment steps and user-defined user steps, may
be added before or after removal steps, as shown here:
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When an additive print is finished, usually the first step is to unbolt the base plate from the machine
and transport it for heat treatment or support removal postprocessing. Including this step in the simu-
lation allows more accurate modeling of the deformations in subsequent postprocessing steps. In this
step, the constraints for UX, UY, and UZ are removed from the base plate nodes and weak springs are
turned on in Analysis Settings. For additional details, see the AMSTEP command. Note that unbolting
the base prior to heat treatment can be especially important and is recommended to prevent any arti-
ficial stress in the base due to fixed boundary conditions and thermal expansion during heating.

A user step includes a solve execution and may be added at various points in the overall sequence. In
the application, a user step effectively leaves the AM simulation environment and enters the usual
nonlinear "load step" environment. Any valid loading and load step options may be used. One example
of a user step is a bolt pretension step before the build.
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Procedural Steps

For AM Process Simulations, the Mechanical application provides an alternative to the ordinary step-
manipulation in analysis settings by using a custom worksheet called the AM Process Sequence worksheet,
or the sequencer, as we like to call it. Overall viewing and control of the steps in your simulation is done
through the sequencer, shown below. You can access the Sequence button only when the AM Process
object is selected in the project tree. You can toggle the display on and off using the button any time
the AM Process object is selected.

The sequencer enables you to view and change the steps in the simulation. In the screen image below
from an LPBF Thermal-Structural system, the steps in the transient thermal analysis and the downstream
static structural analysis are conveniently shown side-by-side. Note that unless you use the LPBF Setup
Wizard or a Commands object, using the sequencer is the only way to manipulate steps in an AM Process
Simulation.

1. Select the AM Process object and then select the AM Process Sequence option on the context
toolbar (or click on Worksheet in the main menu bar).

2. To add a base unbolting step, click Add Step on the Static Structural side of the worksheet and
select Base Unbolt.
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3. To add a heat treatment step, click Add Step on the Static Structural side of the worksheet and select
Heat Treatment Step. Additional steps are required to complete the heat treatment step as described
in the advanced topic Simulating Heat Treatment after the Build (p. 176).

4. To simulate the removal of the base or supports after cooldown or after heat treatment,

a. Click Add Step at the bottom of the Static Structural side of the worksheet. The dropdown
will show the options available for removal, depending on your set-up (Base, Predefined
Support, Generated Support, and/or STL Support). You may reorder the steps in the sequence
using drag and drop of one step on top of another.

b. Additional options are available if you choose the base removal step. Under Static Structural,
click Analysis Settings in the project tree and select the Removal Step: Base option from
the Step drop-down. Choose a Base Removal Type, either Instantaneous or Directional.

• Instantaneous: Simulates instantaneous cutoff of all material at the base (bottom
layer of elements only).

• Directional: Simulates a progressive cutoff of all material at the base (bottom layer
of elements only), in which you specify the cut increment and the angular direction
for removal from the base.

Removal Step Size: Distance removed in every cut step. Cannot be 0 or a negative
number.

Removal Direction: Directional cutoff angle on the X-Y plane as measured from the
+X axis. For example, a value of 90 results in a cutoff direction in the +Y direction.

5. To add a user step to either analysis, click Add Step on the desired side of the worksheet and select
User Step. You will then need to specify your step conditions, such as an extra boundary condition,
etc. If you want to insert a user step, such as for bolt pretensioning, as the first step in the sequence
before the thermal build step, click Add Step and choose User Step Prior to Build.

Note:

Advanced Ansys users frequently combine Mechanical APDL commands with the auto-
matic execution of models set up in Mechanical for more precise and custom control
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over a solution. For example, you may insert a Commands object under the Static Struc-
tural or Transient Thermal environment objects in the project tree. In the Commands
object Details view, there is a useful option to Issue Solve Command (either Yes (default)
or No). It enables users to better control how the commands in the Commands object
are processed relative to the step execution in the sequencer.

Nonlinear Stabilization

The post processing steps of base unbolting and base/support removal are highly nonlinear phenomena.
As such, nonlinear stabilization is on by default for these steps to improve convergence. In most cases,
stabilization is enough to sufficiently hold the part in place to prevent rigid body motion.

Note the following about stabilization:

• Stabilization is turned on by default only if all AM process steps are set to Program Controlled
for Stabilization in Analysis Settings.
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• The default behavior is that stabilization is turned on immediately before relevant AMSTEP
commands and turned off immediately after each relevant AMSTEP command so that stabilization
is only on for the removal or unbolting step and does not affect heat treatment or user steps.

• Stabilization default values are set as follows (shown with Mechanical APDL commands):

– For base unbolting: STABILIZE,CONSTANT,ENERGY,1.e-004,ANYTIME,0.2

– For base and support removal: STABILIZE,CONSTANT,ENERGY,1.e-004,NO,0.2

See Stabilization in the Mechanical User's Guide, and Using Nonlinear Stabilization and STABILIZE in the
Mechanical APDL documentation for more information.
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5.10. Define Build Settings

Go directly to procedural steps. (p. 109)

In this step, specify the simulation and strain assumptions, process parameters, and conditions related
to the machine and the process.

Simulation Settings

Simulation settings include assumptions about the type of simulation and the strain definition.

• Additive Process: Laser Powder Bed Fusion. The Laser Powder Bed Fusion (LPBF) process uses thermal
energy from a laser or electron beam to selectively fuse powder in a powder bed.

• Inherent Strain (Yes or No): An option to use the Inherent Strain method (p. 138). (If you used one
of the AM custom systems (p. 67) in Workbench to set up your analysis system, this option is set
automatically for you.) If No, the AM simulation uses a linked thermal-structural system in which
strains are calculated from material properties and thermal loads. If Yes, an alternative method is
used in which strains are based on an experimentally calibrated Strain Scaling Factor. Options under
Machine Settings, Calibration Settings, Build Conditions, and Cooldown Conditions differ depending
on whether Inherent Strain = Yes or No.

If Inherent Strain = Yes (default if AM LPBF Inherent Strain custom system is used):

– Inherent Strain Definition: Assumption about strain behavior reflecting the different ways
inherent strain is calculated as an input to the structural solver.

→ Isotropic: Simplifying assumption that a constant, isotropic strain occurs at every location
within a part as it is being built. A constant Strain Scaling Factor may be used to scale
strain everywhere uniformly to account for calibration of the Mechanical application
to a particular machine/material combination.

→ Anisotropic: Uses the same average strain magnitude as isotropic strain, but it subdivides
that strain into anisotropic components in the X, Y, and Z directions based on the
Global coordinate system.

→ Scan Pattern: Uses the same average strain magnitude as isotropic strain, but it sub-
divides that strain into anisotropic components based on the local orientation of scan
vectors within the part. Scan vectors may be generated internally via a slicing function
assuming a rotating stripe scan pattern or input via a build file.

→ Thermal Strain: A method that provides the highest level of fidelity and takes thermal
cycling into account at each location within the part.

• Thermal Strain Method: Machine Learning Prediction (only method available
at this release)

Uses a machine learning model prediction of the anisotropic Thermal Strain
simulation result from the Ansys Additive application.—Thermal Strain simulations
provide the highest level of fidelity by predicting how thermal cycling affects
strain accumulation at each location within a part. The simulation follows the
full laser path on every layer, and is based on the machine process parameters
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(power, scan speed, beam diameter, etc.).—The machine learning model has
been trained to predict the Thermal Strain result much faster than simulation.
It can be one to three orders of magnitude faster than Thermal Strain simulation
in Additive Print in calculating the strain that is passed to the structural solver.
Speedup increases with part size, scan area, and melt pool size. See Thermal
Strain - Anisotropic in the Additive Print and Science User's Guide.

Important:

The Machine Learning Prediction feature requires a Structures AI+ li-
cense.

• Machine Learning Model: A list of materials that were used to train the ML
prediction, in particular, the materials validated for the Additive application.
Choose the material that most closely matches your material assignment in En-
gineering Data. ML models may be based on different material properties than
those in Engineering Data. The ML models are used to generate loading strains.
Materials in Engineering Data are used for the structural analysis.

• Layer Height: By default, the program uses the Layer Height specified when meshing as the super
layer height. Occasionally you may want to increase the size of the super layer to something coarser
than what was used when you created the mesh. Use the Layer Height option here to do that. Spe-
cifying a new Layer Height does not affect the existing mesh.

Calibration Settings

Strain Scaling Factors are optional inputs that scale the inherent strains in an inherent strain simulation,
or the thermal strains in a thermal-structural simulation, by a given value. They are usually determined
from calibration experiments. Defaults are shown below for the various strain definitions:

Default
Value

Strain Scaling Factor(s)Strain Definition

1Thermal Strain Scaling
Factor

Thermal-Structural simulation

1Strain Scaling FactorIsotropic - Uniform strain in all directions

1

1

Strain Scaling Factor X

Strain Scaling Factor
Y

Anisotropic - Strain can be scaled based on the Global coordinate
system

1
Strain Scaling Factor
Z

1.5

0.5

Parallel ASC[a]

Perpendicular ASC

Scan Pattern and Thermal Strain - Strain can be scaled based
on the local orientation of scan vectors (parallel and perpendicular
to scanning direction and in the build direction)

1Vertical ASC

ASC = Anisotropic Strain Coefficient[a]
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Machine Settings

Machine settings refer to process parameters for your AM machine setup. Inputs for machine settings
are used to calculate the real, physical time duration of the build process so that the cooldown time
can be determined. Every simulation except a simple isotropic Inherent Strain simulation uses some, or
all, of the parameters shown in blue in the following figure and defined below.

DefinitionInput Parameter

A simulation assumption related to how the material is heated for each
new element layer as it is added (made alive). Choose either Melting

Heating Method

Temperature (default) or Power. Visible for simulations with thermal solves
only (i.e., not Inherent Strain). See Build Settings for details.

The orientation of fill rasters on the first layer of the build. It is measured
from the X axis, such that 0 degrees results in scan lines parallel to the X

Start Layer Angle

axis. The starting layer angle is commonly set to 57 degrees. Must be
between 0 and 180°.

The angle at which the major scan vector orientation changes from layer
to layer. It is commonly 67 degrees. Must be between 0 and 180°.

Layer Rotation Angle

Width of the sections, called stripes, into which the geometry is sliced. The
stripes are scanned sequentially to break up what would otherwise be very

Scan Stripe Width

long continuous scan vectors. Scan Stripe Width is commonly set to 10
mm wide. Must be between 1 and 100 mm.

The average distance between adjacent scan vectors when rastering back
and forth with the laser. Hatch spacing should allow for a slight overlap

Hatch Spacing

of scan vector tracks such that some of the material re-melts to ensure full
coverage of solid material. For Machine Learning strain definition, must be
between 60 and 1000 microns.
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DefinitionInput Parameter

The thickness of added powder material in every pass of the recoater blade.
Specifically, use the amount the base plate drops between layers. For
Thermal Strain strain definition, must be between 10 and 100 microns.

Deposition Thickness

The average speed at which the laser spot moves across the powder bed
along a scan vector to melt material, excluding jump speeds and ramp up

Scan Speed

and down speeds. For Thermal Strain strain definition, must be between
350 and 2500 mm/sec and the recommended range is between 500 and
2500 mm/sec.

The power setting for the laser in the machine. Must be between 50 and
700 Watts. The recommended range is between 50 and 500 Watts.

Beam Power

The width of the laser on the powder or substrate surface defined using
the D4σ beam diameter definition. Usually this value is provided by the

Beam Diameter

machine manufacturer. Sometimes called laser spot diameter. Must be
between 20 and 140 µm. The recommended range is between 80 and 120
µm.

• If Inherent Strain = Yes (default if AM LPBF Inherent Strain custom system is used):

– Scan Pattern Definition (visible if Inherent Strain Definition = Scan Pattern or Thermal Strain):
How the scan pattern is defined, either generated using a rotating stripe pattern (default) or
input via a build file.

→ Generated: Start Layer Angle and Layer Rotation Angle as defined above. Scan Stripe
Width is also visible if Inherent Strain Definition = Thermal Strain. These inputs define
an internally generated scan pattern.

→ Build File: Machine Type and Build File Path inputs become available with this option.
These inputs specify an external build file to be used.

• Machine Type: Specifies the machine or OEM associated with the build file spe-
cified. Options are Additive Industries, EOS, HB3D, Renishaw, Sisma, SLM, and
Trumpf.

• Build File Path: Location of a .zip file containing the scan pattern file(s), and an
stl of the part geometry. See Build File Requirements (p. 109).

– Beam Diameter, Beam Power, Deposition Thickness, Hatch Spacing, and Scan Speed as defined
above. If a build file is specified for Scan Pattern Definition, deposition thickness is determined
from the file.

• If Inherent Strain = No (default unless AM LPBF Inherent Strain custom system is used):

– Hatch Spacing, Deposition Thickness, and Scan Speed as defined above.

– Dwell Time: The span of time from the end of the laser scan of one layer to the start of the
laser scan of the next layer. It includes the time required for recoater-blade repositioning and
powder-layer spreading.
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– Dwell Time Multiplier: The dwell-time multiplier accounts for more than one part in the build.
If they are the same part arranged in the same orientation on the build plate, the multiplier
is the number of parts.

– Number of Heat Sources: For multiple-beam printers, specifies the number of lasers. This divides
the amount of time it takes to scan a layer by the number of heat sources specified.

Build Conditions

Build conditions are the settings pertaining to the environment in the build chamber around the build
as it is being printed, including the preheat temperature. For Inherent Strain = Yes, only preheat
temperature is required and only with Inherent Strain Definition = Thermal Strain. For Inherent Strain
= No, additional inputs are required to account for convection.

During a laser powder bed fusion (LPBF) print process, almost all the heat dissipation is conducted
through the part back to the build plate rather than out through the unmelted powder surrounding
the part. Many users ignore the small effect of heat loss through powder but you may choose to model
it as equivalent heat convection.

The Gas/Powder Temperature option allows the use of Preheat Temperature for Gas Temperature and
Powder Temperature.

DefinitionInput Parameter

The starting temperature of the build plate. Used when Inherent Strain =
Yes and Inherent Strain Definition = Thermal Strain, and when Inherent

Preheat Temperature

Strain = No. For Thermal Strain strain definition, must be between 20 and
500 °C and the recommended range is between 20 and 200 °C.

Temperature of the gas in the build enclosure.Gas Temperature

Convection coefficient from the build to the enclosure gas. The convection
is applied only to the top of a newly laid layer.

Gas Convection Coefficient

Temperature of the newly added powder.Powder Temperature

Effective convection coefficient from the sides of the build to the powder
bed. To estimate, divide the conduction property of the powder by a

Powder Convection Coeffi-
cient

characteristic conduction length into the powder (for example, a quarter
of the distance from the build boundary to the build-chamber wall).

A knockdown factor used to estimate the powder properties. The
Mechanical application applies the factor to the solid material properties

Powder Property Factor

to estimate the properties of the material in its powder state. The
powder-state properties are used in the newly added layer during the
heating of the new layer (before its subsequent solidification and cooldown)
prior to the next layer being applied. The default value is 0.01.

This powder knockdown factor is also used if powder is explicitly
modeled (p. 194) in the build.

Cooldown Conditions

Cooldown conditions are the settings pertaining to the environment in the build chamber around the
build in the cooldown step after the last layer is printed. Available only if Inherent Strain = No.
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• Room Temperature

• Gas Temperature, Gas Convection Coefficient, Powder Temperature, and Powder Convection
Coefficient as defined above, with an option to use Room Temperature for Gas Temperature and
Powder Temperature.

Procedural Steps

You can go back to Workbench and select the Engineering Data tab at any time to see properties for
your chosen material.

1. Select the Build Settings object (under AM Process object).

2. In Details, enter values for all the items under Simulation Settings, Calibration Settings, Machine
Settings, Build Conditions, and Cooldown Conditions. You can load a pre-saved file of build settings
if you have one – right-click Build Settings and select Load Build Settings. (We provide generic
sample files for our AM materials in the ANSYS Inc directory, for example: C:\Program Files\ANSYS
Inc\v231\aisol\DesignSpace\DSPages\SampleData\AdditiveManufacturing. In this example, v231 in-
dicates Release 2023 R1. Note that the ANSYS Inc directory on your machine may not be on the C
drive.)

3. Right-click the Build Settings object and select Save Build Settings to save your inputs to an .xml
file that can be reused.

Build File Requirements

Listed here are the general requirements for build files, which are the same as those required for Additive
Print. Additional machine-specific requirements are provided in the expandable topics below the gen-
eral requirements.

• We define a build file as a .zip file containing, at a minimum: one .stl file for the part geometry
and one machine-specific print file defining the scan vectors. Supported machine manufacturers
include Additive Industries, EOS, HB3D, Renishaw, Sisma, SLM, and Trumpf. Ansys may add addi-
tional options as we continue to work with more machine partners.

• Build files from Additive Prep are automatically created with a file name of "ansys_addit-
ive_print.zip.

• The build file is a .zip file. Do not nest the files to be zipped within a folder, as a folder structure
is not readable. Rather, zip the individual files together as shown in the following figure.
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General requirements for the part geometry .stl file

• .stl files within the .zip file must have units of mm and be positioned in the same location as
the part in the Mechanical application.

• Multiple parts can be used, but they must all be within one .stl file.

• The baseplate should not be included in the part geometry .stl file.

• Supports should not be included in the part geometry .stl file nor as a separate .stl file.

General requirements for the machine file

• One laser head is assumed for the simulation. Build files with multiple lasers are not supported. When
you import a build file with multiple lasers, the application handles it differently depending on the
machine. In most cases, the application either generates an error or ignores the extra lasers upon
import.
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• One set of process parameters is used in the simulation. If the build file contains multiple parameter
sets, such as different scan speeds and laser powers for the part hatches versus the support hatches,
the part hatch parameters will take precedence.

• Only one part layer thickness (Deposition Thickness) is allowed.

• Only one support layer thickness is allowed, and it must be equal to, or a multiple of, the part layer
thickness.

• Regardless of how they are defined in the build file, the scan sequence is always simulated from the
inside out, that is, from hatch to contour scans. However, the appropriate order is maintained within
the hatch area and within a contour. For example, if the build file order is: contour line 1 → contour
line 2 → hatch line 1 → hatch line 2, it will be changed to be hatch line 1 → hatch line 2 → contour
line 1 → contour line 2.

• Scan vectors marked as contour will not be simulated. The definition of contour/hatch is established
by the software that creates the build file. If contour-like scan vectors are marked as hatch they will
be simulated and results may not be as expected.

• Build files for simulations that use the Machine Learning Prediction strain definition only support
stripe scan patterns.

Additive Industries Build Files

A build file for an Additive Industries machine should be a zip file containing:

• Part = *.stl file

• Two machine files are required, one *.daij file and one *.bin file.

Notes:

• Support scan vectors will be ignored and will not be simulated. An Additive Industries build file
with supports has not been tested.

• Only a stripe scan pattern has been tested.
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EOS Build Files

A build file for an EOS machine should be a zip file containing:

• Part = *.stl file

• Machine = *.openjz file. Mechanical uses version 2.8 of the EOS API.

Notes:

• You must have an EOSPRINT 2 license, in the form of a dongle or from a license server, from EOS in
order to import an EOS build file.. If you are using a dongle, do not unplug it until the after strains
have been generated.

• EOS M100, M290 and M400 single-laser machines are supported.

Known Issues and Limitations

• When preparing the .openjz file in EOSPRINT, start height and end height (<height> element)
should not be zero since it is never the position of any layer. The build file may fail to generate
strains in Mechanical.

• When attempting to import an older EOS build file, the application may reject it since version
2.8 of the EOS API is stricter in regards to the OpenJob format. If this happens, you may see an
error.

HB3D Build Files

A build file for an HB3D machine should be a zip file containing:

• Part = *.stl file

• Machine = *.h3d file. Mechanical uses version 1.0 of the *.h3d file specification.

Notes:

• An HB3D build file ignores the last layer when the distance from its Z coordinate to the Z max
is less than one layer thickness.

Renishaw Build Files

A build file for a Renishaw machine should be a zip file containing:

• Part = *.stl file

• Machine = *.mtt file. Mechanical uses version 1.06 of the *.mtt file specification.
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Sisma Build Files

A build file for a Sisma machine should be a zip file containing:

• Part = *.stl file

• Machine = *.wza file. Mechanical uses version 3.0.9 of the *.wza file specification.

SLM Build Files

A build file for an SLM Solutions machine should be a zip file containing:

• Part = *.stl file

• Machine = *.slm file. Mechanical uses version 1.10 of the *.slm file specification.

Trumpf Build Files

A build file for an Trumpf machine should be a zip file containing:

• Part = *.stl file

• Machine = *.wza file. Mechanical uses version 3.0.9 of the *.wza file specification.

5.11. Establish Thermal Analysis Settings (Thermal-Structural System)

Go directly to procedural steps. (p. 114)

This step requires you to think about your simulation's end goals. What do you want to investigate?
And specifically, what data do you want to see from the transient thermal portion of an LPBF Thermal-
Structural simulation? Thermal analysis settings enable the customization of various options during the
transient thermal solution, including identifying which items to solve for.

The transient thermal analysis will determine the temperature history during the build process. These
temperatures will then be used in a static structural analysis to determine the build distortions and
stresses. The Mechanical application will automatically determine all the steps and times needed for
time integration in the simulation.

Options to consider include:

• Hotspot (p. 114) – A significant cause of issues in additive manufacturing can be attributed to
overheating during the build. This typically occurs when there are changes in cross sectional
area and there is not enough material to pull heat away from a certain region. Overheating can
lead to poorly shaped melt pools, affecting the part's material characteristics and porosity. You
can check for the overheating issue with simulation by checking the temperature that each layer
cools down to before a new layer is added. Add an LPBF Hotspot result item to your project so
that the appropriate data is written out during solution. The LPBF Hotspot result tool configures
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the Export Layer End Temperature option so that the temperature of a layer just before a new
layer is applied is written out to a file.

• Layers to Build (p. 114) – An option is available to limit the number of layers to build in the
simulation, that is, to simulate only a partial build process. This may be useful if you want to
examine results in the lower portion of the build if you suspect there will be cracks or blade in-
terference there.

• Other Output Controls (p. 114) – For an AM Process Simulation, your results file will grow in size
very quickly, so we recommend you keep the default output control settings that will suppress
calculation of thermal flux, nodal forces, Euler angles, volume and energy, and other miscellaneous
items. Nodal temperatures are stored at all time points by default but you can change that option
so that temperatures are stored at the last heating and cooling steps only, or every N number
of finite element layers.

Procedural Steps

Usually it is appropriate to leave most analysis settings set to "program-controlled." These settings are
determined when you insert the AM Process object into the project tree. There are a couple of settings
to note related to an AM Process Simulation, as described below.

1. To solve for hotspots, use the LPBF Hotspot tool in the LPBF Process Add-on.

Load the LPBF Process Add-on (p. 8) if you have not already done so. From the LPBF Process tab,
click the LPBF Hotspot button. A new result object, called AM Hotspot, is added in the project tree
under Solution in the Transient Thermal environment. (Alternatively, you can right-click Solution
and select Insert > AM Hotspot.)

The LPBF Hotspot result tool automatically sets the Export Layer End Temperature option to Yes in
the Analysis Settings object under Output Controls. It will write out to a file the temperature of a
layer just before a new layer is applied. Node numbers and x, y, z locations are also written. The
output is not written to the results file but rather to a tab-delimited file called AMResults.txt.

2. If you want to limit the number of layers to build in the simulation, select the Analysis Settings
object under the Transient Thermal object and in Details, Additive Manufacturing Controls, change
the Layers to Build to your desired value. Your results file will show results from the beginning
layer only through the specified layer. (Hint: If you change the value of Layers to Build and you want
to set it back to All, enter 0.) Pay attention to the active step as indicated at the top of the Details
panel under Step Controls. The number of Layers to Build in the Cooldown Step will always equal
the number of Layers to Build in the Build Step.

3. In Details of Analysis Settings, review the Output Controls and adjust them according to your
needs.

• To change the option of when to store element results for the Build Step, select Store Results
At and choose All Time Points, Last Heating and Cooling Steps, or Every N Layers. (Layers
refers to finite element layers, not powder deposition layers.)
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5.12. Apply Thermal Boundary Conditions (Thermal-Structural System)

In the Build Settings step of our workflow, we have already accounted for convection between the build
and the gas in the chamber and convection between the build and the unmelted powder around the
part—in both the Build Step and the Cooldown Step. There is one other area of heat transfer to consider
and that is associated with the base plate.

During the build process, the plate is typically heated on the bottom to maintain a constant, slightly
elevated temperature. You may insert a temperature constraint or convection surface to simulate this
during the build step. If the plate is not heated, perhaps apply a room condition convection surface,
or set the surface boundary condition to adiabatic.

After the print process is complete, the base plate heating is removed and the built part cools to room
temperature. This is simulated by a room-temperature convection surface applied to the bottom of the
base plate in the cooldown step.

The time duration of the cooldown step is estimated based on the average part temperature at the
end of the build, its volume, and material properties. Using the convection values and room temperature,
the Mechanical application solves the simple heat transfer equation to get an estimate of the cool down
time. It is only an estimate so you can extend it if required or put in a preferred time in analysis settings.
One final step is performed to force all the temperatures to room temperature for the subsequent dis-
tortion and stress calculation.

Procedural Steps

To apply a temperature to the bottom surface of the base plate for the build step:

1. Right-click the Transient Thermal object and then select Insert > Temperature.

2. Select the bottom surface of the base plate (geometry selection) and hit Apply in the Details view.

3. In Details under Definition, Temperature, enter a temperature value for Magnitude. (In our example
we use 80°.)

4. In the Tabular Data area of the interface, notice the temperature value you just entered is applied
for all sequence steps. (The first row of tabular data is considered T=0, the preheat condition.) In
the printing process, since the heat is removed after the part is printed, you'll need to remove the
temperature boundary condition for the cooldown step of the simulation. Right-click in the third
row and click Activate/Deactivate at this step! which will deactivate (remove) the elevated temper-
ature for the cooldown step.

115
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Apply Thermal Boundary Conditions (Thermal-Structural System)



To apply room-temperature convection to the bottom surface of the base plate for the cooldown step:

1. Right-click the Transient Thermal object and then select Insert > Convection.

2. Select the bottom surface of the base plate (geometry selection) and hit Apply in the Details view.

3. In Details under Definition, Film Coefficient, enter a value for the convection coefficient.

4. Under Ambient Temperature, enter a value of 22°. (This may be the default.)

5. In the Tabular Data area of the interface, select the first two rows, right-click and select Activate/De-
activate at this step! which will deactivate (remove) the convection for the build step.

It is important to use separate load objects for each change in thermal boundary conditions, as was
done in the example above where temperature and convection boundary conditions were inserted
separately. You may be tempted to combine them into one temperature object and specify 80° for the
first two rows/steps and 22° for the last row/step, but doing so is incorrect and will cause problems.

Important:

For thermal loads in AM analyses, variation in tabular values within a single load object may
cause incorrect temperature profiles during the build stage. Use a separate load object to
define each change in thermal boundary conditions.
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5.13. Solve the Transient Thermal Analysis (Thermal-Structural System)

Some users prefer to solve the thermal analysis first to observe how the simulation is progressing while
others prefer to set up everything and run both the thermal and structural analyses at once. Either way
is perfectly acceptable. To run them both at once, simply execute a solve from the static structural side
and the transient thermal analysis will be run first automatically.

Since the solution can take significant time to complete, a solution status window is provided that in-
dicates the overall progress of the solution. Other solution trackers and tools allow you to i) view the
actual output from the solver, ii) graphically monitor items such as convergence criteria, and iii) view
the temperature contour as the build progresses. You can also monitor some result items such as
temperature at a node as the solution progresses.

Procedural Steps

1. To set up a plot of overall temperature that you can update throughout the solution, under Transient
Thermal, Solution, Solution Information, select Insert > Temperature Plot Tracker.

2. To initiate the solution, under Transient Thermal, highlight the Solution object, right-click and select
Solve.

3. Use the temperature plot tracker occasionally or continuously, as follows:

• Whenever you want to see the updated temperature, right-click the Temperature plot
tracker object and select Update Result. Or,

• Right-click the Temperature plot tracker object and select Switch to Automatic Mode. This
will show a continuous, live display as the solution progresses. The plot tracker object must
be selected in order to see the live display.

5.14. Establish Structural Analysis Settings

Go directly to procedural steps. (p. 118)

In this step, think about your end goals for the simulation and what data you want to see written out
from the structural portion of the simulation. Structural analysis settings allow for the customization of
various options during the static structural solution, including identifying which items to solve for.

Options to consider include:

• Recoater Interference (p. 118) – A significant concern in additive manufacturing is whether the
build will print successfully without experiencing recoater interference (sometimes called blade
crash). This phenomenon occurs when the powder recoater blade hits into a portion of the built
part that has deformed extensively because of residual stresses. Usually the result is a stopped
process and a failed build. If checking for recoater interference is a simulation goal, add an LPBF
Recoater Interference result now to your project so that the appropriate data is written out
during solution. The LPBF Recoater Interference result tool configures the Export Recoater Inter-
ference output control option so that the Z-deformation of a layer just before applying a new
layer is written out to a file.
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• High Strain (p. 119) – When the strain in a part exceeds the elongation a material can withstand,
a failure can occur resulting in cracking throughout the part or supports. The LPBF High Strain
result tool allows you to identify regions of the part that may be prone to forming cracks during
or after the build process by highlighting critical strain values. The LPBF High Strain result tool
configures the Export High Strain output control option so that the maximum equivalent strain
experienced during the build process is written out to a file.

• Reference Temperature (p. 119) – The Reference Temperature is the temperature at which
thermal strains do not exist in a material. In the simulation of the AM process, our assumption
is that each finite element super layer is added (with the element birth/death technique) at the
melting temperature for the material and is initially strain-free. (We set Tref = Tmelt by default.)
As the build cools, thermal strains develop. The static structural analysis will use the temperature
results of the transient thermal analysis to compute the displacements, stresses, strains, and
forces due to these induced thermal strains.

• Relaxation Temperature (p. 119) – If you will be simulating a heat treatment process such as
annealing after the build, you will probably want to specify a Relaxation Temperature. Lower
than the melting temperature, the relaxation temperature is the temperature at which strains
begin to soften. (Using a creep model in Engineering Data is an alternative stress relaxation
mechanism.) Refer to the advanced topic Simulating Heat Treatment after the Build (p. 176) for
details.

• Layers to Build (p. 119) – An option is available to limit the number of layers to build in the
simulation, that is, to simulate only a partial build process. This may be useful if you want to
examine results in the lower portion of the build if you suspect there will be cracks or blade in-
terference there. The number specified here must not be more than the number of layers to
build used in the thermal analysis step if you are performing a thermal-structural simulation.

• Other Output Controls (p. 119) – Your structural results file will grow in size very quickly, so we
recommend you keep the default output control settings that will suppress calculation of contact
data, nodal forces, Euler angles, volume and energy, and other miscellaneous items. Consider
suppressing the calculation of stresses and strains if you are only interested in distortion, as
these data, in particular, will easily increase the size of the results file and it may become unman-
ageable. Additional controls allow you to specify when to store results for the build step: for all
layers, for the last heating and cooling steps, or every N layers.

Procedural Steps

As with the thermal analysis, many analysis settings in the structural analysis are program controlled.

1. To solve for recoater interference, use the LPBF Recoater Interference tool in the LPBF Process Add-
on.

Load the LPBF Process Add-on (p. 8) if you have not already done so. From the LPBF Process tab,
click the LPBF Recoater Interference button. A new result object, called LPBF Recoater Interference,
is added in the project tree under Solution in the Static Structural environment. (Alternatively, you
can right-click Solution and select Insert > LPBF Recoater Interference.)

The LPBF Recoater Interference result tool automatically sets the Export Recoater Interference option
to Yes in the Analysis Settings object under Output Controls. It will write out to a file the z-deform-
ation of a layer just before a new layer is applied. Node numbers and x, y, z locations are also written.
The output is not written to the results file but rather to a tab-delimited file called AMResults.txt.
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2. To solve for high strain areas, use the LPBF High Strain tool in the LPBF Process Add-on.

Load the LPBF Process Add-on (p. 8) if you have not already done so. From the LPBF Process tab,
click the LPBF High Strain button. A new result object, called LPBF High Strain, is added in the
project tree under Solution in the Static Structural environment. (Alternatively, you can right-click
Solution and select Insert > LPBF High Strain.)

The LPBF High Strain result tool automatically sets the Export High Strain option to Yes in the Ana-
lysis Settings object under Output Controls. It will write out to a file the maximum equivalent strain
experienced during the build process. Node numbers and x, y, z locations are also written. The
output is not written to the results file but rather to a tab-delimited file called AMHighStrain.txt.

3. Select the Analysis Settings object under the Static Structural object and in Details, note the Ad-
ditive Manufacturing Controls. The Reference Temperature is automatically set to the material's
melting temperature. (You can see this value in Engineering Data for your chosen material.)

4. If you added a Heat Treatment Step in the AM Process Sequence worksheet (p. 100), you will probably
want to specify a Relaxation Temperature. Under Additive Manufacturing Controls, change the Re-
laxation Temperature to User Specified and change the Value to the appropriate temperature.
For additional steps to complete the Heat Treatment Step, see the advanced topic Simulating Heat
Treatment after the Build (p. 176).

5. To limit the number of layers to build in the simulation, under Additive Manufacturing Controls
change the Layers to Build to your desired value. The number specified must not be more than
the number of layers to build used in the thermal analysis if you are performing a thermal-structural
simulation.

6. Review the Output Controls and suppress items not of interest.

• Turn off calculations of Stress and Strain by changing those options from Yes to No. (Hint:
Simply double-clicking in the Yes box changes it to No.)

• To change the option of when to store results, select Store Results At and choose All Layers,
Last Heating and Cooling Steps, or Every N Layers.

5.15. Apply Structural Boundary Conditions

Usually, the only boundary condition that must be applied is a fixed support boundary condition on
the build plate. This is described in step 1 in the procedural steps below.

If base unbolting and/or removal steps (p. 97) are included in your simulation, the fact that nonlinear
stabilization (p. 102) is on by default should be enough to loosely hold parts in place to prevent rigid
body motion when the base is removed. However, if you think you need additional constraints, consider
using weak springs (first choice) or directly applying fixed boundary conditions on three nodes of the
part (second choice) to prevent rigid body motion. These steps are described in Additional Constraint
Options for Removal Steps (p. 120).

Procedural Steps

1. To fix the bottom surface of the base plate, right-click the Static Structural object and then select
Insert > Fixed Support. Select the bottom surface of the base plate (geometry selection) and hit
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Apply in the Details view. If you have a more detailed geometry for the base, such as one with bolt
holes that you want to explicitly simulate, apply the boundary conditions to affix the plate accordingly.

Additional Constraint Options for Removal Steps

Weak Springs Option

As a first option, insert a Weak Springs object (p. 245) into an LPBF Static Structural simulation to prevent
rigid body motion when the default nonlinear stabilization is insufficient. In most cases, simulations
should be able to reach convergence without this object, but it may be necessary on some occasions.
When added, the object automatically scopes all nodes in the build at the interface of the parts/supports
and the base. It attaches weak springs on the scoping (or a subset of the scoping) to hold the part in
place without significantly affecting results.

1. To add weak springs, click the Weak Springs button in the LPBF Process ribbon. By default, nodes
in the build geometries (part and support) at the interface with the base will be scoped to the weak
springs object. Weak springs can also be scoped to the base or other non-build geometries (p. 196).
You should not scope build elements above the base to this object.

2. Weak springs are generated at the solve. To visualize where they are, before solving, do the following:

a. Under Analysis Settings in Solver Controls, set Weak Springs to On.

b. Under Static Structural > Solution, click Solution Information, and set Visible on Results
to Yes in the FE Connection Visibility options.

After doing this, the weak springs should be visible when viewing result objects like Total Deformation.
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Not every node scoped will get weak springs applied to it, it is dependent on how you set the Spring
Creation (p. 245) setting. Each node that does get springs applied will have three springs, one in the x-
direction, one in the y-direction, and one in the z-direction. You should ensure that the stiffness value
is low enough that it is not affecting simulation results other than holding the parts in place. It is not
recommended to scope weak springs above the interface of the build and base. Weak springs above
that interface can affect the build process leading to incorrect results. You will see a warning if you
have nodes or faces scoped above the build-base interface.

Three Nodes Option

In cases where both stabilization and weak springs are undesired for convergence, consider constraining
the part at three nodes to prevent rigid body motion. Be aware that you will be constraining the nodes
to their displaced position at the end of the build, rather than constraining them to 0. (For example, if
the node displaced 0.1 mm during the simulation, the constraint will keep the node at 0.1 mm.) Use a
Commands object to do this, as follows:

1. You may want to hide the base body during this process. Right-click the base body and select Hide
Body.

2. Zoom in to the area of the part where you will apply constraints. Switch to Node mode of selection.

3. Create nodal named selections: Right-click Model in the project tree, and select Insert > Named
Selection. Select a node on the bottom of the part, perhaps toward the middle of the part. You
should choose nodes that are unimportant to your results. Perhaps spread them out over the bottom
of the part but the nodes must not be co-linear. Your node selection will affect displacement results
but not stresses or strains. Click Apply in Details. Right-click the newly created Selection in the
project tree (under Named Selections) and select Rename. Name it to something short and descriptive,
such as CN1 (for constrained node 1). Do the same step two more times and rename them to CN2
and CN3.
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4. Create commands to constrain the nodes: Click the Static Structural object and select Commands

 from the context menu. Or, right-click and select Insert > Commands. In the Commands
window that is displayed, copy and paste, or type, the following:

D,CN1,UX,%_FIX%
D,CN1,UY,%_FIX%
D,CN1,UZ,%_FIX%
D,CN2,UY,%_FIX%
D,CN2,UZ,%_FIX%
D,CN3,UZ,%_FIX%

Constrained node 1 is fixed in UX, UY, and UZ and holds the part in place. Constrained node 2 is
fixed in UY and UZ, and constrained node 3 is fixed in UZ; these prevent rotation. Selection of CN1
can have a big effect on the displacement throughout the part. See the D command, which defines
degree-of-freedom constraints at nodes, for more information.

5. Match the commands to the base removal sequence step: Select the newly created Commands
object under Static Structural and, in Details, change the Step Selection Mode to By Identifier.
Change the Step Number to Removal Step: Base. This ensures the constraints are applied just
before the base removal step.

6. Remember to make the base plate visible again if you hid the body. Right-click the base body and
select Show Body.
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5.16. Solve the Static Structural Analysis

You initiate the structural solution in this step. Watch convergence plots or a live tracker of the total
deformation as the solution progresses.

Procedural Steps

1. To set up a plot of overall deformation that you can update throughout the solution, under the
Static Structural object, Solution Information, select Insert > Deformation Plot Tracker.

2. To initiate the solution, under Static Structural, highlight the Solution object, right-click and select
Solve.

3. Use the deformation plot tracker occasionally or continuously, as follows:

• Whenever you want to see the updated deformation, right-click the Total Deformation plot
tracker object and select Update Result. Or,

• Right-click the Total Deformation plot tracker object and select Switch to Automatic Mode.
This will show a continuous, live display as the solution progresses. The plot tracker object
must be selected in order to see the live display.

4. To observe convergence plots during solution, click Solution Information and in the Details panel,
under Solution Output, choose from among the selections in the drop-down list, such as Force
Convergence.

Restarts

Multiframe restarts for additive manufacturing analyses can be set up for any AM step specified by the
AMSTEP command except the build step. Restarts with additive manufacturing otherwise follow the
capabilities outlined here.

5.17. Review Results

For any simulation in Mechanical, once a solution is available you can view a contour plot or animate
the results (p. 126). There are solutions at many time points in a transient analysis and you can display
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the variation of a result item at a location over time. So for a LPBF Thermal-Structural simulation you
can view a result at a location on the build over the build history.

In addition to those general results, the following are result items of particular concern for AM simulations:

• Recoater Interference (p. 127) – The LPBF Recoater Interference result tool allows you to identify
excessive deformation in the Z direction that may lead to interference with the powder spreading
mechanism during printing.

• High Strain (p. 129) – The LPBF High Strain result tool allows you to identify regions of the part
that may be prone to forming cracks during or after the build process by highlighting critical
strain values.

• Hotspot (p. 130) – The LPBF Hotspot result tool is used to identify areas of overheating that may
result in problematic thermal conditions. This result is available for thermal-structural simulations
only.

• Deformation Along a Line (p. 131) – At times you may want to obtain results along an edge or
other specific location of the part to determine if the part will be within tolerances or to compare
to distortion measurements made after the part is built. This technique is used when calibrating
Strain Scaling Factors (p. 200), for instance. There are several ways to obtain this result.

• 3D Printing Time Estimate (p. 132) – Get an estimate of the real 3D printing time.

Procedural Steps

Recall that you used Output Controls under Analysis Options and/or AM-specific result items to control
which items are solved for in the simulation. Perhaps you set up results trackers in the solution step to
observe the results being processed during the solution. When reviewing results after the solution, you
will generally need to evaluate results to obtain them for viewing. Evaluating results is a way to retrieve
them from the data that was stored during solution. Only data items that were solved for may be re-
trieved in this way.

There are many different ways to view results but some of the ones most commonly used for additive
manufacturing are described here:
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Animate Thermal Results - Temperatures (Thermal-Structural System)

1. In the project tree under Transient Thermal, select the Solution object and then, in the context
menu, click Thermal and then Temperature. Or right-click Insert > Thermal > Temperature.
A Temperature object is created and becomes active.

2. Right-click Temperature and select Evaluate All Results. This retrieves the temperature data
and displays it in both graph and tabular form.

3. Use the animation controls at the top of the Graph window. Click the Result Sets button 

and also the Update Contour Range at Each Animation Frame button . Adjust the
number of seconds for the animation and click Play. For more information about animation
controls, see Animation in the Mechanical User's Guide.

The following is an animated GIF. Refresh the page to see the animation. View online if you are
reading the PDF version of the help.
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Animate Structural Results - Total Deformation

1. In the project tree under Static Structural, select the Solution object and then, in the context
menu, click Deformation and then Total. A Total Deformation object is created and becomes
active.

2. Right-click Total Deformation and select Evaluate All Results. This retrieves the deformation
data and displays it in both graph and tabular form.

3. Use the animation controls at the top of the Graph window.

4. It is important (and fun!) to change the magnification scale of the display in the Geometry
window so you can get a true sense (or an exaggerated sense) of the deformation in your
build. With Total Deformation highlighted in the project tree, from the Result context tab,
select the True Scale option from the drop-down menu. Animate the results using the animation
controls. Select other scales from the drop-down menu to see exaggerated results.

The following is an animated GIF. Refresh the page to see the animation. View online if you are
reading the PDF version of the help.
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Check for Recoater Interference

You need to define some sort of threshold for the level of Z-deformation that is considered to be
recoater interference. In the LPBF Recoater Interference Details view, change the Threshold
Definition to one of these three options:

• None - The result tool will show pure Z-deformation in the build, where the value at each
point corresponds to the Z-deformation when that material was a new layer.

• Layer Thickness Based (default) - The result tool uses the Deposition Thickness (set in the
Build Settings object for some simulation types, otherwise set it here) and a new input
field, Powder Packing Density, to determine the thresholds for warning and critical deform-
ation. Specifically, if the Z-deformation for any layer is equal to or greater than the Depos-
ition Thickness it is considered a warning. If the Z-deformation is equal to or exceeds the
value of Deposition Thickness/Powder Packing Density, it is considered critical. Powder
Packing Density may be dependent on the powder particle size, material, spreading
mechanism, or other factors.

• User Defined - You define your own warning and critical thresholds.

Once you have chosen your Threshold Definition, right-click the LPBF Recoater Interference
object and select Evaluate All Results. The resulting display shows the model with absolute Z-
deformation values but with color contours based on the threshold criteria you selected. For the
Layer Thickness Based and User Defined options, contours are shown as follows:

• Blue = Safe (Layer Thickness Based: Z-deformation is less than Deposition Thickness)

• Green = Warning (Layer Thickness Based: Z-deformation is equal to or greater than the
Deposition Thickness)

• Red = Critical (Layer Thickness Based: Z-deformation is equal to or exceeds the value of
Deposition Thickness/Powder Packing Density)

Important:

The data displayed is based on the Z deformation of each layer right before the next layer
is added. It does not represent the "final state" of deformation at the end of the cool-
down step.

Note:

To ensure a quick, dynamic calculation of results, Calculate Time History is set to No
by default for this result item. Set Calculate Time History to Yes and then right-click
Evaluate All Results to see the time history results, such as the layer-by-layer animated
build. For large models, the calculation may take some time.
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Check for High Strain Areas

The LPBF High Strain result shows the maximum equivalent strain experienced during the build
process. It can help to identify regions at risk of cracking.

Just as you do for the recoater interference result, consider defining a threshold for the level of
strain that is considered to be of concern for your material. In the LPBF High Strain Details view,
set the Threshold Definition to one of these options:

• None (default) - The result tool will show pure maximum equivalent strain in the build,
where the value at each point corresponds to the strain when that material was a new
layer.

• User Defined - You define your own warning and critical thresholds.

Once you have chosen your Threshold Definition, right-click the LPBF High Strain object and
select Evaluate All Results. The resulting display shows the model with maximum equivalent
strain values. For the User Defined option, color contours are displayed based on the threshold
criteria you selected. Contours are shown as follows:

• Blue = Safe

• Green = Warning

• Red = Critical

Note:

To ensure a quick, dynamic calculation of results, Calculate Time History is set to No
by default for this result item. Set Calculate Time History to Yes and then right-click
Evaluate All Results to see the time history results, such as the layer-by-layer animated
build. For large models, the calculation may take some time.
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Check for Hotspots (Thermal-Structural System)

The LPBF Hotspot result is applicable for the thermal portion of an LPBF Thermal-Structural simu-
lation. Use the result item after the thermal portion, at least, is solved.

Right-click the LPBF Hotspot object and select Evaluate All Results. The resulting display shows
the temperature of each layer right before the next layer is added. The worst hotspots are going
to be the areas with the highest temperature for that layer.

Read-only result data show the minimum and maximum temperature values and where they occur
(part or support).

Results are localized (based on nodal values), not averaged across the layer. Use a section plane
to reveal hotspots inside the part.

Important:

The data displayed is based on the temperature that the build cools down to at the end of
each layer right before the next layer is added. It does not represent the "final state" of
temperatures at the end of the cooldown step.

Note:

To ensure a quick, dynamic calculation of results, Calculate Time History is set to No
by default for this result item. Set Calculate Time History to Yes and then right-click
Evaluate All Results to see the time history results, such as the layer-by-layer animated
build. For large models, the calculation may take some time.
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Scope a Line of Nodes to Get Results at a Specific Location

Suppose you want to obtain X-direction deformation along a line on a face of your part, such as
shown below, at the end of the cooldown step.

There are several ways to perform this function but we will demonstrate it using a Worksheet. To
obtain distortion results along a line on the surface of your part:

1. Create a named selection: Highlight the Model object, right-click and select Insert > Named
Selection. Right-click the newly created Selection object (under Named Selections) and Rename
to something meaningful, for example, Line of Nodes.

131
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Review Results



Get an Estimate of the Actual 3D Printing Time

View the solver output to get an estimate of the real machine build time. It is approximately the
transient thermal build step simulation time multiplied by R^(1/3), where R is the number of de-
posit layers in one element layer. This data is available after the thermal solution. Click the Solution
Information object and then click the Worksheet tab under the Geometry window. In the Details
view, be sure that Solver Output is selected as Solution Output.
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Chapter 6: Advanced Topics
This chapter describes additional topics that you may want to consider for AM Process Simulations, in-
cluding the following:

6.1. Using Topology Optimization for Additive Manufacturing

6.2. Using the Inherent Strain Method

6.3. Using JAHM Temperature-Dependent Material Data in AM Simulation

6.4. Using AM Octree Adaptive Meshing

6.5. Using Variable Layer Height

6.6. Understanding Machine Learning Thermal Strain

6.7. Performing a Directed Energy Deposition (DED) Process Simulation (Simplified Approach)

6.8. Simulating Heat Treatment after the Build

6.9. Capturing a Buckled Shape with Large Deflection

6.10. Modeling a Symmetrical Part

6.11. Modeling Powder with Elements

6.12. Modeling Clamps, Measuring Devices and Other Non-Build Components

6.13.Troubleshooting

6.1. Using Topology Optimization for Additive Manufacturing

Topology optimization is an exciting technology that allows designers to optimize material layout
within a given design space, and for a given set of loads, boundary conditions and constraints, with a
goal of maximizing the performance of a product. The optimal shape of a part is often organic and
counterintuitive, and difficult or impossible to manufacture using traditional methods. By its very nature,
additive manufacturing opens up whole new possibilities for the real-world production of these optimized
parts. Along with the potential gains comes challenges unique to the manufacturing process, however.
We've seen that the use of supports for overhanging features during the printing process is necessary
but costly. If we could optimize our product designs while minimizing the requirement for supports at
the same time, we will be taking advantage of the best of both technologies.

The AM Overhang Constraint available in Ansys Mechanical's topology optimization tools allows us
to do just that. The goal of the overhang constraint is to create a self-supporting structure so that it
may be printed without adding supports. We will examine the overall workflow of using topology op-
timization combined with AM Process Simulation as well as the specific usage of the overhang constraint
in this section. For a general discussion of how topology optimization is implemented in Ansys Mech-
anical, see Structural Optimization Overview.
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Topology Optimization and AM Process Simulation Workflow

The general workflow in a linked topology optimization and AM simulation is shown in the following
figure.

Step A – Run an initial static structural analysis to establish loads and boundary conditions and baseline
results in Mechanical.

Step B – Run the topology optimization analysis with the AM Overhang Constraint in Mechanical.

• Highlight Topology Optimization, right-click and select Insert > AM Overhang Constraint. In Details,
change Build Direction and Overhang Angle to your desired values.

Parts designed using the AM Overhang Constraint are constrained more and results will include more
material than those optimized without the constraint. To allow more flexibility in solving this highly
nonlinear problem, we recommend you specify a range for the response constraint rather than just
a constant value. For example, if you want to reduce the mass in your part by 70%, we recommend
you allow the program to use a Percent to Retain range between 25 and 30% for maximum flexibility
in the algorithm. Defining a range for response constraint in combination with overhang constraint
will frequently require fewer iterations.

• Under Topology Optimization, select Response Constraint. In Details, under Definition, choose Mass
or Volume for Response. Change Define By to Range and enter a range of values for Percent to
Retain Min and Max.

Step C – Clean up the optimized geometry in Discovery Modeling and then validate the design in
Mechanical. Search for the Additive Manufacturing section in the Discovery documentation. Also, see
Performing Design Validation in the Structural Optimization in Mechanical.

Steps D and E – Run the additive manufacturing simulation on the optimized design in Mechanical.

AM Overhang Constraint Methodology

The AM Overhang Constraint is defined by a printing direction and an overhang angle. The printing
direction can be one of the global coordinate system axes (either the positive or negative direction).
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The overhang angle restricts the state of optimized elements. (Optimized elements are those that are
"kept" in the final design and that contribute to the system's overall stiffness matrix; that is, are filled
with material.) An element will be kept only if there is a supporting element in the layer below (or
above depending on the printing direction) that is also filled with material. An element is called a sup-
porting element of another element if the angle between the line defined by their centroids and the
base plate is greater than, or equal to, the overhang angle. The following figure demonstrates the re-
striction with an overhang angle of 45° in 2D. The printing direction is from the bottom to the top. In
order to fill the yellow element with material, at least one of the blue elements has to be filled, too.
Which of the blue elements will be kept depends on the state of the surrounding elements as well as
the load path. In the final design all remaining optimized elements have supporting elements.

Base Plate

The surface of the base plate is a plane perpendicular to the build direction. The base plate touches
the design region from below for positive printing direction (or from above for negative ones). For a
design to be printable, it requires a connection to the base plate. The results will depend on the size
of the area of contact. Results of the optimization will improve with increased contact area.

Excluded Elements

Excluded elements in the design region can lead to designs that do not satisfy the overhang constraint.
It cannot be guaranteed that these excluded elements are supported with respect to the overhang
angle. Excluded elements are always considered to provide support to optimized elements.

Example of AM Overhang Constraint Used in Topology Optimization

As shown in the following figure, a bracket-type component has two counterbored bolt holes at one
end and a through hole going through two flanges at the other. The bolt holes are fixed and a remote
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force is applied to the two holes of the flanges. These regions are excluded from the topology optimiz-
ation and are shown in red. The remainder of the geometry is our design region (purple). We want to
minimize material on the component while still maintaining its ability to structurally support the loads.

We used topology optimization first without, and then with, the AM Overhang Constraint. We set a
mass response constraint range of 10-13% material to retain. When using the AM Overhang Constraint,
we set an overhang angle of 45°. The print (or build) direction is from 0 along the positive Z axis.
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Comparing the two models, you can see there are several surfaces that will require supports in the first
image, especially underneath the branched structures. While not entirely eliminating them, the second
model minimizes these surfaces. Note also that the through holes will need to be supported during 3D
printing. The hole surfaces were not modified, as they were excluded regions.

6.2. Using the Inherent Strain Method

The Inherent Strain method provides an alternative to a coupled thermal-structural additive process
simulation available in Mechanical. With the Inherent Strain method, strains are calculated not from
material properties and thermal loads but from the use of a calibration factor, or Strain Scaling Factor.
The strain is equal to the Strain Scaling Factor multiplied by yield strength and divided by elastic
modulus:

The Strain Scaling Factor (SSF) is an important factor quantifying the variables unique to each build
scenario. It must be experimentally determined for each machine and material combination of interest.
We recommend you perform the same calibration procedure used for Ansys Additive, as described in
the Additive Print and Science Calibration Guide.

The SSF value is a direct multiplier to the predicted strain values. Using a value of 1 (default) will result
in strain magnitudes as calculated by the solver. Some material and geometry combinations result in
bulging/expansion rather than shrinkage and so a negative SSF is possible. Values between -1 and 1
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will reduce displacement and stress while values outside of that range will amplify them. Using a value
of 0 will result in no strain and the final displacement will match the input geometry.

You can define calibration factors that are different in each direction (X, Y, and Z) based on the Global
coordinate system by choosing Anisotropic Inherent Strain Definition. The properties of materials will
differ in different directions. If Inherent Strain Definition = Scan Pattern or Thermal Strain, individual
calibration factors, called anisotropic scaling coefficients (ASCs), may be entered based on the local
orientation of scan vectors within the part, that is, parallel and perpendicular to scanning direction and
in the build direction.

The steps in a typical additive manufacturing simulation are shown in the table below. Considerations
unique to using the Inherent Strain method are described.

Inherent Strain Workflow at a Glance

Considerations for Inherent Strain MethodSimulation Step

Select the AM LPBF Inherent Strain custom system in Workbench.1. Create analysis system

Necessary only if you are using your own user-defined material.
(Ansys-supplied sample AM materials are automatically available
if you used AM LPBF Inherent Strain custom system.)

2. Define Engineering Data

No special considerations.3. Attach geometry and launch
Mechanical

No special considerations.4. Identify geometry

No special considerations.5. Assign materials

No special considerations, other than if you will be using AM octree
adaptive meshing (p. 163), in which case Cartesian meshing with

6. Apply mesh controls and
generate mesh

voxelization option is required. Adaptive meshing is available only
with Inherent Strain simulations.

No special considerations.7. Identify and/or generate supports

No special considerations.8. Define connections

Note there is no cooldown step.9. Define AM process steps

Set Inherent Strain = Yes (Automatic if you used AM LPBF Inherent
Strain custom system.)

Set Inherent Strain Definition to isotropic, anisotropic, scan
pattern, or thermal strain. The thermal strain definition uses
the machine learning (ML) method.

10. Define build settings

Define process parameters. Required inputs depend on the
selected strain definition.

Enter strain scaling factors, usually determined by a calibration
procedure.

Review and change output controls as needed. Most items are not
stored during solution to reduce result file size. Consider

11. Establish structural analysis
settings

suppressing the calculation of stresses and strains if you are
interested only in distortion.

Apply a fixed condition to the underside of the base assuming the
base is rigid with no distortion.

12. Apply structural boundary
conditions
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Inherent Strain Workflow at a Glance

Considerations for Inherent Strain MethodSimulation Step

No special considerations.13. Solve the static structural
analysis

No special considerations.14. Review results

6.3. Using JAHM Temperature-Dependent Material Data in AM Simulation

As an alternative to using Mechanical's predefined sample materials for additive manufacturing, you
may choose to use a material from the JAHM Curve Data database in Granta MI's material library. JAHM
Curve Data provides temperature-dependent curve data for thousands of materials across 27,000+ records.
It includes mechanical, thermal, physical, electrical, fatigue, creep, stress-strain, and magnetic properties
for materials in a range of physical states (gas, liquid, solid) and covers temperatures ranging from -
270°C to over 5,000°C.

When choosing a material from JAHM Curve Data, keep in mind that AM simulations in Mechanical are
currently limited to metal materials. Furthermore, the metals included in the JAHM database are not
additive specific. That is, the test specimens were not additively manufactured. However, there may be
times when you want to use a material from this source. For this reason, we have provided the following
procedure and guidance for using JAHM Temperature-Dependent Material Data in an AM simulation.

6.3.1. Review of Required Material Properties

First let's review the material properties required to perform AM simulations in Mechanical. The fol-
lowing figure shows the required material properties, as depicted by screen captures from Workbench's
Engineering Data. The selected material happens to be the Ansys Ti-6Al-4V sample material. The 12
properties are: Density; Coefficient of Thermal Expansion; Zero-Thermal-Strain Reference Temperature;
Melting Temperature; Thermal Conductivity; Specific Heat; Young's Modulus, Poisson's Ratio, Bulk
Modulus, and Shear Modulus for the Isotropic Elasticity model; and Yield Strength and Tangent
Modulus for the Bilinear Isotropic Hardening model. Note that Isotropic Thermal Conductivity and
Specific Heat are required only when performing simulations with thermal solves, such as AM LPBF
Thermal-Structural.

When using JAHM materials, most of the required data is available on a single material record reflecting
"general properties" for a given material, which can be exported as a material card from Granta MI
and imported directly into Engineering Data. However, a few pieces of data are usually missing from
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the general properties record and you must provide the missing data. In many cases, the Bilinear
Isotropic Hardening model data, from true stress-strain (tension) tensile testing, is not included in a
material record that includes all the other required mechanical and thermal properties. This is because
true stress-strain is very dependent on the specific manufacturing and heat treatment processes, as
well as on tensile test conditions, such as strain rate, hold time, and so on. To handle this, search for
a record that contains true stress-strain (tension) data corresponding to your preferred scenario for
your chosen material. From that data, you will derive the Yield Strength and Tangent Modulus for
the Bilinear Isotropic Hardening model. You may need to refer to other sources to get the single data
points of Zero-Thermal-Strain Reference Temperature and/or Melting Temperature.

The following table summarizes the required properties for AM simulation when using a JAHM tem-
perature dependent material.

Material Properties Required for AM Simulation

SourceComponentsFormProperty

Direct import from
Granta MI

Temperature, DensityTabularDensity

Direct import from
Granta MI

Temperature, CTETabularIsotropic Coefficient of
Thermal Expansion (CTE)

Other sourceTemperatureSingle
data
point

Zero-Thermal-Strain
Reference Temperature

Other sourceTemperatureSingle
data
point

Melting Temperature

Temperature, Young's Modulus,
Poisson's Ratio, Bulk Modulus,
Shear Modulus

TabularIsotropic Elasticity model:

Direct import from
Granta MI

Young's Modulus

Direct import from
Granta MI

Poisson's Ratio

Direct import from
Granta MI

Bulk Modulus

Direct import from
Granta MI

Shear Modulus

Temperature, Yield Strength,
Tangent Modulus

TabularBilinear Isotropic Hardening
model:

Direct import from
Granta MI

Yield Strength

Derived from true
stress-strain curves

Tangent Modulus

Direct import from
Granta MI

Temperature, Thermal
conductivity X, Y, Z

TabularThermal Conductivity[a]
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Material Properties Required for AM Simulation

SourceComponentsFormProperty

Direct import from
Granta MI

Temperature, Specific heatTabularSpecific Heat[a]

Required only for Thermal-Structural simulations[a]

6.3.2. Workflow Using JAHM Material

The steps for using JAHM temperature-dependent material data in an additive manufacturing simu-
lation are:

1. Obtain JAHM Material Data from Granta MI (p. 142)

• Search for material record representing general properties (p. 142)

• Export material card (p. 146)

• Search for material record for true stress-strain data (p. 147)

• Save the true stress-strain curve data (p. 151)

• Use a spreadsheet to derive data for Bilinear Isotropic Hardening model (p. 152)

2. Enter JAHM Material into Engineering Data (p. 155)

• Import general properties material card (p. 155)

• Add missing properties (p. 157)

• Rename and save the new material in Engineering Data (p. 160)

3. Add JAHM Material to a Project and Assign it to a Geometry in a Simulation (p. 162)

6.3.2.1. Obtain JAHM Material Data from Granta MI

We'll use Ti-6Al-4V as an example material throughout this documentation and we'll use Granta MI
Explore to search for the desired JAHM material in Granta MI. We will need more than one material
record to get all the required properties.

Search for material record representing general properties

Important:

Either a Granta Selector or a Granta MI license is required to get access to JAHM datasets.
If you do not see the features used in this example on your system, check with your
Granta MI Administrator, as many features are configurable, such as the Export to Excel
feature.

Open Granta MI and, from the Explore menu drop-down, choose JAHM Curve Data and then
JAHM All Curves.
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On the left side is a search panel where you enter filter criteria. Under Material information, Mater-
ial family, choose Metals and alloys. After selecting the check box, hit Escape or click anywhere
in the user interface outside of the check box window.
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Under Material category, choose Titanium Alloys, followed by Escape.

Under Material, choose Ti - 6Al - 4V.

As you continue to narrow the scope of materials you will see the filter criteria listed at the top of
the page. Adjust the column widths as needed to see the information.

Now we need to narrow the list down to those Ti - 6Al - 4V materials that have density and the
properties for the isotropic elasticity model. In the search panel, scroll down to the Physical prop-
erties check boxes and choose Density. Under Mechanical properties, choose Elastic modulus,
Shear modulus, Bulk modulus, and Poisson's ratio. If you also try to select Yield strength (tension)
and/or, under Stress-Strain, True stress-strain (tension), you will see the message: "No matches for
this criteria in the current search results." There are no material records that contain all the data. This
is because true stress-strain is very dependent on the specific manufacturing and heat treatment
processes, as well as on test conditions, such as strain rate, hold time, and so on. To handle this,
we will find a second material record later. For now, select only the five properties as shown here.
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From the search results, we'll choose Ti - 6Al - 4V, general properties. You can view the specific
properties, plot curves, and so on by double-clicking the record.

You can change the units system under Preferences, in the lower, left corner of the interface. Be
sure to save the material data in Metric or SI units to be consistent with the default units used in
Workbench's Engineering Data for AM simulations in Mechanical.
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Export material card

A material card is an xml file that contains material data in a format useable by the Engineering
Data module. On the left side of the page, click the Export icon, Export Material Cards, to export
the Ti - 6Al - 4V, general properties material card.

Under Available packages, choose Ansys Workbench. Under Available exporters, choose Temper-
ature-dependent properties. Then click Run. Save the xml file to a location on your computer.
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Search for material record for true stress-strain data

Now we need to obtain the information for the plastic portion of the stress-strain curve. Navigate
back to the Explore page and click Reset to clear the form. Again search for Metals and alloys,
Titanium Alloys, Ti - 6Al - 4V, and this time, scroll down to Stress-Strain and check the box for
True stress-strain (tension).
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The search results show Ti-6Al-4V material records with various manufacturing processes. Double-
click Ti - 6Al - 4V, quenched and tempered. In the right side panel that appears, click the arrows
icon to Show full page datasheet.

Scroll down to the Stress-strain section and click Plot curves.
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The many curves shown reflect the Ti - 6Al - 4V, quenched and tempered material record with
various heat treatment processes and tensile test methods. We will need additional filters to select
the conditions we want. We'll choose one that has a fairly slow strain rate and held for a long time.
Generally, we would prefer a lower strain rate for a quasi-static tensile testing and a longer hold
time for the temperature to homogenize at an elevated testing temperature. You should choose a
record that is most appropriate for your situation.

On the right-hand side panel, scroll down to see the parameters of Hold time and Strain rate. Under
Hold time, clear the first two check boxes and keep the box checked for 1800 seconds, reflecting
a half hour hold time. Under Strain rate, clear the last two check boxes and keep the check box
checked for 0.00005 strain/sec. This leaves three stress-strain curves representing three different
temperatures, 204.44°C, 315.56°C, and 537.78°C. Hover over each curve to see the details.
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Remember that from the first material card we already have the data for the elastic portion of the
material's overall stress-strain curve. By looking at the X-axis (True plastic strain) on these curves,
we know the graph shows only the plastic portion of the material's overall stress-strain curve. For
each temperature, the yield point is at the start of the curve, or at a true plastic strain = 0. We will
calculate the slope of each curve, which is the tangent modulus.

To view the data raw numbers, on the left side panel, under Stress-strain, click View this data.
Again, this data is from Ti - 6Al - 4V, quenched and tempered with all the processes and test
methods. Collapse the data until you find our desired data for 0.00005 strain rate and 1800 hold
time. The data for the three temperature curves corresponding to 315.56°C, 537.78°C, and 204.44°C
are in Series 14, 15, and 16, respectively. This is the data we must extract.
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Save the true stress-strain curve data

On the left side of the interface, click the Export icon and then Export to Excel to save the data.
On the next page, after the export is completed, click Download exported data. It is saved as Ti
- 6AI - 4V, quenched and tempered.xlsx.
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Use a spreadsheet to derive data for Bilinear Isotropic Hardening model

Open the Ti - 6 Al - 4 V, quenched & tempered.xlsx file. At the bottom of the
page, navigate to the sheet called Truestress-s_ain(tension).

Scroll to the right to find the data in series 14: Temperature = 315.56°C, Hold time = 0.5 hr, and
Strain rate = 0.00005 strain/s. Continue to scroll to the right to see the data in series 15: Temperature
= 537.78°C, and in series 16: Temperature = 204.44°C.
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For each temperature, the true stress value at true plastic strain = 0 indicates the Yield Strength.
We will enter these values into Engineering Data later.
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For simplicity, we assume the tangent modulus is the slope of the true plastic stress-strain curve.
For full documentation on how to calculate the tangent modulus, refer to Bilinear Isotropic
Hardening.

or

Calculate that in the spreadsheet using a formula as follows:
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The Tangent Modulus for each temperature curve is highlighted. The following tables summarizes
our results.

Tangent Modulus (Pa)Yield Strength (Pa)Temperature °CSeries # in
spreadsheet

2618222728790255600204.4416

3959473439697464900315.5614

5347750000335275300537.7815

These values will be entered into Engineering Data in the next step. The Yield Strength and Tangent
Modulus together comprise the data for the Bilinear Isotropic Hardening model.

6.3.2.2. Enter JAHM Material into Engineering Data

Open Workbench, and add an additive analysis system as you normally do to begin a simulation.
Here we added an AM LPBF Thermal-Structural system. Double-click Engineering Data to open
it.

Import general properties material card

Click Engineering Data Sources and scroll down to the  button to add an existing data source
from a file. Navigate to your saved Ti - 6Al - 4V general properties xml file and click Open.

155
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Using JAHM Temperature-Dependent Material Data in AM Simulation



Click the check box  in column B to edit the material.
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A review of the properties reveals that Melting Temperature and a Bilinear Isotropic Hardening
model are missing.

Add missing properties

To add the missing Melting Temperature, in the Toolbox on the left side panel, open Physical
Properties and double-click Melting Temperature. This adds the property to the material being
edited and shows a yellow highlight for the missing value. Enter 1605 in the highlighted area next
to Melting Temperature. The value of 1605°C is the Melting Temperature from the Ansys Ti-6Al-4V
sample material.
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Do the same to add the Bilinear Isotropic Hardening model from the Plasticity options in the
Toolbox panel. Next to the highlighted input fields, be sure to use the appropriate units; in our
example we are using Pascals for both Yield Strength and Tangent Modulus.
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Double-click either highlighted field and then, in the upper right table, enter the values for Temper-
ature, Yield Strength, and Tangent Modulus that you calculated from the spreadsheet.
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Rename and save the new material in Engineering Data

Now that all the missing data has been entered, the new material is complete and must be saved
in Engineering Data for future use. First rename the material. In the Engineering Data Sources
panel, click the material name field and enter a new name. We used Ti-6Al-4V JAHM.
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Clear the check box that allows editing of data and you will be prompted to save the material.
Click Yes. The new material is saved in Engineering Data and to your original xml file.

161
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Using JAHM Temperature-Dependent Material Data in AM Simulation



6.3.2.3. Add JAHM Material to a Project and Assign it to a Geometry in a Simula-
tion

Any time you want to use the material in a simulation, you must first add it to the project in
Workbench's Engineering Data. Navigate to the new JAHM material in Engineering Data Sources

and click the plus icon . The book icon  indicates it has been added to the current project.
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Work through the simulation as usual and then assign the new material for the appropriate geometry
bodies.

6.4. Using AM Octree Adaptive Meshing

For additive manufacturing Inherent Strain simulations, a special case of nonlinear mesh adaptivity is
available in which the total number of elements is reduced by coarsening elements in previously deposited
layers. This may help in reducing simulation time in specific cases.

A simple 2D representation of mesh coarsening is shown below, in which four square elements are
combined into one larger square element.
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The AM octree method was created specifically for use with laser powder bed fusion simulations, which
commonly use cubic (voxelized) elements. The octree method combines eight cubic elements into a
new, single cubic element, as shown in this 3D representation.

Nonlinear mesh adaptivity modifies the mesh automatically during the solution based on specified cri-
teria. Mesh modifications occur by general remeshing with the AM octree technique. Loads, boundary
conditions, contact conditions, solutions variables, etc., are seamlessly transferred to the new mesh as
the solution progresses. Aside from setting the initial criteria, no user action is required.

AM octree adaptive meshing criteria include the specification of layers designating when remeshing
will start and end, buffer regions, both vertical layers and edge elements, to control where a fine mesh
is maintained, and layer frequency to modify how often the program remeshes elements. The figure
below shows four buffer layers and two buffer elements.
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The goal of AM octree adaptive meshing is to reduce simulation time. However, keep in mind that
remeshing takes time, so remeshing too frequently may not provide a simulation time benefit.

Procedural Steps

The AM octree method is a special case of nonlinear mesh adaptivity designed for mesh coarsening.
To use AM octree adaptive meshing:

1. Set up an AM LPBF Inherent Strain (p. 138) simulation in the usual way and be sure to use voxilized
meshing (p. 78) (Mesh Method with Method = “Cartesian” and Mesh Using Voxelization = “Yes”).

2. Apply a Nonlinear Adaptive Region. The Nonlinear Adaptive Region condition enables you to change
the mesh during the solution phase. It acts as a remesh controller based on certain criteria. The
criteria determine whether or not the mesh will be modified and, if so, when it will be modified and
which locations will be modified.

On the Environment context tab: click Conditions > Nonlinear Adaptive Region. (Or, right-click
the Static Structural tree object, or anywhere in the geometry window, and select Insert > Nonlinear
Adaptive Region.)
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3. Set remesh criteria:

• Scoping will always read All Build Bodies if AM Process is in the project tree, however supports
will not be considered for mesh coarsening. Similarly, the base plate is not taken into account.

• Criterion: This is set to AM Octree automatically if AM Process is in the project tree.

• Remesh Layer Frequency: Frequency with which the program will perform remeshing. A
value of 4 will remesh every 4 layers from Remesh Layer Start to Remesh Layer End.

• Remesh Layer Start: The layer at which remeshing will start. Value must be greater than or
equal to 0.

• Remesh Layer End: The layer at which remeshing will end. Value must be greater than or
equal to 0. A value of 0 (default) will display “Last Layer” and will continue to remesh through
the end of the build.
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• Buffer Layers: Number of layers to keep at fine mesh resolution between the current, top
layer and the layers to be remeshed. Defaults to 2.

• Buffer Elements: Number of buffer elements to keep at fine mesh resolution between the
part edges and the remeshed elements. Defaults to 2.

For both buffer inputs, higher values may ensure better accuracy, but reduces the number of elements
that can be coarsened.

4. Solve the simulation.

5. View the coarsened mesh by selecting a result item and then using a section plane to see inside
the part. Hint: The best way to see the effect of remeshing is to make a clean, vertical slice through
the model.

6. View the time steps at which remeshing took place by looking for Changed Mesh = Yes in tabular
data when a result item or Solution is selected.

Notes on Usage and Known Limitations

Following are considerations and limitations when using AM octree adaptive meshing:

• AM octree adaptive meshing is available only for LPBF Inherent Strain simulations. (Because the
octree technique is used in the structural solver, it is not available for the thermal portion of a
thermal-structural simulation or even the structural step of a thermal-structural simulation where
temperature mapping is based on a consistent mesh between the thermal and structural analyses.)

• AM octree adaptive meshing is available only with a voxelized mesh (Cartesian mesh with
voxelization option (p. 82)).

• AM octree adaptive meshing supports models with multiple build bodies as long as the voxel
grid between bodies is consistent.

• Cubic elements that comprise the part are considered eligible for remeshing. The support, the
base plate, and any other non-cubic elements are not taken into account.

• Cubic elements with a knockdown factor less than 1, such as those found around edges or in
narrow areas that are not completely dense with material, will also not be considered for
remeshing.

• A simulation can contain multiple nonlinear adaptive regions. This gives you more control and
customization over when to remesh, which improves remeshing utilization and could result in
significant time savings if used effectively. Consider using a nonlinear adaptive region whenever
the build reaches a point where, during a remesh, many elements can be coarsened to maximize
time savings. Multiple remeshes can take a significant amount of time, so limiting the number
of remeshes to occur in areas where more elements can be coarsened will bring the greatest
time savings.

• Because AM octree adaptive meshing occurs during solution, the coarsened mesh is visible via
section plane only on results displays.

• The LPBF High Strain result is not available when using AM octree adaptive meshing.
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6.5. Using Variable Layer Height

The variable layer height feature for additive manufacturing analyses allows you to vary the simulation's
layer height to build with smaller layers in areas of interest, and larger layers in other areas of the part.
You can capture fine details in a simulation without greatly increasing the overall simulation time by
reducing the number of super-layer load steps that need to be solved. (See Methodology and Abstrac-
tions (p. 7)). You control this by setting the layer size (AMBUILD,LAYERT) and number of simulation
layers to solve (AMSTEP,BUILD) iteratively until the part is complete.

Procedural Steps

This feature can be used by iteratively specifying the simulation layer size with the AMBUILD command,
and the number of layers to build with the AMSTEP command. In Mechanical, these commands can
be added to a Commands object under the analysis type. If variable layer height is used for a thermal-
structural analysis, both the thermal analysis and the structural analysis must have the same sequence
of layer sizes and layers built.

Create commands to use variable layer height:

1. Click the Static Structural object and select Commands  from the context menu. Or, right-click
and select Insert > Commands. In the Commands window that is displayed, type something like
the following, modifying the specific numbers to fit your part:

! Build 10 layers at 1 mm
AMBUILD,LAYERT,0.05,1
AMSTEP,BUILD,,10

! Build 6 layers at 0.25 mm
AMBUILD,LAYERT,0.05,0.25
AMSTEP,BUILD,,6

! Build the remaining layers at 1mm
AMBUILD,LAYERT,0.05,1

Note:

By default, the Mechanical application will send the AMSTEP,BUILD command after
reading the Commands objects. If variable layer height is used in an independent script,
the AMSTEP,BUILD command will need to be added to the end of the example script
above.

2. Repeat the above step for the Transient Thermal system if you have a thermal-structural analysis.
(This step is not applicable for an AM simulation using Inherent Strain.)

Example

Following is an example to illustrate the variable layer height feature. The simple part has three columns
that come together to form a beam at a height of 8 mm. We want to capture greater details at the
location where the columns join together because we suspect that is where the greatest distortion will
be.
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Using a Commands object inserted under the static structural system, we set up simulation layers with
a height of 1 mm for the columns and a height of 0.25 mm after that for the beam. This simulation
uses Inherent Strain so there is no transient thermal system.

Our results show comparable distortion at the location of interest and the variable layer height feature
resulted in a 53.8% simulation time reduction for this model and variable layer height setup.

B. Variable layer heightA. Full layer height

Mesh layer size = 0.25 mmMesh layer size = 0.25 mm

Number of element layers = 40Number of element layers = 40

Number of simulation layers = 15Number of simulation layers = 40

Node count = 78,115Node count = 78,115

Element count = 52,376Element count = 52,376

Solution time = 3 min 30 sec (10 cores)Solution time = 6 min 30 sec (10 cores)
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Notes on Usage and Known Limitations

When using variable layer height:

• Using large layer thicknesses may lead to artificially high deformations. It’s always important to
carefully review your results.

• In some cases, it may be necessary to suppress an error check for elements spanning multiple layers.
Suppression for this check can be controlled in the AMBUILD,LAYERT command. A value of 1 can be
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sent for the “Layer-checking suppression” field shown in the command input below. Be careful when
using this option as it may lead to improper boundary conditions. This is a beta option at this release.

AMBUILD,LAYERT,Deposition thickness,Super-layer thickness,Layer-checking
suppression

• The progress bar may not accurately track the progress of the simulation.

• At this release, the estimate of the real machine build time in the output file will probably be incorrect.

6.6. Understanding Machine Learning Thermal Strain

Thermal Strain simulations, specifically those run using Additive Print's Thermal Strain simulation type,
provide the highest level of fidelity at the cost of a much longer computational time. That is because
Thermal Strain simulations predict how thermal cycling affects strain accumulation at each location
within a part. The simulation follows the laser moving along each scan track on each deposit layer and
is based on the machine process parameters (power, scan speed, beam diameter, etc.). See Thermal
Strain - Anisotropic and Overview of the Thermal Solver in the Additive Print and Science User's Guide.

It can take millions of laser scan tracks to build a typical part with the laser powder bed fusion process,
and performing a thermal simulation that follows the laser along each scan track can easily incur a
computational cost that is prohibitive. Modern machine learning (ML) techniques provide a way to map
from the machine parameters and scan pattern directly to the final outcome, skipping the costly scan-
by-scan thermal simulation while providing a high-fidelity result that is computationally practical. Our
ML Thermal Strain model, based upon the Thermal Strain simulation type in Additive Print and imple-
mented in Mechanical, predicts the Thermal Strain result much faster than simulation. It can be one to
three orders of magnitude faster than Thermal Strain simulation in calculating the strain that is passed
to the structural solver. Speedup increases with part size, scan area, and melt pool size.

The ML model is based on a deep convolutional neural network that has been trained on an extensive
database of Thermal Strain simulation results. No further data generation or training is required to use
ML Thermal Strain. The database used to pre-train the ML model consisted of nearly one million layers
from a variety of complex geometries. Machine parameters covered the entire range available when
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defining build settings, and were restricted to combinations with predicted single bead melt pool di-
mensions that meet the following constraints:

• Single bead melt pool depth must be greater than or equal to deposition thickness

• Single bead melt pool width must be greater than or equal to hatch spacing

• Single bead melt pool width divided by single bead melt pool depth must be greater than or equal
to 1.25

When using ML Thermal Strain, violations of predicted single bead melt pool dimension constraints will
trigger messages that recommend how to adjust machine parameters to resolve the violations. Note
that the predicted single bead melt pool dimensions are an approximation and may not match results
from a Single Bead simulation in Additive Science.

Porosity is neglected. All locations within the part are assigned at least the base strain. For this reason,
and because the ML model is subject to error in approximating Thermal Strain results, ML Thermal
Strain results may not be an exact match with Thermal Strain results.

We recommend you perform a Strain Scaling Factor calibration specifically for ML Thermal Strain. Do
not use Strain Scaling Factor calibration that was completed for Thermal Strain.

Important:

The Machine Learning Prediction feature requires a Structures AI+ license.

Frequently Asked Questions

• How much of a speedup over Thermal Strain simulation can I expect when I choose ML Thermal Strain?

The following plot shows performance data for generating the thermal strain for one deposit layer in
a sample part run in various strain modes in the Additive application. For an average layer time of 1
second, it would take ~1000 seconds for a 1000-layer part to complete the thermal strain mapping
for the part. Overall, the speedup of strain generation with ML Thermal-Strain can be up to three
orders of magnitude faster than Thermal Strain simulation and is comparable in speed to the Scan
Pattern simulation type. Speedup increases with part size, scan area, and melt pool size. However, it
is important to remember that the speedup from ML Thermal Strain is applicable to the thermal
portion only of the overall simulation, and that the thermal strains are then passed to the structural
solver to determine stress and deformation. To determine the overall simulation time, you need to
add the time taken to solve the structural portion.
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The following plot demonstrates that the speedup of ML Thermal Strain over Thermal Strain simulation
improves with increasing part size, scan area, and melt pool size. Melt pool width generally increases
as energy is input to the system, such as by increasing power and/or beam diameter, and/or decreasing
scan speed. As in the above plot, the data is from the generation of thermal strain for one deposit
layer, and this data is from two sample parts with two sets of process parameters run in the Additive
application. You can see a 20X to 4500X speedup in these scenarios.
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• Is the ML Thermal Strain capable of simulating my unique geometry without additional training?

Yes. Additional training is not needed. The ML model was trained with a collection of over 300 parts
representing a wide range of geometries including organic shapes, bulky and thin features, state
transitions, spiral and helical geometries, and many more.

• Is there a limited range of machine input parameters I should stay within?

Yes. The table below shows the required ranges and recommended ranges, if applicable, for the
machine parameters required for the ML model.

Recommended RangeRequired RangeParameter

50 to 500 Watts50 to 700 WattsBeam Power

500 to 2500 mm/sec350 to 2500 mm/secScan Speed

80 to 120 µm20 to 140 µmBeam Diameter

10 to 100 µmDeposition Thickness

60[a] to 1000 µmHatch Spacing

1 to 100 mmScan Stripe Width

0 to 180°Start Layer Angle

0 to 180°Layer Rotation Angle
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Recommended RangeRequired RangeParameter

20 to 200 °C20 to 500 °CPreheat Temperature

Different than Thermal Strain in Ansys Additive[a]

• What if I want to customize my material properties?

Since there are no material property inputs to the ML Model, we can only provide thermal strain
results based on the material properties used to train the models. These are the materials validated
for the Additive application. Choose the thermal Strain Material Model that most closely matches
your material and then be sure to perform a calibration for ML Thermal Strain.

• Why do I need to calibrate specifically for ML Thermal Strain? Are there any special considerations for ML
when performing a calibration?

Each simulation type represents a specific set of underlying assumptions. For example, an Inherent
Strain simulation with an Isotropic strain definition (referred to as the Assumed Strain simulation type
in Additive Print) is the most simplifying assumption about strain behavior within a part during a
build. More inputs are needed as the underlying assumptions become more complex for various
simulation types. A calibration process determines the factor(s) that work with any given set of as-
sumptions to get the best fit to your machine/material/part scenario. Therefore we recommend you
perform a calibration for each simulation type you will be performing. See Additive Calibration - Full
Procedure in the Additive Print and Science Calibration Guide. While the ML model was based on the
Thermal Strain simulation type in Additive Print, we do not guarantee that the ML model, as trained,
will always remain in sync with the Thermal Strain simulation type, as occasional tunings of the
Thermal Solver are performed.

There are no special considerations for ML when building a calibration part and taking measurements,
but be sure to choose ML Thermal Strain in Mechanical when running the simulation portion of the
calibration procedure.

Just as we state for all simulation types, it is not necessary to perform a calibration for ML Thermal
Strain if your goal is simply to examine trends, that is, the effects of variable changes on stress or
distortion relative to each other.

6.7. Performing a Directed Energy Deposition (DED) Process Simulation
(Simplified Approach)

Directed Energy Deposition (DED) is an additive manufacturing process where metal wire or powder is
combined with an energy source to deposit material onto a part directly. Rather than spreading a layer
of metal powder across a surface and scanning the part's profile with a laser to build up a part surrounded
by unmelted powder, only the desired part is built in a DED process, with no surrounding leftover
powder. The DED process is much less expensive than LPBF but less precise. It is widely used to repair,
or add extra material to, existing parts.

Important:

Ansys provides two methods of DED process simulation. The first is a simplified approach in
which super layers representing several actual welded layers are lumped together using the
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birth-and-death technique just as in an LPBF simulation. Most of the steps are the same, with
special considerations as described in this section.

The second approach is a more detailed and accurate representation in which the path of
each deposition weld track is "followed" using element clusters that are made alive using the
birth-and-death technique. This approach uses the DED Process Add-on. Refer to the dedicated
user's guide for details.

Simulation of a DED process using the simplified approach is almost the same as for an LPBF process,
except that the convection of heat from the part as it is being built must be accounted for differently.
Specifically, convection to the surrounding gas in the chamber is applied to all sides of the build as it
is building. (This differs from an LPBF simulation, in which the convection is applied only to the top of
a newly deposited layer.) A DED simulation uses only the gas convection properties of the build settings
and not the powder convection properties. All the required adjustments are handled automatically by
the program once you specify a DED simulation using the AMTYPE command.

At any point prior to solution, specify a DED simulation with a Commands object in both the transient
thermal and static structural analyses:

1. Click the Transient Thermal object and select Commands  from the context menu. Or, right-
click and select Insert > Commands. In the Commands window that is displayed, copy and paste,
or type, the following:

AMTYPE,DED

2. Click the Static Structural object and select Commands  from the context menu. Or, right-click
and select Insert > Commands. In the Commands window that is displayed, copy and paste, or
type, the following:

AMTYPE,DED

All other procedures for a DED simulation are the same as in an LPBF simulation.

6.8. Simulating Heat Treatment after the Build

After a part is built, it is common to heat treat it to relieve residual stresses. Heat treating is a process
using the controlled application of heat to alter the physical and chemical properties of a material. In
an annealing process, metal is heated in a furnace to a particular high temperature, held there for a
long time (hours or days) and then allowed to cool slowly. This may be done either before or after re-
moving the part from the base plate. These scenarios can be simulated in Mechanical.

To model the heat treatment process, an additional Transient Thermal analysis is required. The data
flow at the system level in Workbench is depicted in the figure below for both Inherent Strain and
Thermal-Structural simulations. The workflow systems depict how data flows from one type of analysis
to another. For example, temperatures from the two (uncoupled) thermal analyses are required as inputs
for the structural analysis in the Thermal-Structural simulation. The proper time sequence—or when
that data is used—is defined in the AM Process Sequence worksheet (p. 100).
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You can account for the stress relief mechanism in a heat treatment analysis in one of two ways:

• By using a creep model in Workbench's Engineering Data. This approach results in a more real-
istic stress relaxation curve as shown in an equivalent stress plot.

Note:

The creep models for Ansys predefined AM materials are not applicable for DED or
sintering simulations.

• By specifying a Relaxation Temperature in the Static Structural analysis settings. This is a simplified
approach resulting in an abrupt stress relaxation.

The following topics related to heat treatment are available:

6.8.1. Overview of Heat Treatment Workflow

6.8.2. Define Engineering Data - Unsuppress Creep Properties

6.8.3. Add Transient Thermal System to the Project

6.8.4. Define AM Process Steps - Add Base Unbolting and Heat Treatment Steps to the Sequencer

6.8.5. Establish Analysis Settings - Define Creep Relaxation Temperature

6.8.6. Apply Boundary Conditions - Add Convection for Heat Treatment Step

6.8.7. Solve the Simulation - Check Units First!

6.8.8. Heat Treatment Examples
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6.8.1. Overview of Heat Treatment Workflow

The LPBF Setup Wizard includes heat treatment modeling as an option. We strongly advise you to
use the wizard to set up your simulation because it automates much of the tedious set-up, including
enabling the creep model, applying boundary conditions, and adjusting the unit system during
solution when you choose to simulate with creep effects. If you do not use the wizard, follow these
steps to simulate heat treatment after the build:

Heat Treatment Workflow at a Glance (Non-Wizard Workflow)

Considerations for Simulating Heat TreatmentSimulation Step

Set up an LPBF simulation, either Inherent Strain or
Thermal-Structural.

1. Create analysis system

If simulating heat treatment using a creep model as the mechanism
for stress relief, identify it here in Engineering Data. For Ansys

2. Define Engineering Data (p. 179)

predefined AM materials, open Engineering Data, select the desired
material, and unsuppress the creep model (either Norton or
Generalized Garofalo). Take note of the unit system used to define
the creep model.

No special considerations.3. Attach geometry and launch
Mechanical

In Mechanical, add a Transient Thermal system to the project for
the heat treatment step. Be sure AM Process Simulation is set to

4. Add Transient Thermal system for
heat treatment step (p. 181)

No for the new system. Insert an Imported Load into the Static
Structural system.

No special considerations.5. Identify geometry

No special considerations.6. Assign materials

No special considerations.7. Apply mesh controls and
generate mesh

No special considerations.8. Identify and/or generate supports

No special considerations.9. Define connections

Using the Sequencer, add a base unbolting step first, followed by
a heat treatment step.

10. Define AM process steps (p. 182)

No special considerations.11. Define build settings

If simulating heat treatment using a relaxation temperature as the
mechanism for stress relief, set it here in Static Structural > Analysis
Settings.

12. Establish analysis settings (p. 183)

In addition to the usual boundary conditions for an LPBF simulation,
apply convection to the surfaces of the part, supports, and base

13. Apply boundary
conditions (p. 183)

plate for the heat treatment step. For the Imported Load, specify
the Transfer Step to be Heat Treatment Step.

If simulating with creep properties, switch to the unit system used
in the creep model before solving.

14. Solve the simulation (p. 184)

Add an Equivalent Stress result scoped to the build to see the stress
relief. Add an Equivalent Creep Strain result to see the creep
accumulation.

15. Review results
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6.8.2. Define Engineering Data - Unsuppress Creep Properties

When simulating with heat treatment, use either creep properties or a relaxation temperature (p. 183)
as the mechanism for stress relief, but not both.

To use creep properties as the mechanism for stress relief, unsuppress the creep model in Engineering
Data. (By default, creep properties are suppressed, meaning creep effects are ignored.) Unsuppress
the creep model as follows:

1. In Workbench, double-click the Engineering Data cell in the first (left-most) system. This
opens the Engineering Data tab and workspace

2. Click your choice of materials from the list of available AM materials shown. In this example,
we've chosen 316 Stainless Steel. Notice the Source column (column D) shows Additive
Manufacturing Materials.

3. Clear the check box to the right of the creep model so that the creep properties are unsup-
pressed. In this example, the model is Generalized Garofalo. The model may also be Norton,
depending on your chosen material. Expand the model cell to view the creep constants and
reference units. In this example, the reference unit system is in millimeters.
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Important:

Take note of the reference unit system used to define the creep model. It may be
defined in meters or millimeters. The unit system used during solution must be the
same unit system used to define the creep model. You may set up your simulation
and review results in any unit system but be sure to switch to the creep model
system just before you initiate the solve. Should you forget to do this, you will see
the following error message and the simulation will not solve. "An error occurred
inside the SOLVER module: The "Reference Units" defined for the Creep material property
does not match the solver unit system." If you see this error, clear generated data,
change to the creep unit system, and solve again.

4. Click the Project tab at the top of the Workbench window to go back to the system view.

What if I forget to unsuppress the creep model?

If you forgot to unsuppress the creep model in Engineering Data and you have already assigned
material properties to the bodies in Mechanical, you must update the project after unsuppressing
the creep model. Unsuppress the creep model as described above, and then in Workbench system
view, right-click the Model cell in the first Transient Thermal analysis and select Update before returning
to Mechanical.
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6.8.3. Add Transient Thermal System to the Project

Add the Transient Thermal system to account for heat treatment as follows:

1. In Mechanical, from the Home tab, click the Analysis button to reveal a drop-down list of analysis
types. Select the Transient Thermal system.

2. Click the new Transient Thermal object in the project tree and in the Details view, under Additive
Manufacturing, change the AM Process Simulation setting to No. (This option may already be
set to No, depending on the LPBF system you set up.)

3. Right-click the Static Structural object and select Import Load > Transient Thermal. This adds
a new Imported Load object under the structural system. You will need to go back to this object
later after the AM process steps are defined.
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6.8.4. Define AM Process Steps - Add Base Unbolting and Heat Treatment
Steps to the Sequencer

When modeling heat treatment, it is best to also include a base unbolting step, in which the constraints
for UX, UY, and UZ are removed from the base plate nodes. This eliminates any artificial tension in
the base caused by fixed boundary conditions and thermal expansion during heating, which would
otherwise occur if base unbolting is not used.

Add base unbolting and heat treatment steps to the AM Process Sequence worksheet as follows:

1. Select the AM Process object and then click the Sequence button (AM Process group) on the
context toolbar. The sequencer worksheet comes up.
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2. Click Add Step on the Static Structural side of the sequencer worksheet and select Base Unbolt
to add the unbolting step first. Click Add Step again and select Heat Treatment Step.

3. Select the Static Structural object in the project tree and then select the Imported Load object
underneath it that belongs to the new heat treatment Transient Thermal system. In the Details
view, under Additive Manufacturing, change the Transfer Step option to the new Heat Treatment
Step. This ensures the thermal data from the heat treatment step is transferred at the correct time
(load step).

6.8.5. Establish Analysis Settings - Define Creep Relaxation Temperature

When simulating with heat treatment, use either creep properties (p. 179) or a relaxation temperature
as the mechanism for stress relief, but not both.

To use a relaxation temperature as the mechanism for stress relief, click Analysis Settings under the
Static Structural object. In the Details view, under Additive Manufacturing Controls, change the step
to heat treatment step, then change Relaxation Temperature to User Specified and then change
the Value to your desired stress relaxation temperature for the material.

6.8.6. Apply Boundary Conditions - Add Convection for Heat Treatment Step

In addition to the typical boundary conditions for an LPBF simulation, apply convection to the surfaces
of the part, supports, and base plate for the heat treatment step, as follows:

1. Right-click the Transient Thermal object corresponding to the heat treatment step and then select
Insert > Convection.
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2. Select all the bodies including the base plate (geometry selection) and hit Apply in the Details
view. Are STL Supports automatically selected and included in body count?

3. In Details under Definition, Film Coefficient, enter a value for the convection coefficient of the
gas in the furnace, or select Tabular Data.

4. Under Ambient Temperature, select Tabular Data.

5. In the Tabular Data area of the interface, specify the appropriate convection coefficient and
temperature at different time points.

6. In Analysis Settings, change the Step End Time to match the final time in the convection tabular
data. More details on how to control the time stepping settings are available here.

6.8.7. Solve the Simulation - Check Units First!

If simulating with creep properties (p. 179), switch to the unit system used in the creep model before
solving. Should you forget to do this, you will see the following error message and the simulation
will not solve. "An error occurred inside the SOLVER module: The "Reference Units" defined for the Creep
material property does not match the solver unit system." If you see this error, clear generated data,
change to the creep unit system, and solve again.

Note that you can switch back to your preferred unit system for reviewing results after the solution
is finished.

6.8.8. Heat Treatment Examples

The following examples are available:

6.8.8.1. Example LPBF process simulation with and without heat treatment

6.8.8.1. Example LPBF process simulation with and without heat treatment

The following heat treatment project was set up to show the effects that heat treatment can have
on stress and distortion in an additively manufactured part. Two cantilevers with supports are set
up in the same additive manufacturing simulation with cutoff from the supports occurring at different
time points for each cantilever. The first cantilever is removed from supports before heat treatment,
and the second cantilever is removed after heat treatment.
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To model this, the AM sequencer was set up as shown in the following figure.
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After simulating the additive manufacturing process and steps defined in the sequencer, the two
cantilevers are left with different distortion magnitudes. The heat treatment step relieved residual
stresses and led to decreased distortion in the second cantilever (on the left) after the cutoff step.
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6.9. Capturing a Buckled Shape with Large Deflection

If your part has particularly thin walls and you are worried that it may deform significantly during the
additive printing process, you can set up a simulation to capture a buckled shape deformation. The
following two settings should be set to capture this phenomena in the AM simulation:

• Turn on Large Deflection: Under Static Structural, click Analysis Settings. In the Details view,
under Solver Controls, change Large Deflection to On. This setting is off by default for AM
simulations.

• Use Quadradic elements: Click Mesh, and in Details, under Defaults, change Element Order to
Quadradic. Higher-order elements may help convergence in the simulation.

The following figures show distortion results from an AM simulation of a model with a thin outer wall.
The full model is shown as well as a cross-section view. The upper portion shows significant distortion
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into a buckled shape. (Note: this model has a coarser mesh than recommended, it is for demonstration
purposes only.)
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6.10. Modeling a Symmetrical Part

If your model has symmetrical geometry—specifically, if it is symmetric with respect to the part, supports,
and build plate, and it has symmetric loading and boundary conditions—you can simulate a sector of
a large model to achieve a faster simulation time with fewer resources. Both the base plate and the
build (part and supports) should be included in the symmetry sector.

189
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Modeling a Symmetrical Part



The procedure is the same as described in Symmetry, with a few modifications for the AM process
simulation. Specifically, you will need to do the following:

A. Prepare your part, supports, and baseplate geometries to form a symmetric sector.

B. After meshing, create a SYMM_NODES named selection consisting of nodes along the symmetry
plane. This named selection is used internally and allows the program to handle the AM
boundary conditions properly.

C. As a structural boundary condition, apply a constraint at the symmetry plane of the build and
the base plate. Depending on the mesh type used, this is done in one of two ways:

• For a Cartesian mesh, where the mesh is associated back to the geometry entities, insert
a symmetry region on the geometry faces defining the symmetry planes.

• For a layered tetrahedral or voxel mesh, where the mesh is not associated back to the
geometry faces, define Mechanical APDL commands that constrain nodes from moving
normal to the symmetry planes.

D. Finally, if your simulation includes a thermal solution, input a Dwell Time Multiple in Build
Settings to account for the reduced simulation time that comes with a symmetry model.

For step A, prepare your model in a CAD package, as normal. Procedures for steps B through D are
described next.

Procedural Steps

B. Create a SYMM_NODES named selection consisting of nodes along the symmetry plane
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Right-click Model in the project tree, and select Insert > Named Selection. Right-click the newly created
Selection object (under Named Selections) and Rename it to SYMM_NODES. In the Details view change
Scoping Method to Worksheet. In the Worksheet, set up filtering criteria to identify the nodes of interest.
In the half symmetry model below, we selected all the nodes along a plane of X = 0. Click Generate to
create the named selection of nodes.

C. Apply a constraint at the symmetry plane

• For a Cartesian mesh, insert a symmetry region on the faces defining the symmetry plane of the
build and the base plate. This will apply a frictionless support boundary condition on those faces.
With this boundary condition, no portion of the body can move, rotate, or deform normal to the
faces. (The use of a frictionless support is not unique to additive manufacturing simulations.)

Switch to face mode of selection and use Ctrl-left-click to select the multiple geometry faces
along the symmetry plane. Highlight Model, right-click and Insert > Symmetry. Right-click the
Symmetry object and select Insert > Symmetry Region. In the Details view, be sure that the
Symmetry Normal property is set to the axis of the Global Coordinate System that is normal to
the symmetry plane, in our example, the X-Axis.
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• For a layered tetrahedral or voxel mesh, since the mesh is not associated back to geometry faces,
planes of symmetry selected in the UI are not recognized. For these types of meshes, you must
define Mechanical APDL commands that constrain nodes in the symmetry planes. (Note that a
voxel mesh associates back to body entities only, not faces, edges, or vertexes.)

Right-click Static Structural and select Insert > Commands. On the Commands object that
appears in the tree, enter the appropriate commands that select the SYMM_NODES nodes, applies
a constraint (D command) to prevent motion normal to the symmetry plane, and selects all
nodes again. In our half symmetry example:

CMSEL,S,SYMM_NODES
D,ALL,UX,0
ALLSEL

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.192

Advanced Topics



D. For thermal simulations, input a Dwell Time Multiple equal to the number of symmetry sector
repeats

For analyses with thermal solutions, such as an AM LPBF Thermal-Structural simulation, this step is re-
quired to reconcile the reduced time to simulate the build. For example, the build time for a half sym-
metry model is ½ of the build time of the full model, so the Dwell Time Multiple should be 2. Similarly,
use a Dwell Time Multiple of 4 for a quarter symmetry model, and so on.

In the project tree, click AM Process > Build Settings and in the Details view under Machine Settings,
change Dwell Time Multiple to 2, or 4, or the appropriate number of repeats. In the half symmetry
model in our example, we changed Dwell Time Multiple to 2.
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The remaining steps are the same as usual for additive simulations.

6.11. Modeling Powder with Elements

During a laser powder bed fusion (LPBF) process, almost all the heat dissipation is through the part and
supports back to the build plate rather than out through the unmelted powder surrounding the part.
Many users ignore the small effect of heat loss through powder but you may choose to model it in one
of two ways:

• As equivalent heat convection

• By including powder elements as a named selection called POWDER_ELEMENTS. (For Mechanical
APDL users, use an element component CM,POWDER_ELEMENTS,ELEM).

Modeling the powder as elements may be useful if you will be simulating multiple parts close together
on the build plate or if the part has features close together, where accounting for the heat transfer oc-
curring between the parts or features is important. The following is an overview of the procedure:

1. In your CAD program, create a separate body to represent the powder in-between the parts or fea-
tures. If you will be using a Cartesian mesh, share topology between the bodies. If you will be using
a layered Tetrahedrons mesh, do not share topology.

Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.194

Advanced Topics



2. In the Mechanical application, identify the build and base bodies on the AM Process object as usual.
Do not select the powder body when identifying the build and base bodies.

3. Assign the same material property that you use for the build to the powder body.

4. Depending on your chosen mesh type, account for the connections between bodies and mesh the
model.

5. Create a named selection, called POWDER_ELEMENTS, of elements associated with the powder body.
This Ansys-defined named selection will use the knockdown factor, Powder Property Factor, identified
in the Build Conditions to estimate the powder properties.

6. Proceed with the rest of the simulation as normal.

In the following example, the powder was modeled between two cylindrical parts close together on
the build plate. Temperature contours are shown in the second figure. Notice the heat transfer in the
powder area between the parts.
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6.12. Modeling Clamps, Measuring Devices and Other Non-Build Com-
ponents

At times you may want to simulate geometry items that are present on the build plate but that are not
being 3D-printed. These items may include clamps, bolts, measuring devices, instrumentation, etc. They
may influence the heat dissipation and/or distortion of the part being built so they need to be included
in the simulation.

Use the Ansys-defined named selection NONBUILD_ELEMENTS to identify this geometry. (For Mechan-
ical APDL users, use an element component CM,NONBUILD_ELEMENTS,ELEM). This Ansys-defined com-
ponent name signals to the application that those elements should not be part of the build process.
That is, they will be present the entire simulation and will not be "birthed" at melting temperature in
a layer-by-layer fashion.

6.13. Troubleshooting

If you are experiencing convergence issues during an AM Process Simulation, try one or more of these
suggestions, as appropriate:

• If base unbolting and/or removal steps (p. 97) are included in your simulation, the fact that nonlinear
stabilization (p. 102) is on by default should be enough to loosely hold parts in place to prevent rigid
body motion when the base is removed. However, if you think you need additional constraints, consider
using weak springs (first choice) or directly applying fixed boundary conditions on three nodes of
the part (second choice) to prevent rigid body motion. These steps are described in Additional Con-
straint Options for Removal Steps (p. 120).
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• If Large Deflection is on, turn it off, under Analysis Settings for the static structural analysis. Large
deflection is off by default for AM Process Simulations but it is useful in some cases and users often
turn it on.

For thin-walled parts, the walls can tend to take on a buckled or dimpled shape as the build progresses.
In these cases, large deflection is required and convergence difficulties may be seen. If that is the
case, you will need an adequate mesh to capture this deformation. Consider using a finer mesh or
switch to a quadratic (midside-noded) element (Element Order in Mesh Details). See Capturing a
Buckled Shape with Large Deflection (p. 187) for details.

• Switch to the Direct Solver for Solver Type under Analysis Settings for the static structural analysis.

• If you are using customized materials, be sure you have defined a nominal strength at the melt
temperature, as a near zero modulus and/or yield strength could lead to convergence problems.
(Ansys predefined materials take care of this internally.)

• If you are using a Layered Tetrahedrons mesh with a geometry imported from an .stl file, be sure
the faceted geometry is cleaned up as much as possible. (See Cleaning Up Facets (p. 13)). Depending
on the quality of the .stl file, you may see convergence issues because of poor tet elements created
with a "dirty" .stl file.

• If you are using creep properties in a heat treatment analysis and you experience convergence issues
in the transient thermal solution, increase the sub-steps in the Transient Thermal module in order to
avoid an abrupt change in temperature.

If you are using an AM Bond connection and see unrealistic spikes in deformation at the interface where
the AM Bond is applied, adding a second AM Bond connection with flipped scoping may improve the
connection and prevent the unrealistic deformations.
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Chapter 7: Performing a Calibration
Deformation values within additively manufactured parts vary across different machine and material
combinations in real-world fabrication scenarios, especially when considering the numerous laser powder
bed fusion (LPBF) machine manufacturers and powder material suppliers available. Before simulating
your production part, you should calibrate your simulation software to help reduce variability. Calibration
accounts for the difference between measured and simulated deformation.

The overall calibration process for Additive in Mechanical consists of obtaining measured
distortion values from physical experiments and then performing a calibration simulation.
The first part of the process, obtaining measured distortion from a calibration build, is
exactly the same process as described in the Additive Print and Science Calibration
Guide. Refer to the following topics from that document for details:

• Determine Your Calibration Part

• Appendix B: Download Calibration Files Here

• Build the Calibration Parts

• Take Distortion Measurements

The objective of this calibration procedure is to determine a set of calibration coefficients
to use when performing additive simulations in Ansys Mechanical. The coefficients to
be determined depend on the simulation type and strain definition selected. This is
summarized in the following table. SSF is Strain Scaling Factor and ASC is Anisotropic
Scaling Coefficient. Throughout this document, we will distinguish between an SSF/TSSF-
only calibration and an SSF combined with ASCs (or SSF + ASCs) calibration.

Calibration Coefficients
Simulation type / Strain
definition

Calibration
Type

---
SSFAM LPBF Inherent

Strain / Isotropic
SSF only

---
Thermal
SSF (TSSF)

AM LPBF
Thermal-Structural

Vertical
ASC = 1

Perpendicular
ASC

Parallel
ASC

SSFAM LPBF Inherent
Strain / Scan PatternSSF +

ASCs Vertical
ASC = 1

Perpendicular
ASC

Parallel
ASC

SSFAM LPBF Inherent
Strain / Thermal Strain

The values of the calibration coefficient(s) compensate for the difference between an
experimentally measured target deformation and a simulated deformation value obtained
at the same location on a chosen calibration geometry. Using the calibrated coefficient(s)
will greatly improve the simulation prediction accuracy of your production part when
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using the same simulation setting combinations, therefore increasing the chance of
successful builds as well as reducing the cost of trial-and-error experiments.

For more information about calibration coefficients, see the beginning of this sec-
tion (p. 138).

7.1. When to Calibrate

The values for calibration coefficients depend upon many variables from both fabrication and simulation
setup:

• Material

• LPBF machine

• Process parameters (laser power, scan speed, deposition thickness, base plate preheat temperature,
hatch spacing, etc.)

• Simulation type and strain definition

• Material properties (linear or nonlinear)

• Mesh type (Cartesian, layered tetrahedrons, or voxel)

• Other simulation specific configurations

Calibrate only for the type of simulation you will be performing on your production part. For example,
if you care about the as-built distortion of a part for a given material, machine, and process parameter
combination using an Inherent Strain isotropic simulation, run the calibration just for that combination
of variables. When the combination changes, re-calibrate the calibration coefficients. Even changing
the material supplier for a material you have already calibrated for may require a new calibration.

It is important to note that you can expect different calibration coefficient values from different simulation
types, material properties, and/or mesh types even when using the same experimental distortion
measurement value(s).

7.2. Calibration Simulation Workflow

The steps in a calibration simulation are summarized here and described in more detail following the
table.

Calibration Simulation Workflow at a Glance

Considerations for CalibrationSimulation Step

Set up either an LPBF Thermal-Structural or LPBF Inherent Strain
simulation. Import your chosen calibration geometry. Use the LPBF

1. Set up AM simulation

Setup Wizard (p. 17) to set up your simulation the same as you
would to simulate your production part.

For the meshing step, use a 0.5 mm voxel mesh size if you are
using either the Cantilever or Double arches calibration
geometry from Ansys.
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Calibration Simulation Workflow at a Glance

Considerations for CalibrationSimulation Step

Use defaults for all calibration values.

Perform the steps in the wizard until you reach the last step,
Set Up Calibration.

Set Set up Calibration to Yes.

Identify Node Measurement Location, such as a line of nodes
along a surface, corresponding to the experimental
measurement location.

2. Set up calibration

The last step of the LPBF Setup
Wizard is the same as the
single-step LPBF Calibration
Wizard.

Choose Deformation Direction, either X, Y, or Z in which
deformation is measured. Usually this is normal to the surface
of the measurement location.

Set Calibration Deformation Results, either Max, Min, or Avg

Calibration Type (either SSF or SSF + ASCs) is set automatically
based on your settings of simulation type and Strain Definition.

Set up Start Layer Angle and Layer Rotate Angle if SSF +
ASC mode is chosen.

Set Target EXP Deformation, the target deformation value.

Set Calibration Tolerance, an acceptable level of difference
between experimental and simulated deformation.

In Workbench, right-click Optimization > Update in the Direct
Optimization system to initiate the calibration. Calibration iterations
are fully automatic.

Requires an Additive Suite license

3. Solve the calibration simulation

Record the last set of parameters and then Save Build Settings.4. View and save optimized
calibration coefficients

Details of Workflow

Let's look at the workflow to run a calibration simulation in Mechanical in a little more detail.

1. Set up either an LPBF Thermal-Structural or LPBF Inherent Strain simulation. See Create the
Analysis System (p. 67).

2. Import your chosen calibration geometry.

3. Use the LPBF Setup Wizard (p. 17) to set up your simulation the same as you would to simulate
your production part.

4. There are a few preferred mesh types for LPBF simulations. See Apply Mesh Controls and Gen-
erate Mesh (p. 78). Mesh type and size affect results convergence. For best results, we recom-
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mend you use the same mesh type for the calibration simulation that you will use for the sim-
ulation of your production part.

These are our mesh size recommendations for the Ansys-supplied Cantilever and Double arches
calibration geometries:

Projection
Factor

Layer height
(mm)

Mesh size
(mm)

Mesh typeGeometry

--0.5Voxel

Double
arches

-0.50.5Layered
tetrahedrons

0-0.5Cartesian

--0.5Voxel

Cantilever
-0.750.75Layered

tetrahedrons

00.5Cartesian

5. The selections you make in the Build Settings step determine whether you will need a SSF/TSSF-
only calibration or an SSF + ASCs calibration.

Note that the Inherent Strain Definition of Anisotropic is not available/supported for automatic
calibration.

6. Use default values for calibration coefficients.

7. The last step of the LPBF Setup Wizard is the calibration set-up. Follow the instructions in the
Help section to complete the settings.
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Set up Calibration = Yes

Node Measurement Location: Use geometry selection or named selection to identify the nodes
corresponding to the measurement location. Directional deformation data will be extracted
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here for comparison to the target EXP deformation values. It may be easiest to define a named
selection based on geometric location such as a line of nodes along an edge located at X=0
and Y=5 mm, for example. Refer to the tutorial for an example.

Deformation Direction: The direction, either X, Y, or Z, in which deformation is measured.
Usually this is normal to the surface of the measurement location.

Calibration Tolerance: An acceptable level of difference between experimental and simulated
deformation. Defaults to 1%.

Calibration Deformation Results: Either Max, Min, or Avg. Choose this input to match the data
you measured.

Calibration Type: Either SSF or SSF + ASCs. This is set automatically based on your settings of
simulation type and Strain Definition.

Target EXP Deformation: The target deformation value.

8. Once all the required settings are configured, click Finish and close the wizard. Proceed back
to Workbench UI. For the calibration iterations, a pre-configured Direct Optimization system is
added to the project and linked to the AM simulation system.

In Workbench, right-click Optimization > Update in the Direct Optimization system. The op-
timization will start to run calibration iterations automatically. Depending on the calibration
mode you are using, either a one step SSF/TSSF-only calibration or a two-step SSF + ASCs cal-
ibration is performed.
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9. To check the progress during calibration iterations, double-click Optimization (in the Direct
Optimization system) and click Raw Optimization Data.
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10. Once the optimization is completed, you will see the yellow lightening bolt become a green
check mark in the Direct Optimization system. In the Optimization tab, click Candidate Points.
The optimized values for calibration coefficients with their corresponding simulation deformation
values will be shown on the right.
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11. We recommend that you save the optimized SSF and ASC values for use in future simulations
of production parts. Use them whenever you simulate with the same set of variables for which
you calibrated. See When to Calibrate (p. 200).

In Workbench, double-click Parameter Set. Click inside the last row, then right-click and choose
Set Update Order by Row. Set to Current. Back in the Mechanical application, right-click Build
Settings in the project tree and select Save Build Settings. This will save the entire set of build
parameters including the optimized calibration coefficients.

7.3. Known Limitations

• The Inherent Strain Definition of Anisotropic is not available/supported in the LPBF Calibration Wizard.

• For calibrations that use cutoff results as target deformation values, turning on large deflection
(Static Structural > Analysis Settings under Solver Controls) is a reasonable option to consider. However,
convergence issues may arise from time to time during the calibration process.
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Chapter 8: Object Reference
Specifications are provided for the following Mechanical application objects that are unique to LPBF
process simulations:

8.1. AM Bond

8.2. AM Process

8.3. Build Settings

8.4. Generated Support

8.5. LPBF High Strain

8.6. LPBF Hotspot

8.7. LPBF Hotspot Time Correction (Beta)

8.8. LPBF Recoater Interference

8.9. Predefined Support

8.10. STL Support

8.11. Support Group

8.12.Weak Springs

8.1. AM Bond

Connects a meshed part to a meshed support when the mesh is non-contiguous between them in an
AM Process Simulation. The internal means of connection is through constraint equations that connect
the support nodes to the part elements.

209
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.



Object Properties (p. 210)

Tree Dependencies (p. 211)

Insertion Methods (p. 211)

Right-click Options (p. 211)

API Reference (p. 211)

Additional Related
Information (p. 211)

Object Properties

The Details Pane for this object includes the following properties.

Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection and Named Selection (default).Scope

Contact: In most cases, choose the part as the contact.[a] When the Scoping Method is
set to Named Selection, select a desired Named Selection from the drop-down menu.
When the Scoping Method is set to Geometry Selection, use selection filters to pick the
part geometry, click in the Geometry field, then click Apply.

Target: In most cases, choose the support as the target.[a] When the Scoping Method is
set to Named Selection, select a desired Named Selection from the drop-down menu.

Contact Bodies: Read-only indication of scoped geometry or Named Selection.

Target Bodies: Read-only indication of scoped geometry or Named Selection.

Reversing the entities identified as contact and target will not only produce a warning
message, but will typically produce unexpected and unrealistic deformation. However, if

[a]

the support mesh is much coarser than the part mesh, say greater than 2:1 proportions,
reverse the selection and make the support the contact and the part the target.
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Tree Dependencies

• Valid Parent Tree Object: Connections.

• Valid Child Tree Objects: None.

Insertion Methods

Use any of the following methods after highlighting Connections object:

• Select AM Bond on the Connections Context Tab.

• Right-click the Connections object or in the Geometry window and select Insert > AM Bond.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Suppress: Suppresses the contact connection from the simulation.

• Enable/Disable Transparency

• Hide All Other Bodies

• Flip Contact/Target: Reverses the identification of contact and target entities. For AM Bond
connections, typically the part is the contact and the support is the target. However, if the support
mesh is much coarser than the part mesh, say greater than 2:1 proportions, use this option to
flip the selection and make the support the contact and the part the target.

API Reference

See the AM Bond Connection section of the ACT API Reference Guide for specific scripting information.

Additional Related Information

See Define Connections in the LPBF Simulation Guide (p. 93) section for more information.

8.2. AM Process

Identifies geometries and sets global options for all AM-related objects in an AM Process Simulation.

211
Release 2025 R1 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

AM Process



Object Properties (p. 212)

Tree Dependencies (p. 213)

Insertion Methods (p. 213)

Right-click Options (p. 213)

API Reference (p. 213)

Additional Related
Information (p. 213)

Object Properties

The Details Pane for this object includes the following properties.

Properties/Options/DescriptionsCategory

The part to be printed.Build
Geo-
metry Scoping Method: Options include Geometry Selection (default) and Named Selection.

Geometry: Use selection filters to pick geometry, click in the Geometry field, then click
Apply.

Named Selection: Select a desired Named Selection from the drop-down menu.

The base plate upon which the part rests.Base
Geo-
metry Scoping Method: Options include Geometry Selection (default) and Named Selection.

Geometry: Use selection filters to pick geometry, click in the Geometry field, then click
Apply.

Named Selection: Select a desired Named Selection from the drop-down menu.

Z Location at the Top of Base: Read-only indication of the Z location at the top of the
base plate. This is often 0.
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Properties/Options/DescriptionsCategory

Layer Height: Read-only indication of the layer height used in the mesh.

Tree Dependencies

• Valid Parent Tree Object: Model.

• Valid Child Tree Object: Build Settings and Support Group.

Insertion Methods

The AM Process object is inserted under the Model object in the project tree by default when using
either of these two custom systems for additive manufacturing: AM LPBF Inherent Strain or AM LPBF
Thermal-Structural. When not inserted automatically by a custom system, use any of the following
methods after highlighting Model object:

• Select the AM Process option on the Model Context Tab.

• Right-click the Model object or in the geometry window and select Insert > AM Process.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Insert >

– Support Group

– Predefined Support

– Generated Support

– STL Support

– Cartesian Mesh

• Create Build To Base Contact: This option creates a Contact Region between the Build Geo-
metry and the Base Plate Geometry. The Contact Side is defined as the element faces of the
bottom of the Build or Support. The Target Side is defined as the element faces of the top of
the Base Plate Geometry. Both contact and target scopes are defined by Named Selection. This
option is visible once you have generated a mesh.

API Reference

See the AM Process section of the ACT API Reference Guide for specific scripting information.

Additional Related Information

See the following sections for more information:

• LPBF Simulation Guide (p. 1)
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• Identify Geometries (AM Process Object) (p. 76)

8.3. Build Settings

Defines simulation and strain assumptions, process parameters, and build conditions related to an ad-
ditive manufacturing material, machine, and process.

Object Properties (p. 217)Build Settings for an AM LPBF Inherent Strain system
showing Details for the four strain definitions (Isotropic,
Anisotropic, Scan Pattern, and Thermal Strain): Tree Dependencies (p. 223)

Insertion Methods (p. 223)

Right-click Options (p. 223)

API Reference (p. 223)

Additional Related
Information (p. 224)
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Build Settings for an AM LPBF Thermal-Structural system
shown with power heating method:
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Object Properties

The Details Pane for this object includes the following properties.
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Properties/Options/DescriptionsCategory

Additive Process: The Additive Process Type - Laser Powder Bed Fusion. The LPBF
process uses thermal energy from a laser or electron beam to selectively fuse powder
in a powder bed.

Sim-
u-
la-

Inherent Strain (p. 138): Yes or No. If Yes, the AM simulation uses a static structural
system and the loading strains are calculated based on an experimentally calibrated

tion
Set-
tings

Strain Scaling Factor. If No, the AM simulation uses a linked thermal-structural system
in which strains are calculated from temperature-dependent material properties (p. 69)
and loads. The remaining options under Machine Settings differ depending on whether
Inherent Strain = Yes or No.

If Inherent Strain = Yes:

• Inherent Strain Definition: Isotropic, Anisotropic, Scan Pattern, or Thermal
Strain.

– Isotropic assumes that a constant, uniform strain occurs at every
location within a part as it is being built.

– Anisotropic uses the same average strain magnitude as isotropic strain,
but it subdivides that strain into anisotropic components in the X, Y,
and Z directions based on the Global coordinate system.

– Scan Pattern uses the same average strain magnitude as isotropic
strain, but it subdivides that strain into anisotropic components based
on the local orientation of scan vectors within the part. Scan vectors
may be generated internally via a slicing function assuming a rotating
stripe scan pattern or input via a build file.

– Thermal Strain is a method that provides the highest level of fidelity
and takes thermal cycling into account at each location within the part.

• Thermal Strain Method: At this release, only the Machine Learning Prediction
method is available.

– Machine Learning Prediction uses a machine learning model prediction
of the anisotropic Thermal Strain simulation result from the Ansys
Additive application.—Thermal Strain simulations provide the highest
level of fidelity by predicting how thermal cycling affects strain
accumulation at each location within a part. The simulation follows the
full laser path on every layer, and is based on the machine process
parameters (power, scan speed, beam diameter, etc.)—The machine
learning model has been trained to predict the Thermal Strain result
much faster than simulation. It can be one to three orders of magnitude
faster than Thermal Strain simulation in Additive Print in calculating the
strain that is passed to the structural solver. Speedup increases with
part size, scan area, and melt pool size. See Thermal Strain - Anisotropic
in the Additive Print and Science User's Guide and Understanding Machine
Learning Thermal Strain (p. 171).
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Properties/Options/DescriptionsCategory

• Machine Learning Model: A list of materials that were used to train the ML
prediction. Choose the material that most closely matches your material
assignment in Engineering Data. ML models may be based on different material
properties than those in Engineering Data. The ML models are used to generate
loading strains. Materials in Engineering Data are used for the structural analysis.

• Layer Height: Sets the element layer height for the mesh, which must conform
to uniform layer sizes in the global Z direction. Options include Program
Controlled (default) and Manual. For Program Controlled, the application
finds the first layered tetrahedrons mesh method that is scoped to the AM
build body and sets the Layer Height to the value specified in the Details pane
of the layered tetrahedrons mesh method. If there are no layered tetrahedrons
meshes present/scoped to the build, then no Layer Height value is used. When
set to Manual, the user specified Layer Height is used, regardless of whether
a layered tetrahedrons mesh is present.

Strain Scaling Factor(s): A calibration factor, or factors, used to account for differences
in additive machines and materials that you may use to improve the accuracy of your
simulations. The SSF scales the inherent strains in the analysis by the given value.

Cal-
ib-
ra-
tion

• If Inherent Strain = Yes:Set-
tings

– If Inherent Strain Definition = Isotropic, a constant Strain Scaling
Factor may be entered to scale strain everywhere uniformly.

– If Inherent Strain Definition = Anisotropic, individual Strain Scaling
Factors may be entered for X, Y, and Z directions based on the Global
coordinate system.

– If Inherent Strain Definition = Scan Pattern or Thermal Strain,
individual Strain Scaling Factors, called anisotropic scaling factors (ASC),
may be entered based on the local orientation of scan vectors within
the part, that is, parallel and perpendicular to scanning direction and
in the build direction.

• If Inherent Strain = No:

– Thermal Strain Scaling Factor: An optional input that scales the thermal
strains in the structural portion of AM simulations by a given value.
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Properties/Options/DescriptionsCategory

Properties in this category are illustrated in the following figure:Ma-
chine
Set-
tings

If Inherent Strain = Yes:

• Scan Pattern Definition (visible if Inherent Strain Definition = Scan Pattern
or Thermal Strain): How the scan pattern is defined, either generated using a
rotating stripe pattern (default) or input via a build file.

– Generated: Start Layer Angle and Layer Rotation Angle as defined below.
Scan Stripe Width is also visible if Inherent Strain Definition = Thermal
Strain. These inputs define an internally generated scan pattern.

– Build File: Machine Type and Build File Path inputs become available
with this option. These inputs specify an external build file to be used.

→ Machine Type: Specifies the machine or OEM associated with
the build file specified. Options are Additive Industries, EOS,
HB3D, Renishaw, Sisma, SLM, and Trumpf.

→ Build File Path: Location of a .zip file containing the scan pattern
file(s), and an stl of the part geometry.

Build files for simulations that use the Machine Learning
Prediction Thermal Strain Method only support stripe scan
patterns. See Build File Requirements in the LPBF Simulation
Guide (p. 109) for additional requirements.

• Start Layer Angle: The orientation of fill rasters on the first layer of the build.
It is measured from the X axis, such that 0 degrees results in scan lines parallel
to the X axis. The starting layer angle is commonly set to 57 degrees. Must be
between 0 and 180°.
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• Layer Rotation Angle: The angle at which the major scan vector orientation
changes from layer to layer. It is commonly 67 degrees. Must be between 0
and 180°.

• Scan Stripe Width: Width of the sections, called stripes, into which the
geometry is sliced. The stripes are scanned sequentially to break up what would
otherwise be very long continuous scan vectors. Scan Stripe Width is commonly
set to 10 mm wide. Must be between 1 and 100 mm.

• Hatch Spacing: The average distance between adjacent scan vectors when
rastering back and forth with the laser. Hatch spacing should allow for a slight
overlap of scan vector tracks such that some of the material re-melts to ensure
full coverage of solid material. For Machine Learning strain definition, must be
between 60 and 1000 microns.

• Deposition Thickness: The thickness of added powder material in every pass
of the recoater blade. Specifically, use the amount the base plate drops between
layers. For Thermal Strain strain definition, must be between 10 and 100
microns.

• Scan Speed: The average speed at which the laser spot moves across the
powder bed along a scan vector to melt material, excluding jump speeds and
ramp up and down speeds. For Thermal Strain strain definition, must be
between 350 and 2500 mm/sec and the recommended range is between 500
and 2500 mm/sec.

• Beam Power: The power setting for the laser in the machine. Must be between
50 and 700 Watts. The recommended range is between 50 and 500 Watts.

• Beam Diameter: The width of the laser on the powder or substrate surface
defined using the D4σ beam diameter definition. Usually, this value is provided
by the machine manufacturer. Sometimes called laser spot diameter. Must be
between 20 and 140 µm. The recommended range is between 80 and 120 µm.

If Inherent Strain = No:

• Heating Method: Controls how new layers are heated in the transient thermal
analysis. Choose Melting Temperature (default) or Power.

– Melting Temperature sets the new layer to the melt temperature
specified in Engineering Data.

– Power uses a heat generation load to heat new layers.

• Heating Duration: Visible if Heating Method = Power. The amount of time
the heat is applied, either Scan Time (default) or Flash.

– Scan Time: Heat is applied for the time it takes to scan the volume of
material in each element layer. This setting may give better temperature
results at the end of the layer but may not yield a temperature spike
above melting. Note that this Scan Time option will have a different
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end time of the simulation because the layer thickness adjustment for
cooling will not be used.

– Flash: Heat is applied in a very short time increment resulting in a spike
in temperature then cooling before the next element layer is added.

• Beam Power: Visible if Heating Method = Power. The power of the laser.

• Absorptivity: Visible if Heating Method = Power. The average fraction of energy
that is absorbed by the deposited material and contributes to the heating
process. Must be between 0 and 1. Defaults to 0.35.

• Hatch Spacing: See above.

• Deposition Thickness: See above.

• Scan Speed: See above.

• Dwell Time: The span of time from the end of the deposition of a layer to the
start of the deposition of the next layer. It includes the time required for
recoater-blade repositioning and powder-layer spreading.

• Dwell Time Multiple: The dwell-time multiplier accounts for more than one
part in the build. If they are the same part arranged in the same orientation
on the build plate, the multiplier is the number of parts.

• Number of Heat Sources: For multiple-beam printers, specifies the number
of beams. This divides the time it takes to scan a layer by the number of heat
sources specified.

Preheat Temperature: The starting temperature of the build plate. Used when Inherent
Strain = Yes and Inherent Strain Definition = Thermal Strain, and when Inherent Strain

Build
Con-

= No. For Thermal Strain strain definition, must be between 20 and 500 °C and the
recommended range is between 20 and 200 °C.

di-
tions

If Inherent Strain = No:

• Gas/Powder Temperature: Options include Use Preheat Temperature (default)
and Specified.

• Gas Convection Coefficient: Convection coefficient from the build to the
enclosure gas. The convection is applied only to the top of a newly laid layer.

• Gas Temperature: Temperature of the gas in the build enclosure.

• Powder Convection Coefficient: Effective convection coefficient from the
sides of the build to the powder bed. To estimate, divide the conduction
property of the powder by a characteristic conduction length into the powder
(for example, a quarter of the distance from the build boundary to the
build-chamber wall).

• Powder Temperature: Temperature of the newly added powder.
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• Powder Property Factor: The application uses this factor to estimate the
powder properties. The application applies the factor to the solid material
properties to estimate the properties of the material in its powder state. The
powder-state properties are used during the heating of the new layer (before
its subsequent solidification and cooldown) prior to the next layer being
applied.

Room TemperatureCool-
down

Gas/Powder Temperature: Options include Use Room Temperature (default) and
Specified.

Con-
di-
tions

Gas Convection Coefficient: Convection coefficient from the build to the enclosure
gas. The convection is applied only to the top of a newly laid layer.(In-

her-
Gas Temperature: Temperature of the gas in the build enclosure.ent

Powder Convection Coefficient: Effective convection coefficient from the build to
the powder bed. To estimate, divide the conduction property of the powder by a

Strain
=
No

characteristic conduction length into the powder (for example, a quarter of the distance
from the build boundary to the build-chamber wall).

option
only)

Powder Temperature: Temperature of the newly added powder.

Tree Dependencies

• Valid Parent Tree Object: AM Process.

• Valid Child Tree Objects: None.

Insertion Methods

Inserted automatically by the AM Process object.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Save Build Settings: Saves your build settings as an XML file. The property values are always
saved in Consistent MKS Unit System.

• Load Build Settings: Imports a build setting XML file. Once loaded, the settings properly populate
the properties of the Details pane. View and use example XML files at: [Ansys Installation Direct-
ory]\aisol\DesignSpace\DSPages\SampleData\AdditiveManufacturing.

• Reset to Default: Resets build settings to default values.

API Reference

See the AM Build Settings section of the ACT API Reference Guide for specific scripting information.
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Additional Related Information

LPBF Simulation Guide (p. 1)

Define Build Settings (p. 104)

8.4. Generated Support

Generates a support structure consisting of finite elements for Additive Manufacturing simulations.
Elements are generated between the part geometry and the base plate geometry based on an existing
mesh and the criteria set in Support Group.

After inserting this object, select element faces of the part under which you want elements to be gen-
erated. Then right-click and select Generate Support Bodies to generate the elements. Elements are
generated straight down from there to fill the gap between the part and the base plate.

Object Properties (p. 225)

Tree Dependencies (p. 226)

Insertion Methods (p. 226)

Right-click Options (p. 226)

API Reference (p. 227)

Additional Related
Information (p. 227)
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Object Properties

The Details Pane properties for this object include the following.

Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection (default) and Named
Selections.

Scope

Geometry: Displays when the Scoping Method is set to Geometry Selection. Using
the Element Face selection filter on the graphics toolbar, select the desired element
faces and click Apply.

Named Selection: Displays when the Scoping Method is set to Named Selection.
It provides a drop-down menu. Only element face-based Named Selections are
displayed in the drop-down menu.

Nonlinear Effects: Options include Yes (default) and No. This property applies nonlinear
material effects to the generated elements.

Defin-
i-
tion

Mode: Indicates whether you manually specified the Geometry Selection or whether
it was detected using the options of the Support Group object.

Important:

Only automatically generated supports are affected by the Generate
on Remesh property of the Support Group object

Visible: Show or hide the generated elements whenever the mesh is displayed (using
the Show Mesh option or when the mesh object is selected).

Support Type: Options include User Defined (default) and Block. When you select
the Block option, the following properties become the only visible properties.

Sup-
port
Ma-

• Wall Thickness: Enter a thickness value (illustrated by T length below).ter-
ial

• Wall Spacing: Enter a spacing value (illustrated by L length below).Set-
tings

Multiplier Entry: Options include All (default) and Manual.

Material Multiplier

All Setting

When the Multiplier Entry property is set to All, the Material Multiplier
property displays. The Material Multiplier property applies the same value
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to all of the material multipliers listed below. The multiplication factors are
homogenization factors and, in each direction, reflect the ratio of the support
area projected onto the area of a fully solid support.

Manual Setting

When the Multiplier Entry property is set to Manual, the following multiplier
properties display:

• Elastic Modulus Multiple in X/Y/Z

• Shear Modulus Multiple in XY/YZ/XZ

• Density Multiple

• Thermal Conductivity Multiple in X/Y/Z

Nodes: Read-only property that displays the number of nodes in the generated
elements.

Stat-
ist-
ics

Elements: Read-only property that displays the number of generated elements.

Volume: Read-only property that displays the volume of the generated elements.

Tree Dependencies

• Valid Parent Tree Object: Support Group, which is under AM Process object.

• Valid Child Tree Objects: None.

Insertion Methods

• Select the AM Process object and then select the Generated Support option from the AM Process
Context Tab.

• Right-click the AM Process object and then select Insert > Generated Support.

• Select the Support Group object and then select the Generated Support option from the AM Process
Context Tab.

• Right-click the Support Group object and then select Insert > Generated Support.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Insert

– Predefined Support

– Generated Support
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– STL Support

– Commands

• Create Named Selection of Generated Elements

• Hide Support

• Hide All Other Bodies

• Generate Support Bodies

• Clear Generated Data

API Reference

See the Generated AM Support section of the ACT API Reference Guide for specific scripting information.

Additional Related Information

• LPBF Simulation Guide (p. 1)

• Identify and/or Generate Supports (p. 86)

8.5. LPBF High Strain

Identifies areas of high strain that are prone to cracking in an AM Process simulation.
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Object Properties (p. 228)

Tree Dependencies (p. 229)

Insertion Methods (p. 230)

Right-click Options (p. 230)

Additional Related
Information (p. 230)

Object Properties

The Details Pane for this object includes the following properties.

Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection, Named Selection, All
Bodies (default), and Material IDs.

Geometry
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Threshold Definition:Display

• None (default): The result tool will show pure maximum equivalent strain
in the build, where the value at each point corresponds to the strain when
that material was a new layer.

• User Defined: Specify your own warning and critical thresholds.

– Warning Threshold: Strains above this are considered to be in a
warning state for potential cracking.

– Critical Threshold: Strains above this are considered to be in a critical
state for potential cracking.

If None is selected, the display will show the default color range. For User Defined
threshold definition, the display colors are:

• Blue = good

• Green = warning

• Red = critical

Calculate Time History: No (default) or Yes.Definition

• No (default): Results are not time dependent. Ensures a quick, dynamic
calculation of results.

• Yes: Setting Calculate Time History to Yes is unnecessary unless you want
to animate the result. Set to Yes to see the time history results, such as
for a layer-by-layer animated build. For large models, the calculation may
take some time.

Read-only properties displaying the following:Results

Minimum: The minimum equivalent strain experienced during the build process.

Maximum: The maximum equivalent strain experienced during the build process.

Minimum Occurs On: The geometry body (part or support) on which the minimum
equivalent strain occurs.

Maximum Occurs On: The geometry body (part or support) on which the
maximum equivalent strain occurs.

Tree Dependencies

• Valid Parent Tree Object: Solution, under Static Structural.

• Valid Child Tree Objects: None.
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Insertion Methods

• Click the LPBF High Strain button in the LPBF Process ribbon.

• Under the Static Structural system, right-click Solution and then select Insert > LPBF High Strain.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Evaluate All Results: Retrieves the equivalent strain data and displays it in graphical form.

• Clear Generated Data: Clears evaluated data for this result item.

Additional Related Information

Establish Structural Analysis Settings (p. 117)

Review Results (p. 123)

8.6. LPBF Hotspot

Identifies areas of overheating that may result in problematic thermal conditions in an AM LPBF Thermal
Structural simulation.
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Object Properties (p. 231)

Tree Dependencies (p. 232)

Insertion Methods (p. 232)

Right-click Options (p. 233)

Additional Related
Information (p. 233)

Object Properties

The Details Pane for this object includes the following properties.

Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection, Named Selection, All
Bodies (default), and Material IDs.

Scope

Threshold Definition:Display

• None (default): The result tool will show temperature that the build cools
down to for each layer right before the next layer is added. (It does not
represent the "final state" of temperatures at the end of the entire process's
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Properties/Options/DescriptionsCategory

cooldown step.) The worst hotspots are going to be the areas with the
highest temperature for that layer.

• User Defined: Specify your own warning and critical thresholds:

– Warning Threshold: Temperatures above this are considered to be
in a warning state for hotspots.

– Critical Threshold: Temperatures above this are considered to be
in a critical state for hotspots.

If None is selected, the display will show the default color range. For User Defined
threshold definition, the display colors are:

• Blue = good

• Green = warning

• Red = critical

Calculate Time History: No (default) or Yes.Definition

• No (default): Results are not time dependent. Ensures a quick, dynamic
calculation of results.

• Yes: Setting Calculate Time History to Yes is unnecessary unless you want
to animate the result. Set to Yes to see the time history results, such as
for a layer-by-layer animated build. For large models, the calculation may
take some time.

Read-only properties displaying the following:Results

Minimum: The minimum temperature experienced during the build process.

Maximum: The maximum temperature experienced during the build process.

Minimum Occurs On: The geometry body (part or support) on which the minimum
temperature occurs.

Maximum Occurs On: The geometry body (part or support) on which the
maximum temperature occurs.

Tree Dependencies

• Valid Parent Tree Object: Solution, under Transient Thermal.

• Valid Child Tree Objects: None.

Insertion Methods

• Click the LPBF Hotspot button in the LPBF Process ribbon.
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• Under the Transient Thermal system, right-click Solution and then select Insert > LPBF Hotspot.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Evaluate All Results: Retrieves the temperature data and displays it in graphical form.

• Clear Generated Data: Clears evaluated data for this result item.

Additional Related Information

Establish Thermal Analysis Settings (Thermal-Structural System) (p. 113)

Review Results (p. 123)

8.7. LPBF Hotspot Time Correction (Beta)

This result helps you define how much time should be spent on each layer to ensure that the build
cools down below a target temperature to prevent overheating. Whereas the LPBF Hotspot result (p. 230)
identifies problem areas, this result provides a method to resolve the problem by increasing time spent
on specific layers.

The hotspot time correction result item is a Beta feature at this release. See Hotspot Time Correction
Result (Beta) in the Additive Manufacturing Beta Features document.

8.8. LPBF Recoater Interference

Identifies areas that may result in recoater interference issues in an AM Process simulation.
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Object Properties (p. 234)

Tree Dependencies (p. 236)

Insertion Methods (p. 236)

Right-click Options (p. 236)

Additional Related
Information (p. 236)

Object Properties

The Details Pane for this object includes the following properties.

Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection, Named Selection, All
Bodies (default), and Material IDs.

Geometry

Threshold Definition:Display

• Layer Thickness Based: The result tool uses the Deposition Thickness (set
in the Build Settings (p. 214) object for some simulation types, otherwise
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set it here) and a new input field, Powder Packing Density, to determine
the thresholds for warning and critical deformation. Specifically, if the
Z-deformation for any layer is equal to or greater than the Deposition
Thickness it is considered a warning. If the Z-deformation is equal to or
exceeds the value of Deposition Thickness/Powder Packing Density, it is
considered critical. Powder Packing Density may be dependent on the
powder particle size, material, spreading mechanism, or other factors

• None: The result tool will show pure Z-deformation in the build, where
the value at each point corresponds to the Z-deformation when that
material was a new layer.

• User Defined: You define your own warning and critical thresholds.

If None is selected, the display will show the default color range. For Layer
Thickness Based and User Defined threshold definitions, the display colors are:

• Blue = good

• Green = warning

• Red = critical

Deposition Thickness: The thickness of added powder material in every pass of
the recoater blade. Specifically, use the amount the base plate drops between
layers.

Powder Packing Density: May be dependent on the powder particle size, material,
spreading mechanism, or other factors.

Calculate Time History: No (default) or Yes.Definition

• No (default): Results are not time dependent. Ensures a quick, dynamic
calculation of results.

• Yes: Setting Calculate Time History to Yes is unnecessary unless you want
to animate the result. Set to Yes to see the time history results, such as
for a layer-by-layer animated build. For large models, the calculation may
take some time.

Read-only properties displaying the following:Results

Minimum: The minimum displacement experienced during the build process.

Maximum: The maximum displacement experienced during the build process.

Minimum Occurs On: The geometry body on which the minimum displacement
occurs.

Maximum Occurs On: The geometry body on which the maximum displacement
occurs.
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Tree Dependencies

• Valid Parent Tree Object: Solution, under Static Structural.

• Valid Child Tree Objects: None.

Insertion Methods

• Click the LPBF Recoater Interference button in the LPBF Process ribbon.

• Under the Static Structural system, right-click Solution and then select Insert > LPBF Recoater In-
terference.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Evaluate All Results: Retrieves the displacement data and displays it in graphical form.

• Clear Generated Data: Clears evaluated data for this result item.

Additional Related Information

Establish Structural Analysis Settings (p. 117)

Review Results (p. 123)

8.9. Predefined Support

Identifies a support structure that was imported with your part geometry for Additive Manufacturing
simulations. Supports are modelled as elements between the Build Geometry and the Base Plate
Geometry.
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Object Properties (p. 237)

Tree Dependencies (p. 238)

Insertion Methods (p. 238)

Right-click Options (p. 239)

API Reference (p. 239)

Additional Related
Information (p. 239)

Object Properties

The Details Pane properties for this object include the following.

Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection (default) and Named
Selections.

Scope

Geometry: Displays when the Scoping Method is set to Geometry Selection.

Named Selection: Displays when the Scoping Method is set to Named Selection.
Select a desired Named Selection from the drop-down menu.

Support Type: Options include User Defined (default) and Block. When you select
the Block option, the following properties become the only visible properties.

Sup-
port
Ma-

• Wall Thickness: Enter a thickness value (illustrated by T length below).ter-
ial

• Wall Spacing: Enter a spacing value (illustrated by L length below).
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Properties/Options/DescriptionsCategory

Set-
tings

Multiplier Entry: Options include All (default) and Manual.

Material Multiplier

All Setting

When the Multiplier Entry property is set to All, the Material Multiplier
property displays. The Material Multiplier property applies the same value
to all of the material multipliers listed below. The multiplication factors are
homogenization factors and, in each direction, reflect the ratio of the support
area projected onto the area of a fully solid support.

Manual Setting

When the Multiplier Entry property is set to Manual, the following multiplier
properties display:

• Elastic Modulus Multiple in X/Y/Z

• Shear Modulus Multiple in XY/YZ/XZ

• Density Multiple

• Thermal Conductivity Multiple in X/Y/Z

Volume: Read-only property that displays the volume of the added finite element
body.

Stat-
ist-
ics

Tree Dependencies

• Valid Parent Tree Object: Support Group, which is under AM Process object.

• Valid Child Tree Object: This object does not support any child objects.

Insertion Methods

• Select the Support Group object and then select the Predefined option from the Supports group
of the AM Process Context Tab.

• Right-click the Support Group object and then select the Insert > Predefined Support.
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Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Insert

– Predefined Support

– Generated Support

– STL Support

– Commands

• Suppress/Unsuppress

API Reference

See the Predefined AM Support section of the ACT API Reference Guide for specific scripting information.

Additional Related Information

• LPBF Simulation Guide (p. 1)

• Identify and/or Generate Supports (p. 86)

8.10. STL Support

Imports and meshes a support structure that is an STL (Stereolithography) file, of either volumeless or
solid type. This feature is designed primarily for inserting volumeless (that is, not watertight) supports,
such as those created by Additive Prep, into an additive manufacturing model for simulation.

After inserting this object, right-click and select Generate Mesh to mesh the support. The mesh is created
using elements that are internally divided into subdivisions to sample the presence of material and
calculate the overall density of each element. Each element's density is used, in turn, as a material
property knockdown factor.
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Object Properties (p. 240)

Tree Dependencies (p. 241)

Insertion Methods (p. 242)

Right-click Options (p. 242)

API Reference (p. 242)

Additional Related
Information (p. 242)

Object Properties

The Details Pane properties for this object include the following.

Properties/Options/DescriptionsCategory

Source: File or STL. If you choose File, enter the File Name in the File Name
property. If you choose STL, an STL dropdown menu appears where you select
from previously imported Construction Geometry STLs.

Scope

File Name: Navigate to the appropriate folder and select your STL support file.

Length Units: A drop-down menu with units. Choose the units used in the support
file. Millimeters is the default setting.

If there are multiple bodies in the model, use the next two fields to designate
which body is associated with the STL support.
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Properties/Options/DescriptionsCategory

Scoping Method: Either Geometry Selection or Named Selection.

Geometry/Named Selection: Select the body (or Named Selection) that is
associated with the STL support.

Nonlinear Effects: Yes (default) or No. This property applies nonlinear effects to
the finite element body.

Defin-
ition

STL Support Type: The type of support in the STL file. Options include:

Volumeless: These are usually thin, single-bead width support walls that are not
watertight, such as lattice or tree-type supports, or Block/Heartcell/Rod/Line
supports from Additive Prep. Other names in the industry for this type include thin
wall, vector, and facet.

Solid: These supports are standard, watertight geometry bodies. Custom supports
from Additive Prep are in this category. Other names in the industry for this type
include thick wall, bulk, and volume.

Wall Thickness: Wall Thickness value is the thickness of a single-bead width laser
scan set by your machine. Available only if STL Support Type = Volumeless.

Subsample Rate: Subsample Rate value. Each element is divided into sampling
regions to determine an overall element density used as a material knockdown
factor within that element. A Subsample Rate of 5 (default) = 5 x 5 x 5 = 125
subdivisions. Subsample Rate affects the accuracy of element density.

Element Size: Read-only indication of the element size, which is taken from the
part's mesh size criteria. Visible only after mesh generation.

Support View: A drop-down menu with the following options:Dis-
play

STL View: Displays the STL support.

Mesh View: Displays the elements associated with the STL support. Visible only
after mesh generation.

Knockdown Factors: Displays the element densities associated with the STL
support. Visible only after mesh generation.

Read-only indications only visible once you have generated the mesh for the
support.

Stat-
istics

Nodes: The number of nodes generated for the support.

Elements: The number of elements generated for the support.

Volume: The volume of all the elements generated for the support.

Tree Dependencies

• Valid Parent Tree Object: Support Group, which is under AM Process object.

• Valid Child Tree Objects: None.
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Insertion Methods

• Select the AM Process object and then select the STL Support option from the AM Process Context
Tab.

• Right-click the AM Process object and then select the Insert > STL Support.

• Select the Support Group object and then select the STL Support option from the AM Process
Context Tab.

• Right-click the Support Group object and then select the Insert > STL Support.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Insert

– Predefined Support

– Generated Support

– STL Support

– Commands

• Generate Mesh: Generates a mesh of elements for the support using Subsample Rate to determine
knockdown factors.

• Create Named Selection of Generated Elements: Creates a Named Selection consisting of the
generated elements for the support.

• Create Named Selection of External Element Faces: Creates a Named Selection consisting of
the faces of the generated elements for the support.

• Suppress: Suppresses the STL support from the simulation.

• Clear Generated Data: Clears any generated elements on the supports.

API Reference

See the SLT AM Support section of the ACT API Reference Guide for specific scripting information.

Additional Related Information

LPBF Simulation Guide (p. 1)

Identify and/or Generate Supports (p. 86)
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8.11. Support Group

Groups Predefined Support and/or Generated Support objects in an AM process simulation. Also use
this object to detect element faces for a Generated Support.

Object
Properties (p. 243)

Tree
Dependencies (p. 244)

Insertion
Methods (p. 244)

Right-click
Options (p. 244)

Additional
Related
Information (p. 244)

Object Properties

The Details Pane properties for this object include the following.

Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection (default) and Named
Selections.

Scope

Geometry: Displays when the Scoping Method is set to Geometry Selection.

Named Selection: Displays when the Scoping Method is set to Named Selection.
Select a desired Named Selection from the drop-down menu.
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Properties/Options/DescriptionsCategory

The Detect Group category includes the properties listed below. You use these
properties to automatically detect element faces to be applied to Generated Supports.
See Identify and/or Generate Supports (p. 86) for more information.

De-
tect
Group

Generate On Remesh

Overhang Angle

Detect Above Z Location

Output Type

Group By

Tree Dependencies

• Valid Parent Tree Object: AM Process.

• Valid Child Tree Objects: Predefined Support, Generated Support, and STL Support.

Insertion Methods

• Select the AM Process object and then select the Support Group option from the Supports group
on the AM Process Context tab.

• Right-click the AM Process object and then select the Insert > Support Group.

Right-click Options

In addition to common right-click options, relevant right-click options for this object include:

• Insert

– Predefined Support

– Generated Support

– STL Support

– Commands

• Detect Supports: Detect element faces to be applied to Generated Supports.

• Detect and Generate Supports: Detect element faces and generate supports for the build
bodies.

Additional Related Information

LPBF Simulation Guide (p. 1)

Identify and/or Generate Supports (p. 86)
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8.12. Weak Springs

Loosely holds parts in place during AM postprocess steps to prevent rigid body motion.

Insert a Weak Springs object into an LPBF Static Structural simulation to prevent rigid body motion
when the default nonlinear stabilization is insufficient. In most cases, simulations should be able to
reach convergence without this object, but it may be necessary on some occasions. When added, the
object automatically scopes all nodes at the bottom of the part and support geometries. It attaches
weak springs on the scoping (or a subset of the scoping) to hold the part in place without significantly
affecting results.

Object Properties (p. 245)

Tree Dependencies (p. 247)

Insertion Methods (p. 247)

Additional Related
Information (p. 247)

Object Properties

The Details Pane for this object includes the following properties.
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Properties/Options/DescriptionsCategory

Scoping Method: Options include Geometry Selection (default) and Named
Selections.

Scope

• Geometry: Select either Faces or Mesh Nodes of the object. If the Grid
option is chosen for Spring Creation the scoped nodes or faces need to
be on a consistent Z-plane. When added, the object will automatically
scope all nodes in the build geometries (part and support) at the interface
with the base.

• Named Selection: Select a Named Selection from the drop-down menu.

Spring Stiffness Setting: Choose Program Controlled, Factor, or Manual.Definition

• Program Controlled: Equivalent to using the Factor setting with a value
of 1e-7.

• Factor:

– Spring Stiffness Factor: A factor used to indirectly specify the spring
stiffness. Defaults to 1e-7. With this option,

, where Area is the area
represented by the scoped nodes, E is the elastic modulus, and
Factor is the Spring Stiffness Factor.

The area and elastic modulus in this equation are determined by
Mechanical APDL whereas the Spring Stiffness Factor is user input.
The elastic modulus is taken at either the room temperature
specified in the AM Process object (for Thermal-Structural
simulations), or the reference temperature of the body it’s associated
with (for Inherent Strain simulations).

• Manual:

– Spring Stiffness: Stiffness value to be used by each spring.

Spring Creation: Choose Program Controlled, Grid, All Scoped Nodes, or All
Scoped Corner Nodes.

• Program Controlled: When scoped faces or nodes are all on the same
Z-plane, the application uses the same as using the Grid option where the
grid length is the total_element_volume/total_area where the area is the
area associated with each scoped node and the volume is the element
volume of elements associated with the scoped nodes.

When scoped faces or nodes are not on the same Z-plane, the application
defaults to All Scoped Corner Nodes.

• Grid: When the Grid setting is selected, an X-Y grid of candidate points is
created internally. For each point, the nearest corner node is identified,
and if the node is within the Grid Spacing distance of the candidate grid
point, weak springs are applied to it. This option is useful when a layered
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Properties/Options/DescriptionsCategory

tetrahedral mesh is used, to provide a more uniform overall distance
between weak springs when there may be smaller elements along part
curves. The Grid option is only valid if the face or node scoping is in a
consistent Z-plane.

– Grid Spacing: Spacing used to identify weak spring locations.

• All Scoped Nodes: Weak springs are placed on all scoped nodes or nodes
associated with face scoping.

• All Scoped Corner Nodes: Weak springs are placed on all scoped corner
nodes or all corner nodes associated with scoped face(s). Corner nodes
are those at the corners of an element (not the midside of an element
edge).

Tree Dependencies

• Valid Parent Tree Object: Static Structural

• Valid Child Tree Objects: None.

Insertion Methods

• Click the Weak Springs button in the LPBF Process ribbon.

• Right-click Static Structural and then select Insert > Weak Springs.

Additional Related Information

Apply Structural Boundary Conditions (p. 120)
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